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About This Guide  
The System Configuration Manual is intended for process control engineers responsible for setting up 
and configuring Proficy Batch Execution, as well as MIS or IT personnel who are responsible for 
configuring network communications for Batch Execution. 

This manual teaches engineers the skills they need to set up Batch Execution Servers, Clients, and 
development workstations. The manual also explains how to set up several different relational 
databases to work with Batch Execution. 

Reference Documents 
For related information about configuring Batch Execution, refer to the following documents: 

• Upgrade Guide  

• Equipment Configuration Manual  

• Operations Manual  

• iFIX Setting up the Environment Manual  

• iFIX Implementing Security Manual  

Introduction 
When you configure the Proficy Batch Execution product, you can configure three types of nodes: 
servers, clients, and development workstations.  

Server Nodes 

Server nodes provide a central repository for files and can include the following: 

• Batch Servers  

• iFIX SCADA Servers  

• A relational database server  

Client Nodes 

Client nodes provide access to files and batch processing information during the production of a batch 
and include the following: 

• Batch Execution Clients (to access information from a Batch Execution Server)  

• Batch Execution Servers (to access information from a SCADA Server, your process 
hardware, and a relational database)  
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Development Nodes  

Use development workstations to create and maintain all components of a Batch Execution System, 
including: 

• An area model (based on ISA-S88.01 Batch Control Standard)  

• Recipes (based on S88.01)  

• iFIX operator displays  

• Process database  

Your tool for setting up each type of node depends on the specific node you are configuring, as the 
following table shows.  

Configuring Nodes in your Batch Execution System  

When setting up a... Use the... 

Development workstation or 
Batch Execution Server 

Proficy Batch Execution WorkSpace™. 

Batch Execution Client Batch Execution Client application. (If you are using 
ActiveX controls, use the control's property page.) 

iFIX SCADA Server System Configuration Utility (SCU). 

Relational database Administration program provided with your relational 
database. 

Understanding Batch Execution Configuration 
Before you begin setting up your Batch Execution software, you need to understand each type of node 
you can configure and the different tasks each Batch Execution node performs. Refer to the following 
sections for more information. 

NOTE: You cannot install Batch Execution software on a Windows server domain controller (primary 
or backup). You can install Batch Execution software on a member server. 

Batch Execution Client and Server Configuration  

Batch Execution supports one or more Clients and Servers. A Batch Execution Client is a computer 
used by operators to manage and control batches. Batch Execution Clients can run: 

• The Batch Execution Client application, to manage and control batches.  

• iFIX Client, allowing operators to monitor process values residing in the iFIX process 
database.  
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• The Batch Execution Archiver, which archives batch event data to a relational database.  

• The Batch Execution ActiveX Controls, allowing operators to monitor and control batches 
instead of, or in addition to, using the Batch Execution Client application.  

• VBIS, the GE Intelligent Platforms Batch Integrated Services COM Server.  

A Batch Execution Server is a computer that: 

• Coordinates the function of the recipes, the area model, and each Batch Execution Client 
during production.  

• Generates batch event journals.  

• Communicates with SCADA Servers, the relational database, and OPC-aware process 
hardware.  

It is possible to use the same computer for your Batch Execution Client and your Batch Execution 
Server. Having the Batch Execution Server and the Batch Execution Client applications on the same 
computer may adversely affect system performance. In fact, most Batch Execution systems may 
incorporate remote client operation. The following figure shows a typical configuration where multiple 
Batch Execution Clients are distributed throughout your site.  
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Sample Batch Execution Architecture  
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Development Workstation Configuration 

Engineers use development workstations to create the recipes, operator displays, and the area model 
required by your application, as the following figure shows. 

 

Development Workstation Configuration 

Depending on your needs, you may also use the Batch Execution Server as a development workstation 
to create recipes, operator displays, and an area model with the Proficy Batch Execution WorkSpace. 
However, since the Batch Execution Server coordinates the function of Batch Execution during 
production, this is not recommended. Typically, you will want to have separate nodes for development 
and for production. 

SCADA Server Configuration 

As the following figure shows, the Batch Execution Server communicates with iFIX SCADA Servers. 
Typically this is done when: 

• A process value required by a recipe resides in the iFIX process database.  

• You want to monitor one or more process values with operator displays from iFIX Client.  

• The Batch Execution Server is controlling phases in the process controller.  
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SCADA Server Configuration  

In general, the functions of a SCADA Server are to: 

• Communicate with your process hardware.  

• Maintain the process database.  

If your process hardware is OPC-aware, the Batch Execution Server can communicate directly with 
your equipment. However, if you want to take advantage of the iFIX process database, you can set up 
your process hardware so that it stores process values to a SCADA Server. The Batch Execution 
Server can then retrieve these process values when a batch is run. The Batch Execution Server allows 
you to combine both methods of communication.  

For more information on setting up a SCADA Server, refer to the Building a SCADA System Manual. 

Relational Database Configuration  

In addition to communicating with SCADA Servers, a Batch Execution Server can communicate with 
relational databases to load recipes during production. These recipes are initially saved to the relational 
database during the development of your batch application from development workstations. 
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The Batch Execution Server distributes event data to the Batch Execution Archiver as SQL files that 
can be archived in your relational database. Once the data is written to the relational database, you can 
create SQL queries to extract the information you need and produce reports.  

The following figure illustrates how Batch Execution Event Journal and recipe data are stored in the 
relational database. 

 

Relational Database Configuration  

Batch Execution supports the following relational databases: 

• Oracle® 10g and 11g 

• SQL Server 2005 and 2008 

NOTE: GE does not support the use of Microsoft Access for data archiving in a production 
environment. However, you may utilize it for testing only. 

Other ODBC databases, while not supported, should also work with Batch Execution.  

The relational database you install and configure must be operating correctly before you set up the data 
sources required for Batch Execution. Typically, setting up a relational database requires you to install 
an ODBC driver. Refer to your ODBC manuals for installing and configuring your relational database 
and ODBC driver. 

For more information on configuring the relational database to store recipe and batch Event Journal 
data from the Archiver, refer to the Relational Database Configuration section. 
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Network Configuration  

Once you have set up each Batch Execution node, you need to enable network communications 
between a Batch Execution Server and the following equipment:  

• Each Batch Execution Client  

• Each iFIX SCADA Server required by your application  

• Each relational database server  

• OPC-aware process hardware  

• The iFIX Terminal Server, if terminal services are used in iFIX 

Once these tasks are complete, you are ready to start using Batch Execution, refer to the Network 
Configuration section. 

Getting Started 
The sections that follow explain how to start configuring Batch Execution: 

• Before You Start  

• Batch Execution Requirements  

• Task Overview  

• Developing a Configuration Strategy  

Use the information in these sections to identify each configuration tasks for each node you require. 

Before You Start 
Before you start configuring Batch Execution, make sure you have a Windows login account with 
administrator rights. For information on creating a Windows login account, refer to your Windows 
manuals or see your system administrator.  

Once you create the login account, complete the following tasks: 

• Identify the computers that will function as your Batch Execution Servers, Clients, and 
development workstations.  

• Identify the computers that will function as your:  

• iFIX SCADA Server(s)  

• Relational database server(s)  

• Decide if you need to enable iFIX security.  

• Log into Windows and install the following iFIX software on the nodes listed in the following 
table.  
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Node Type Required iFIX Software 

SCADA Server Database Manager, SCADA support, and an I/O driver 

Batch Execution Server (as a 
SCADA Server) 

Database Manager, SCADA support, and an I/O driver 

Batch Execution Server (as an iFIX 
Client) 

iFIX Client 

Batch Execution Client iFIX Client to monitor process values in the process 
database 

Development workstations iFIX Client with Graphics to develop operator displays 

If your application requires an iFIX SCADA Server, install 
the Database Manager. 

Batch Execution nodes requiring 
security 

iFIX Client 

• Set up the SCADA Server. For more information on setting up a SCADA Server, refer to the 
iFIX Building a SCADA System manual.  

• Install Batch Execution on each Batch Execution Server, Client, and development workstation 
after you install your iFIX software.  

Configuring and Optimizing iFIX Software 

If you are integrating GE's iFIX software with Batch Execution, these systems must be properly 
configured and optimized for your process. If your iFIX software is not properly configured, you may 
encounter problems with Batch Execution. For example, it is important that you assign the correct iFIX 
tag types and EGU ranges to your Equipment Phase tags. Refer to the Equipment Configuration 
Manual for a listing of the recommended tag types and EGU ranges.  

For information on configuring your iFIX systems, refer to the iFIX documentation.  
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Batch Execution Requirements  
The following table lists the recommended requirements for Batch Execution. These requirements do 
not include the ones to run iFIX or relational database software. For information on iFIX software, 
refer to the iFIX Setting up the Environment Manual. For information on supported database software, 
refer to the Relational Database Configuration section in this manual.  

Batch Execution Requirements   

Item Minimum Recommendation 

Batch Execution 
Client Computer 

Intel Core 2 Duo, 2.2 Gigahertz or better 

Batch Execution 
Server Computer 

Intel Core 2 Duo, 2.2 Gigahertz or better 

Operating System Microsoft® Windows® XP Professional, Service Pack 3. Since Windows 
XP has continuous updates, you should run the Windows update feature to 
get the latest software.  

Microsoft® Windows® Vista, Service Pack 1. Since Windows Vista has 
continuous updates, you should run the Windows update feature to get the 
latest software.  

Microsoft® Windows® Server 2003, Service Pack 2.Standard or Enterprise 
Edition. Since Windows Server 2003 has continuous updates, you should 
run the Windows update feature to get the latest software.  

Microsoft® Windows® Server 2008, Standard or Enterprise Edition. Since 
Windows Server 2008 has continuous updates, you should run the Windows 
update feature to get the latest software.  

Memory — Batch 
Execution Client 

1 Gigabyte 

Memory — Batch 
Execution Server 

2 Gigabytes 

NOTE: If you are running an iFIX Server or iFIX Client, add an additional 
1GB. 

Virtual Memory 2 – 3 times the amount of physical memory 

Hard Disk Space 
(Client or Server) 

40 Gigabytes (server), 1 Gigabyte (client) 

Free Disk space – 
Batch Execution 
Client 

100 Megabytes 
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Batch Execution Requirements   

Item Minimum Recommendation 

Free Disk space – 
Batch Execution 
Server 

1 Gigabyte 

Monitor 1024 x 768 

Network protocol TCP/IP 

Video Display 
Settings 

65536 Colors (recommended) 

Task Overview  
When you are ready to begin configuring Batch Execution, use the following steps to identify the tasks 
you need to complete:  

Batch Execution System Configuration Tasks   

  Task For more information refer to this 
section... 

1 Configure the Batch Execution Server. Defining a Project's Settings. 

2 Configure the settings for the project. Configuring and Managing the Batch 
Execution Server 

3 Define the Batch Execution Archiver settings 
for each Batch Execution Server.  

Configuring Active Journaling 

4 Set up your iFIX software for each Batch 
Execution node.  

SCU and Security Configuration 

5 If you need to enable security, run the iFIX 
Security Configuration program.  

SCU and Security Configuration 

6 Set up your OPC server (process hardware) 
software.  

Network Configuration  

NOTE: You can also refer to your 
process hardware manuals. 
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Batch Execution System Configuration Tasks   

  Task For more information refer to this 
section... 

7 Set up network communication for your Batch 
Execution nodes.  

Network Configuration 

8 Install and configure your relational database 
server.  

Relational Database Configuration 

NOTE: You can also refer to your 
relational database manuals. 

9 Install and configure your Soft Phase Server, if 
applicable. 

Configuring the Soft Phase Server 

10 Use the Batch Execution Client application to 
set up each Batch Execution Client.  

Operations Manual 

Developing a Configuration Strategy  
When you are ready to start configuring Batch Execution, plan out which tasks you need to complete 
for each node. The following figure shows the recommended order to perform these tasks. 
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Recommended Configuration Flow  

Defining a Project's Settings 
The sections that follow describe how to define the Batch Execution Project settings: 

• Defining Project Directories  

• Moving Projects  

Project settings are defined in the file, VBEXEC.INI. On Windows Vista or on Windows Server 2008, 
this file resides in the C:\ProgramData\Proficy\Proficy Batch Execution\Configs folder. On Windows 
XP or Windows Server 2003, the file is located in the C:\Documents and Settings\All 
Users\Application Data\Proficy\Proficy Batch Execution\Configs folder. The file is read by the Batch 
Execution Server on startup. Configuration of the VBEXEC.INI file is done through the Proficy Batch 
Execution WorkSpace. When you open a project and save it, the configuration information is written 
to the VBEXEC.INI file. 
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Defining Project Directories 
In Batch Execution, your equipment, recipes, journals, and logs are grouped into projects. These files 
and others are stored in project directories. When you create a new project with the Proficy Batch 
Execution WorkSpace, the program prompts you for a project name. Once you enter this information, 
the Proficy Batch Execution WorkSpace creates the following paths by default.  

The path... Stores... 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RECIPES 

Recipes 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\JOURNALS  

Primary and 
Secondary 
Journals 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\LOGS  

Logs 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RECIPES\Mydatabase.cfg 

Equipment 
Database 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RESTART1 

Primary Restart 
Path 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RESTART2 

Secondary Restart 
Path 

C:\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\EIBPRODUCTION 

EWI Directory 
Store 

NOTE: These paths reflect the default Batch Execution base path, C:\Program Files\Proficy\Proficy 
Batch Execution. Batch Execution creates the project paths in the directory where you have installed 
Batch Execution.  

The Proficy Batch Execution WorkSpace assigns the name of the project to the area model that is 
associated with this project. During the initial configuration, you can accept these defaults or change 
them to suit your needs. If you want to change the project name after the initial installation, refer to 
Modifying Equipment Database Project Paths. You can specify a network drive in any of the project 
paths; however, you may want to use UNC paths instead of network paths, as described in the 
following section. 
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Using UNC Paths  

If your project files reside on a remote computer, you can access these files over your network. Batch 
Execution supports Microsoft's Universal Naming Convention (UNC) to access project files that are 
stored on other computers within your network. The syntax for UNC paths is as follows: 

\\machinename\sharename\path\filename 

For example, assume that your project resides on a computer called SERVER1 with a share name of 
CROOT and your Batch Execution software is installed in the Batch Execution path. In this example, 
the project paths would be as follows:  

The path... Stores... 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RECIPES 

Recipes 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\JOURNALS  

Primary and 
Secondary 
Journals 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\LOGS  

Logs 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RECIPES\Mydatabase.cfg 

Equipment 
Database 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RESTART1 

Primary Restart 
Path 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\RESTART2 

Secondary 
Restart Path 

\\SERVER1\CROOT\Program Files\Proficy\Proficy Batch 
Execution\PROJECTS\projectname\EIBPRODUCTION 

EWI Directory 
Store 

NOTE: You cannot use UNC paths if you are running the Batch Execution Server as a Windows 
service under the local system account. Refer to the Configuring and Managing the Batch Execution 
Server section for more information on running the Batch Execution Server as a Windows service. 

Sharing and Setting Permissions for Project Directories 

In order for computers to access project files remotely using UNC, you need to: 

• Share the project directory. In the Windows Explorer, select the project directory, right-click 
the mouse, and select the Sharing command from the pop-up menu. For example, to share the 
DEMO project, you would share the DEMO directory in C:\Program Files\Proficy\Proficy 
Batch Execution\PROJECTS\DEMO.  
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• Assign Full Control permissions to the shared directory. To prevent unauthorized access to 
the shared directory, you can add specific users or a group of users to the permissions list.  

NOTE: Refer to the Windows documentation for instructions on sharing directories and 
setting permissions. 

Project Components in the Proficy Batch Execution WorkSpace System 
Tree  

Once you are satisfied with the server configuration, the project paths, and the area model name, the 
Proficy Batch Execution WorkSpace: 

1. Creates an empty hierarchy of folders in the system tree using the information you entered. 
Note that if the specified paths do not exist, the Proficy Batch Execution WorkSpace prompts 
you to create the paths.  

2. Adds the specified area model to the Equipment folder. If the specified file does not exist, the 
Proficy Batch Execution WorkSpace adds an empty area model.  

3. Adds the required configuration files into the Configuration folder.  

4. Adds any iFIX pictures residing in your Picture path to the Pictures folder.  

Project Components in the Proficy iFIX WorkSpace System Tree 

The Proficy iFIX WorkSpace functions differently than the Batch Execution WorkSpace. When you 
start the Proficy iFIX WorkSpace, the system tree contains the items shown in the following figure. To 
open and create new Batch Execution projects, use the Active Project field in the Batch Execution 
Configuration dialog box. To access this dialog, select the Batch Execution Configuration icon in the 
system tree.  
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Proficy iFIX WorkSpace System Tree 

NOTE: For more information on using the Proficy iFIX WorkSpace, refer to the iFIX electronic 
books. 

Converting WorkSpace Projects  

If you have created a project in the Proficy Batch Execution WorkSpace and you want to use this 
project in the iFIX WorkSpace, you first need to convert the project. This conversion produces a .vbw 
file in the folder containing the selected batch project's .wkb file, which will allow you to open your 
Batch project in the iFIX WorkSpace. 

To convert a project:  

1. Start the Project Conversion Utility. This utility resides in the Batch Execution BIN directory, 
typically C:\Program Files\Proficy\Proficy Batch Execution\Proficy\Proficy Batch 
Execution\BIN. The name of the executable is PROJECTCONVERT.EXE. The 
ProjectConvert dialog box appears.  

2. Select the project you want to convert and click the Convert button. A message appears 
indicating that your project was successfully converted.  

IMPORTANT: Once you work on a project in the Proficy iFIX WorkSpace, you can no 
longer open that project in the Batch Execution WorkSpace. 
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If you have problems viewing any Batch items in the iFIX WorkSpace system tree, refer to the "Batch 
Execution Entries Do Not Appear in Proficy iFIX WorkSpace Tree After Install" section of the 
Release Notes tab of the IPI. These steps describe how to add the Batch items to the iFIX WorkSpace 
system tree if the Batch install program did not automatically add them for you. 

Moving Projects  
If you create a project and want to move it to another computer, you need to: 

• Create a new project (.WKB file) on the destination computer. You cannot copy a project's 
.WKB file. This file may reference paths that are not valid on the destination computer.  

• Copy the project files in the RECIPE directory from the source computer to the destination 
computer.  

Configuring and Managing the Batch 
Execution Server 
The Batch Execution Server is the main processing engine of the Batch Execution system. The sections 
that follow describe how to configure the Batch Execution Server, including how to:  

• Configure the Batch Execution Server to run as a Windows service using the Batch Execution 
Services Configuration utility.  

• Change the default batch account. 

• Manage and monitor the Batch Execution Server using the Batch Execution Server Manager.  

• Define the Batch Execution Server settings for a Batch Execution project.  

Batch Execution Server settings are defined in the file, VBEXEC.INI. On Windows Vista and 
Windows Server 2008, this file resides in the folder C:\ProgramData\Proficy\Proficy Batch 
Execution\Configs. On Windows XP or Windows Server 2003, the file is located in the folder 
C:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs. The 
file is read by the Batch Execution Server on startup. Configuration of the VBEXEC.INI file is done 
through the Proficy Batch Execution WorkSpace. When you open a project and save it, the 
configuration information is written to the VBEXEC.INI file.  

IMPORTANT: Changes to server settings do not take effect until the Batch Execution Server is shut 
down and restarted.  

You also need to configure network communications between the Batch Execution Server and its 
clients. For information on configuring your network settings, refer to the Network Configuration 
section. 
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Configuring the Batch Execution Server to Run as a Windows 
Service  
You can configure the Batch Execution Server to run as a Windows service using the Batch Execution 
Services Configuration Utility. When you configure the Batch Execution Server to run as a service, 
you are also configuring the EIB Server to run as a service.  

Running the Batch Execution Server and EIB Server applications as services enables users to log on 
and off the computer without having to shutdown and restart these applications. 

NOTES:  

• By default, the VBIS runs as a service under the batch user account, which by default is 
BatchExecutive (unless you change this account name during the install, or in the 
Services Configuration utility). The VBIS Server always runs on the same computer as 
the Batch Execution Server.  

• The Services Configuration utility does not create a user name if one does not already 
exist. You must create the user account in the Windows. 

Configuration Guidelines 

Use the following important guidelines when configuring Batch Execution applications to run as 
Windows services: 

• If you are using iFIX as your SCADA/HMI system, and you are running the Batch Execution 
Server as service, you must also run iFIX as a service. Refer to the "Running iFIX as a 
Service" section in the Getting Started with iFIX guide for steps. 

• If your product key does not include WorkInstruction, you should manually disable the EIB 
Server from running as a service. To do this, on the Start menu, point to Settings, Control 
Panel, Administrative Tools, and then Services. The Services window appears. Double-click 
the GE EIB Server to open the Properties dialog box. In the Startup Type drop-down list, 
select Manual and click OK. If you do not configure the Manual option, you may encounter 
an error message when you automatically start your applications at system boot, or in the 
event log. The following is an example of the message that can appear at system boot: 

Hardware key error. Either EIBServer Manager bit is not enabled in the 
key, or the key is bad.  

• When you run the Services Configuration Utility, you have the following configuration 
options:  

Run as Regular Server – This is the default configuration. Select this option if you do not 
want to run Batch Execution applications as Windows services. When a user logs out 
of the computer, the Batch Execution applications will shut down.  

Run as Windows Service – Select this option if you want the Batch Execution applications 
to run as Windows services. This allows the Batch Execution applications to continue 
running after the user logs off the computer. The Batch Execution applications will not 
shut down after the user logs out.  

IMPORTANT: You must be logged in as Administrator if you want to select the Run as 
Windows Service option. Additionally, the Batch Execution Server or EIB Server cannot 
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be running when you select your service options.  

If you choose to run as a Windows service, you have additional options to choose from. You 
can optionally select the Automatically Start Applications at System Boot check box. Then, 
you have the choice to select either the "Run under local system account" or "Run under this 
account" option. Here is more information about each of these individual options: 

Automatically Start Applications at System Boot – Select this option if you want to 
automatically start the Batch Server and EIB Server when Windows starts.  

Run under local system account – Select this option to run the Server and EIB Server as 
Windows services under the local system account. This limits access to system 
resources. You cannot archive to a remote database or use UNC paths with this option 
enabled.  

Run under this account – Select this option to configure the Batch Server and EIB Server to 
run as Windows services under a specified user account. This allows access to network 
resources. Enter a Windows user name and password in the fields below this option. 
This user must already be configured as a Windows user account before you can add it 
here; you cannot create a new user by entering it here. If you leave the default user 
settings during install, the account name that displays in this field is BatchExecutive 
and the password is batchrules. If the user is on a domain, then you need to specify the 
domain and the user name. Make sure that the password you enter follows the security 
rules and settings, such as complex passwords, for the domain. The following figure 
illustrates an example of a domain with the user name.  
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Changing the Default Batch User Account 
When you install Batch Execution, you are prompted to enter a user name and password for the 
account used to run batch applications. This account is created locally during the install process. Be 
aware that if you are installing on a domain, that you will need to make sure that this account exists on 
the domain. If no user name and password is specified during the install, the default user name of 
BatchExecutive, and password of batchrules is created.  

Normally, you will not need to change the batch user account information. However, if you left the 
default account name during install and did not change the password field, you should change this 
password for security reasons. If you change this password, you will also need to change the password 
setting for the user account and for the VBIS service. All Batch services must be stopped before you 
can do this. The following steps describe how to do this.  

To change the password of the default batch user account: 

1. In Windows, log in as an Administrator. 

2. If Batch is running as a service, make sure that the Batch Server, EIB Server, and VBIS 
services are not running. If they are, shut them down. 

3. If the Archiver is running, shut it down from the Archiver Manager. 

4. On the Start menu, point to Settings, Control Panel, Administrative Tools, and then Computer 
Management. The Computer Management dialog box appears. 

5. In the System Tools folder, open the Local Users and Groups folder, and select Users.   

6. Right-click the default batch user account (this is BatchExecutive, if you did not change this 
account during the install) and select Set Password. A message box appears.  

7. Click Proceed to continue. The Set Password for Account dialog box appears. 

8. In the New Password field, enter the new password. Be sure to take note of this password.  

9. In the Confirm Password field, enter the password again, and click OK. 

10. On the Start menu, point to Settings, Control Panel, Administrative Tools, and then Services. 
The Services dialog box appears. 

11. Right-click the "GE Intelligent Platforms Batch Integration Services" service and select 
Properties. The Properties dialog box appears. 

12. Select the Log On tab. 

13. In the Password and Confirm Password fields, enter the password you typed in steps 8 and 9. 

14. Click OK. 

Changing the Account that Batch Uses to Run as a Service 

If you are running Batch Execution as a service, you can change the account that the Batch 
applications, such as the Batch Server, run under by using the Services configuration utility. 

To change the batch account from the one specified during install: 

1. In Windows, log in as an Administrator. 

2. Make sure that the Batch Server and EIB Server are not running. If they are, shut them down. 
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3. If the Archiver is running, shut it down from the Archiver Manager. 

4. Click the Start button, point to Programs, Proficy Batch Execution, and then Services 
Configuration.  The Batch Execution Services Configuration Utility dialog box appears. 

5. To run these applications as Windows services, select the Run as a Windows Service button.   

6. Optionally, if you want to start the Batch Server and EIB Server when Windows starts, select 
the Automatically Start Applications at System Boot check box. 

7. Select the Run under this account option. This configures the Batch Server and EIB Server to 
run as services under a specified user account. This also allows access to network resources.  

8. Enter a Windows user name and password. This user must already be configured as a 
Windows user account before you can add it here; you cannot create a new user by entering it 
here.  

9. Click OK. 

Batch Services Configuration Dialog Boxes 
The Batch Execution application includes the following dialog box for system configuration: 

• Batch Execution Services Configuration Utility Dialog Box 

Batch Execution Services Configuration Utility Dialog Box 

The Batch Execution Services Configuration Utility dialog box displays the following items: 

Batch Execution Services Configuration Utility Tab 

Item Description 

Run as Regular Server Select Run as Regular Server if you do not want to run the Batch 
Execution Server, Batch Archiver, and EIB Server as a Windows 
services. When a user logs out of the computer, the Batch Execution 
applications will shut down. 

NOTE:  This is the default configuration setting. 

Run as a Windows 
Service 

Select Run as a Windows Service if you want to run the Batch 
Execution Server, Batch Archiver, and EIB Server as a Windows 
services. This allows the Batch Execution applications to continue 
running after the user logs off the computer. The Batch Execution 
applications will not shut down, after the user logs out.  

IMPORTANT: You must be logged in as Administrator if you want to 
select the Run as a Windows Service option. Additionally, the Batch 
Execution Server or EIB Server cannot be running when you select 
your service options.  
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Item Description 

Automatically Start 
Applications at System 
Boot 

Select this option if you want to automatically start the Batch 
Execution Server, Batch Archiver, and EIB Server when Windows 
starts. 

Run Under Local 
System Account 

Select Run under local system account to run the Server, Batch 
Archiver, and EIB Server as Windows services under the local system 
account. This limits access to system resources. You cannot archive to 
a remote database or use UNC paths with this option enabled.  

Run Under This 
Account 

Select Run under this account if you want to configure the Batch 
Server and EIB Server to run as services under a specified user 
account. This allows access to network resources.  

Enter a Windows user name and password in the fields below. The user 
name that you enter must already be configured as a Windows user 
account before you can add it here; you cannot create a new user by 
entering it here. If you leave the default user settings during install, the 
account name that displays in this field is BatchExecutive and the 
password is batchrules.  

DCOM Tab 

Item Description 

Domain Enter the domain name if the user account you want to add belongs to a 
domain; otherwise, leave this field empty. 

User Name Enter the user name to be added to the DCOM permission list.  

Windows Firewall Lists the executables that will be added to the Firewall Exception list if 
the Windows Firewall is enabled. 

NOTE: The Windows Firewall area appears in this dialog box only if 
the Windows Firewall is enabled. 

Select a check box to add a file (BatchClient.exe, BatchServer.exe, or 
VBIS.exe) to the Exception list, if you did not already do so during or 
after the install process. The BatchClient.exe is the only file that 
appears in Windows Vista. By default, any check boxes that display are 
selected.  

After the file is added to the Firewall Exception list, you cannot remove 
it by clearing the check box. When you select a check box, you can re-
add the item to the Exception List. 
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Using the Batch Execution Server Manager 
The Batch Execution Server Manager is the application that you use to manage and monitor the Batch 
Execution Server, including the following tasks: 

• Starting and stopping the Batch Execution Server.  

• Verifying the status of equipment tags in the area model.  

• Monitoring the conversation status between the Batch Execution Server and its OPC Servers, 
such as iFIX SCADA Servers.  

• Monitoring batch statistics including the current number of:  

• Batches  

• Operator prompts  

• Phase failures  

• Monitoring communications between the Batch Execution Server and any subscribed clients, 
such as Batch Execution Clients, and other data sources, including relational databases.  

• Monitoring informational, warning, and severe errors encountered by the Batch Execution 
Server. These messages are also logged to the VBEXEC.LOG file.  

Configuring Server Settings 
For each Batch Execution project that you create, you need to define the Batch Execution Server 
settings, including: 

• Restart control  

• Warm restart paths  

• Hold propagation  

• File and disk settings  

• Equipment capacity setting  

The following sections describe each configuration setting. 

Setting up the Restart Control 

The Batch Execution Server can start up in one of the following modes: 

• Cold Restart  

• Warm Restart  

• Prompt  

These settings control how the Batch Execution Server starts. The following sections describe each 
mode. 
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Cold Restart Mode  

Selecting cold restart is best when you first start the Batch Execution Server or after a controlled 
shutdown and restart of your process. In the cold restart mode, the Batch Execution Server provides an 
empty batch list to the operators, forcing them to select the batches they want to schedule and run.  

Warm Restart Mode  

Selecting warm restart lets operators continue from the point where the batch left off. Typically, you 
warm restart the Batch Execution Server when a batch is interrupted unexpectedly, for example, after a 
power failure.  

When a warm restart occurs, Batch Execution restores the batch list and the state of each batch to its 
last known state. Batch Execution also re-synchronizes the phase logic with the phases defined in the 
area model. Batch operations can then continue as if they had not been interrupted. 

NOTE: If there is a delay before a warm restart occurs, the batch may need to be finished manually. 

Prompt Mode  

By default, the Batch Execution Server starts in prompt mode. When in prompt mode, the Batch 
Execution Server prompts you to select a restart mode.  

You can eliminate the startup prompt and automatically start up the Batch Execution Server by 
selecting cold or warm restart mode in the Restart Control tab of the Batch Execution Configuration 
dialog box.  

NOTE: Prompt mode is not available if the Batch Execution Server is configured to start when the 
computer boots. You can configure the Batch Execution Server to start when the computer boots in the 
Services Configuration Utility. For more information, refer to the Configuring the Batch Execution 
Server to Run as a Windows Service section. 

Defining the Warm Restart Paths  

When an operator schedules a batch during production, the Batch Execution Server copies the files it 
needs to perform a warm restart into two specified paths: a primary path (restart1) and a secondary 
path (restart2). The primary path is the main path you want the Batch Execution Server to use when a 
warm restart occurs. Typically, this is a local path. 

The secondary path provides a backup to the primary path. Batch Execution uses the secondary path if 
the primary path is unavailable when a warm restart occurs. Typically, this is a path to a file server. 

To perform a warm restart, Batch Execution creates the following directory and files in both the 
primary and secondary paths: 

.OBT directory – For each batch that you add to the batch list, Batch Execution creates an .OBT 
directory that contains copies of the recipe files that the batch uses.  

DAT files – Batch Execution creates .DAT files to temporarily store persistent lists of the Batch 
List, Prompt List, and Alarm List. 

When you warm restart the Batch Execution Server, the server reads the files in the warm restart paths 
to restore the batch list and the state of each batch to its last known state. 
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NOTE: Batch Execution requires you to define primary and backup restart paths. If you do not specify 
a primary or secondary restart path, the default path is typically C:\Program Files\Proficy\Proficy 
Batch Execution\projects\project_name\restart1 and C:\Program Files\Proficy\Proficy Batch 
Execution\projects\project_name\restart2. 

Setting up Hold Propagation 

Hold propagation can be configured for each project. Hold propagation controls how the Batch Server 
responds to phase failures. In general, when a phase fails, the phase's hold logic executes and the 
controller sets the _F register with a value indicating a failure. The Batch Server can ignore the hold 
command (no hold propagation) or can respond by holding: 

• A phase  

• An operation  

• A unit procedure  

• The entire batch procedure  

Each of these items corresponds to one level in the procedural hierarchy, as the following figure 
shows. 
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Batch Levels  

Example: Hold Propagation 

For example, when you set the hold propagation level to the batch procedure level and the PLC issues 
a hold command, the command propagates up from the phase through the entire procedure, as the 
following figure shows. 
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Hold Propagation for an Entire Batch  

If you change the hold propagation to a lower level, the hold command propagates up to the selected 
level, as the following figure shows. 
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Hold Propagation up to a Unit Procedure  

Batch Modes 

Hold commands are also affected by batch modes. A batch mode is a state associated with each 
procedure in a batch. Possible modes are as follows:  

Manual mode – prevents the procedure's transition from executing, but allows an operator to send 
commands to a batch.  

O-Auto mode – allows the procedure's transition to execute and allows an operator to send 
commands to a batch. This is the default mode for the highest procedure level in the batch.  

P-Auto mode – allows the procedure's transition to execute but prevents an operator from sending 
commands to a batch. This is the default mode for the lower-level procedures in the batch. 

For example, if you run a batch that executes a batch procedure containing two unit procedures, the 
batch procedure runs in O-Auto mode and the underlying unit procedures, operations, and phases run 
in P-Auto mode. Similarly, if you just run a unit procedure, the unit procedure runs in O-Auto mode, 
because this is the highest level for this batch, and its underlying operations and phases run in P-Auto 
mode. 

When hold command is issued, the command propagates up the batch structure. If the command 
encounters a step in O-Auto mode before it reaches the selected hold propagation level, propagation 
stops, as the following figure shows. 
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Hold Propagation and Batch Modes  

Defining the File and Disk Settings  

During operation, each Batch Execution Server maintains a historical record of the commands it 
received and the operations it performed. Batch Execution stores this record in a log file called 
VBEXEC.LOG. This file resides in the Batch Execution Log directory. 

You can control the maximum space that this files uses by configuring the file and disk settings of the 
Batch Execution Server in the Proficy Batch Execution WorkSpace. 

Enabling Equipment Capacity  

Batch Execution lets you enable or disable equipment capacity for your project. When enabled, Batch 
Execution ensures that units allocated to unit procedures meet the minimum capacity defined for the 
unit procedure in the recipe. For example, if a unit procedure specifies that it requires a unit with a 
capacity of 1000 Liters, the Batch Execution Server will only allocate units with a capacity setting that 
is greater than or equal to 1000 Liters. For 3.0 projects, equipment capacity is disabled.  
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For information on configuring a unit's equipment capacity, refer to the Equipment Configuration 
Manual. For information on configuring a unit procedure's capacity requirement, refer to the Recipe 
Development Manual. 

Server Manager Dialog Boxes 
The Server Manager application includes the following dialog boxes for managing the Batch Server: 

• Batch Server Manager Dialog Box 

• Choose Boot Method Dialog Box 

Choose Boot Method Dialog Box 

The Choose Boot Method dialog box displays the following items: 

Warm 

Click to return the Batch Execution Server to its last known state. Control recipes, manually controlled 
phases, and arbitration functions are returned to the state that existed prior to the termination of the 
server.  

Cold 

Click to start the Batch Execution Server with an empty batch list and with no resources allocated to 
the operator.  

Cancel 

Closes the dialog box without saving any changes you have made. 

Batch Server Manager Dialog Box 

The Batch Server Manager application includes the following tabs: 

• Server Tab 

• Data Servers Tab 

• Statistics Tab 

• Server Messages Tab 

• Equipment Audit Information Tab 

Server Tab 

The Server tab in the Batch Server Manager displays the following items: 
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Server Info Group 

The following table lists the contents of the Server Info group:  

Item Description 

Version Displays the version number of the Batch Execution Server. 

Started at 
Displays the date and time the batch started. 

Area Model File 
Displays the full path name of the currently configured area model file. 
For example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\RECIPES\DEMO.CFG  

Server Control Group 

The following table lists the contents of the Server Control group:  

Item Description 

Server Status Displays the current Server status. 

Icon 
Shows the running status of the Batch Execution Server. 

Start Server 
Click to start the Batch Execution Server. 

Stop Server 
Click to shut down the Batch Execution Server.  As part of a 
controlled shutdown, be sure to put all batches in a Hold state before 
shutting down.  This improves performance when you perform a 
warm restart. 

License Info Group 

The following table lists the contents of the License Info group:  
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Item Description 

Maximum Units 
Allowed 

Displays the maximum number of units that can be configured in 
the Proficy Batch Execution WorkSpace, allowed under your 
current license. 

Total Units 
Displays the total number of units configured in the current area 
model. 

   

Data Servers Tab 

The Data Servers tab in the Batch Server Manager displays the following items: 

Data Server Info Group 

The following grid displays the data server's name, type, and communication status.   

Tag Verification Group 

The following table lists the contents of the Tag Verification group:  

Item Description 

Tag Verify Status Displays the status of the tag verification procedure.  

Valid Entries:  Run, Not Run, or Completed.  

Verified Tag Count 
Displays the number of verified tags. 

Bad Tag Count 
Displays the number of bad tags. 

Verify Tags 
Orders each tag in the area model to retrieve its value.  

Statistics Tab 

The Statistics tab in the Batch Server Manager displays the following items: 
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Batch Statistics Group 

The following table lists the contents of the Batch Statistics group:  

Item Description 

Batch Count Displays the number of batches currently in the batch list. 

Operator Prompts 
Count 

Displays the number of operator prompts waiting to be 
acknowledged. 

Binding Prompts Count 
Displays the number of binding prompts waiting to be 
acknowledged. 

Server Communication Group 

The following table lists the contents of the Server Communication group:  

Item Description 

Connections Displays the number of clients currently subscribed to the server. 

Items 
Displays the number of OPC items. 

Server Messages Tab 

The Server Messages tab in the Batch Server Manager displays the following items: 

Info 

Displays all informational messages generated by the Batch Execution Server.   

Warning 

Displays all warning messages generated by the Batch Execution Server.   

Severe 

Displays severe messages generated by the Batch Execution Server.   
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Equipment Audit Information Tab 

The Equipment Audit Information tab in the Batch Server Manager displays the following items: 

Area Model File 

Displays the full path name of the currently configured area model file. For example:  C:\Program 
Files\Proficy\Proficy Batch Execution\Projects\DEMO\RECIPES\DEMO.CFG 

Audit Version 

Displays the audit version number of the currently configured area model file. The audit version 
number increases by one each time the area model is saved. 

Performed By Group 

The following table lists the contents of the Performed By group:  

Item Description 

User Name Displays the Windows user ID of the operator (in the Performed 
By group) who last authorized the saving of the area model 
before the Server Manager started.     

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area 
model with the required electronic signatures. 

Full Name 
Displays the full user name of the operator (in the Performed By 
group) who last authorized the saving of the area model before the 
Server Manager started.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures. 

Timestamp 
Displays the date and time when Proficy Batch Execution 
authenticated the electronic signature of  the operator (in the 
Performed By group).   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures.  
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Item Description 

Comment 
Displays any comments entered by the operator (in the Performed 
By group) who last authorized the saving of the area model before 
the Server Manager started.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures. 

Verified By Group 

The following table lists the contents of the Verified By group:  

Item Description 

User Name Displays the Windows user ID of the supervisor (in the Verified 
By group) who last authorized the saving of the area model 
before the Server Manager started.    

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area 
model with the required electronic signatures. 

Full Name 
Displays the full user name of the supervisor (in the Verified By 
group) who last authorized the saving of the area model before the 
Server Manager started.   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures. 

Timestamp 
Displays the date and time when Proficy Batch Execution 
authenticated the electronic signature of  the supervisor (in the 
Verified By group).   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures. 



System Configuration Manual 

37 

Item Description 

Comment 
Displays any comments entered by the supervisor (in the Verified 
By group) who last authorized the saving of the area model before 
the Server Manager started.   

Information only appears in this field if you enabled auditing and 
configured Save or Save As signature requirements in the Batch 
Execution Configuration dialog box, and then saved the area model 
with the required electronic signatures. 

Configuring the Soft Phase Server 
The Soft Phase Server is an OPC Server, running under Windows, that acts as a PC-based controller 
between the Batch Execution Server and soft phases. Soft phases are Batch Execution phases whose 
phase logic is provided by scripting or programming outside of a hardware controller (PLC or DCS) 
environment. You can implement soft phases either within iFIX or with any development systems that 
supports OLE Automation servers and OLE for Process Control (OPC), using Visual Basic, C++, or 
Java programming languages. In every case, communication between the Soft Phase Server, the Batch 
Execution Server, and the phase logic is accomplished using OPC.  

The following figure illustrates how the Soft Phase Server communicates to other processes, when you 
configure soft phases in iFIX. 

 

Overview of Soft Phase Server Configuration 
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NOTE: By default, the Soft Phase Server runs in Simulation Mode.  

The Soft Phase Server provides the state machine and PLI for each soft phase in the system, as 
described in the PLI Development Manual. Phase logic is implemented as described in the Phase 
Programming Manual, using scripting or programming languages. 

The Soft Phase Server provides a client/server solution for developing soft phases and can support 
multiple clients connected at the same time. The Soft Phase Server also provides a single server for all 
soft phases in the system, eliminating the need to develop and deploy separate applications for each 
soft phase. 

IMPORTANT: The Soft Phase Server is not intended for control phases.  

Examples of some of the functions for which you can use a Soft Phase Server are as follows: 

• Electronic work instructions  

• Screen interactions  

• Mathematical calculations  

• Database transactions for inventory and tracking  

NOTES:  

• The Soft Phase Server cannot be run as a Windows service. 

• The Soft Phase Server supports a maximum of 50 parameters, 50 reports, and 50 request 
qualifiers per phase. 

Before You Begin Configuring iFIX and the Soft Phase Server 
Before you begin to configure the Soft Phase Server, you need to know the phase names and IDs, from 
the Batch Execution Equipment Editor, that you want to run as soft phases. It is important that the item 
ID in the OPC Client driver and the iFIX database match the item ID for the equipment phase that you 
used in the Batch Execution area model. 

Also, if you want to configure any report parameters, phase parameters, or request data tags directly 
from the Soft Phase Server, you need to know the names of these tags and add them to your area 
model. For example, if you are using requests to download parameters for some phase, you need to 
configure the parameters for that phase in the Batch Execution Equipment Editor when you are 
designing your area model.  

If you did not already install the OPC Client driver on the Soft Phase Server computer, you need to 
install it as well. 

Installing the OPC Client Driver 

The steps that follow explain how to install the OPC Client driver. 
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To install the OPC Client driver:  

1. Insert the GE I/O Drivers and OPC Servers CD into your CD-ROM drive. The GE Driver CD 
screen appears.  

NOTE: You can also install the OPC Client driver by downloading and running the setup.exe 
file for this driver from GE support on the Downloads web page, www.ge-
ip.com/support/downloads.asp . 

2. Click the Install Driver button. The Install Driver Selection screen displays.  

3. Select the OPC-OLE for Process Control Client 7.31.  

NOTE: The version of the OPC driver may be different. Make sure you use version 7.20b or 
higher. 

4. Click Install Now. The GE I/O Drivers and OPC Servers License Agreement appears.  

5. Click I Agree to continue. The OPC Client Setup dialog box appears.  

6. Click Next to continue. The License Agreement appears.  

7. Click Next to continue.  

8. Enter the installation directory. Usually this path is the same as your iFIX software. For 
example: C:\Program Files\Proficy\Proficy iFIX.  

9. Click Next.  

10. Select the Server option for the node type.  

11. Click Next to continue.  

12. Enter the iFIX node name and click Next.  

13. Enter the name of the folder that you would like to contain the OPC Power Tool and Help 
icons, if you want to specify a custom path.  

14. Click Finish. Before the install completes, the release notes display. After you close the 
release notes, a message box displays when the install is complete.  

15. Click Done.  

Tasks to Configure iFIX to Work with the Soft Phase Server 
The steps below explain how to configure iFIX to use the Soft Phase Server. 

To configure your system to use a Soft Phase Server:  

1. Configure the Soft Phase Server in the Batch Execution WorkSpace.  

2. Configure the Soft Phase Server with the OPC Power Tool.  

3. Configure the iFIX database blocks.  

4. Configure the Soft Phase Server mode.  

5. Configure the Watchdog for the Soft Phase Server.  

6. Configure the Soft Phase Server from the Proficy iFIX WorkSpace.  

NOTE: If you are using the OPC Client driver, then you do not need to configure the Soft 
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Phase Server from the Proficy iFIX WorkSpace. You do not have to use the OPC Client driver 
if the Batch Execution Server, Soft Phase Server, and Proficy iFIX WorkSpace all reside on 
the same local computer. 

7. Design your soft phases in iFIX, Visual Basic, C++, or Java.  

If you use C++ or Java, you need to use the OPC Client driver or have some other OPC client 
to communicate with the Soft Phase Server directly. 

Configuring the Soft Phase Server in the Batch Execution 
WorkSpace 
In order to use the Soft Phase Server with your Batch Execution project, you must do the following 
from the Batch Execution WorkSpace: 

• Add a data server to register the Soft Phase Server within Batch Execution.  

• Configure the default startup path for the Soft Phase Server configuration file.  

• Specify the Soft Phase Server as the data server for the equipment phases.  

To define a data server:  

1. From the Batch Execution WorkSpace, click the Edit Servers button on the toolbar. The Edit 
Servers dialog box appears.  

2. Click the New Server button. The Edit Server Name dialog box appears.  

3. In the Server Name field, enter the name of the OPC server and click the OPC Server button. 
The Create OPC Server dialog box appears.  

4. Select the Intellution.SPServer driver from the Select a Server drop-down list.  

5. In the Watchdog field, enter a tag to act as a watchdog register.  

6. Click OK. The new OPC server appears in the list in the Edit Servers dialog box.  

To configure the default startup path for the Soft Phase Server configuration file:  

1. Double-click the Batch Execution Configuration icon in the WorkSpace tree. The Batch 
Execution Configuration dialog box opens.  

2. Click the Restart Control tab.  

3. In the Soft Phase Server field, enter the fully qualified path of the configuration file that you 
want to load when starting up the Soft Phase Server.  

4. If you are using OPC simulation, enter the fully qualified path of the configuration file that 
you want to load when starting up the Simulator in the Simulator field.  

To specify the Soft Phase Server as the data server for the equipment phases:  

1. Double-click a phase instance. The Edit Equipment Phase dialog box appears.  

2. Click the Server button. The Set Tag Server dialog box appears.  

3. Click the down arrow next to the Name field and select the Intellution.SPServer.  
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NOTE:  The Change All Tags check box is unavailable. It is automatically selected for you so 
that all tags in this phase are assigned to the same server.  

4. Click OK.  

5. Repeat steps 1-5 for each phase for which you want to use Soft Phase Server as the data 
server.  

Configuring the Soft Phase Server with the OPC Power Tool in 
iFIX 
Before you can configure the Soft Phase Server with the OPC Power Tool, you must add the OPC 
Client driver to your iFIX SCADA configuration.  

To add the OPC Client driver to your iFIX SCADA configuration:  

1. From the Proficy iFIX WorkSpace, double-click the System Configuration icon in the 
WorkSpace tree to start the System Configuration Utility (SCU).  

2. On the Configure menu, click SCADA. The SCADA Configuration dialog box appears.  

3. Click Enable.  

4. Click Browse next to the I/O Driver Name field. The Drivers Available dialog box appears.  

5. Select the OPC - OLE for Process Control Client driver and click OK.  

6. Click Add.  

7. Click OK.  

8. Save the current SCU settings.  

To configure the Soft Phase Server with the OPC Power Tool:  

1. Open the OPC Power Tool from the folder that you installed it to. If you chose the default 
locations, go to the Start menu, select Programs, Proficy HMI SCADA - iFIX, and then OPC 
Power Tool.  

The I/O Driver Server Configuration dialog box appears. 

2. Click Use Local OPC Client Driver. 

3. Click Connect. The OPC Power Tool appears.  

4. On the Edit menu, click Add Server. The Select the Host Machine dialog box appears. 

5. Click Use Local OPC Server and then click Next. The Select an OPC Server dialog box 
appears. 

6. Select Intellution.SPServer.  

7. Click Finish. The server information appears on the right side of the OPC Power Tool 
window, as shown in the following figure.  
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OPC Power Tool Dialog Box 

7. In the Server Name field, enter a name.  

8. Select the Enabled check box. The Choose Boot Method dialog box appears for the Soft 
Phase Server.  

NOTE: The Choose Boot Method dialog box only appears if the Soft Phase Server is not 
already running. 

9. Click Cold. The Soft Phase Server application starts.  

10. Switch back (Alt+Tab) to the OPC Power Tool.  

11. On the Edit menu, click Add Group. The group information appears on the right side of the 
OPC Power Tool window.  

12. In the Group Name field, enter a group name.  

13. In the OPC Group Communications Settings, select Asynchronous for the I/O Type.  

NOTE: Both Asynchronous and Synchronous can be used for communications. Asynchronous 
is recommended, however, for better performance.  

14. Select the Enable check box.  

NOTE: You do not have to specify a data source since all data for the Soft Phase Server is maintained in 
memory. If you select a Data Source in this dialog box, the Soft Phase Server ignores it. 
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15. On the Edit menu, click Add Item. The item and group information appears on the right side 
of the OPC Power Tool window.  

16. In the Item Name field, enter an item name.  

17. In the OPC Item Settings group box, in the Item ID field, enter the item ID. It is important 
that the item ID match the item ID that you used in the area model.  

18. Select Server for the Requested Datatype field.  

19. In the Client Settings group box, type Disabled in the Access Time field, if it is not already 
entered.  

20. Select the Enable check box.  

21. Repeat steps 11-20 to add the remaining groups and items.  

For each phase that executes as a soft phase, the items in the following table must be created. 
The item naming convention follows the same naming convention as defined in the Allocating 
Phase Memory Variables section.  

Phase Tag Item Name Item ID 

P01 PHASEP01 PHASEP01 

Request PHASE_RQ PHASE_RQ 

Status PHASE_ST PHASE_ST 

Aborting Complete PHASE_AC PHASE_AC 

Running Complete PHASE_RC PHASE_RC 

Holding Complete PHASE_HC PHASE_HC 

Restarting Complete PHASE_TC PHASE_TC 

Starting Complete PHASE_SC PHASE_SC 

Command PHASE_VC PHASE_VC 

22. On the File menu, click Save. The Save As dialog box appears.  

23. Enter a name in the File Name field and click Save.  
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Configuring the iFIX Database Blocks 
The steps that follow explain how to configure database blocks in iFIX.  

To configure the Proficy iFIX database blocks:  

1. Start Database Manager from the Proficy iFIX WorkSpace.  

2. Add the database blocks:  

• Create Analog Input (AI) or Digital Input (DI) blocks for items that you need read-
only access to. With read-only access you cannot change the value of the item.  

• Create Analog Output (AO) or Digital Output (DO) blocks for items that you need 
read/write access for. With read/write access you can change the value of an item.  

3. In the block configuration dialog box, for each data block:  

• Select the OPC Client in the Driver drop-down list. You should have 7.2b or higher 
of the OPC Client driver.  

• Enter the names of OPC Server, OPC Group object, and OPC item, in the I/O 
Address field. The entire address should use the following syntax:  

Server_Name;Group_Name;Item_Name;No Access Path 

For example, if the name of OPC server configured in OPC Client driver is Server1, 
the name of OPC group object is Group1, and the name of OPC item is 
PHASE11_VC, then the entire path to Soft Phase Server item is: 

Server1;Group1;PHASE11_VC;No Access Path 

Configuring the Soft Phase Server Mode 
There are three ways that you can run the Soft Phase Server. The following table outlines these 
configuration modes.  

Mode Description 

OPC Simulator Mode Simulation of both the PLI and phase logic. 

Partial Simulation Mode Simulation of the PLI and most of the phase logic. 

Soft Phase Mode Simulation of only the PLI. 

The next sections describe how to configure these modes from the within the Batch Execution Soft 
Phase Server. 

NOTE: You set this mode for each phase. 



System Configuration Manual 

45 

OPC Simulator Mode 

In this mode, the Soft Phase Server simulates both the PLI and phase logic. Phase logic can be 
configured for all active phase states. Request logic can be configured on any active state logic. 

If you want to run the Soft Phase Server in Simulation Mode, you need to select Manual Configuration 
from the Phase Configuration dialog box and then configure the requests. The Soft Phase Server uses 
these requests when running phases.  

To run the Soft Phase Server in Simulation Mode:  

1. Start the Soft Phase Server.  

2. Select Cold from the Choose Boot Method dialog box.  

3. On the Edit menu, click Phase Configuration. The Phase Configuration dialog box appears.  

4. Select an equipment phase from the drop-down list.  

5. Select the Manual Configuration check box.  

6. Select the Continuous Phase check box, if applicable, as shown in the following figure.  

 

Phase Configuration Dialog Box, OPC Simulation Mode 

7. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state.  

Clear this check box if you want these requests to continue to be processed when the batch is 
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put into a Holding state. If this check box is cleared, the batch will not be put into a Held state 
until all EIBs are completed. 

If the phase issues a 7001 request to start an electronic work instruction, as in the previous 
figure, clear the Clear Requests check box. 

8. Select a state from the drop-down list in the Select State group box.  

9. Configure the requests for the phase.  

10. Enter a dwell time, if applicable. The dwell time is the length of time a phase maintains a 
specific state.  

11. Click Update Phase.  

12. Repeat steps 4-10 for each state that you want to configure.  

13. Click Close to exit the Phase Configuration dialog box.  

14. On the File menu, click Save As. The Save As dialog box opens.  

15. Enter a name and click Save.  

Partial Simulation Mode 

In this mode, the Soft Phase Server simulates both the PLI and most of the phase logic. This mode 
allows users to configure requests in the Phase Configuration dialog box of Soft Phase Server instead 
of programming them in soft phase logic. Phase logic can be configured for all active phase states. You 
must program the Complete bit externally; the Soft Phase Server does define this bit. The soft phase 
logic should set the following tags to 1:  

• _RC (Running Complete)  

• _HC (Holding Complete)  

• _TC (Restarting Complete)  

• _SC (Stopping Complete)  

• _AC (Aborting Complete)  

If you want to run the Soft Phase Server in Partial Simulation Mode, you need to select Soft Phase and 
Manual Configuration from the Phase Configuration dialog box and then configure the requests. The 
Soft Phase Server uses the configured requests when running phases. It also will be updating step 
index register internally. 

To run the Soft Phase Server in Partial Simulation Mode:  

1. Start the Soft Phase Server.  

2. Select Cold from the Choose Boot Method dialog box.  

3. On the Edit menu, click Phase Configuration. The Phase Configuration dialog box appears.  

4. Select an equipment phase from the drop-down list.  

5. Select the Soft Phase check box.  

6. Select the Manual Configuration check box, as shown in the following figure.  
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Phase Configuration Options, Partial Simulation Mode 

NOTE: The Continuous check box is unavailable since this setting is irrelevant for soft 
phases. 

7. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state.  

Clear this check box if you want these requests to continue to be processed when the batch is 
put into a Holding state. If this check box is cleared, the batch will not be put into a Held state 
until all EIBs are completed. 

8. Select a state from the drop-down list in the Select State group box.  

9. Configure the requests for the phase.  

10. Enter a dwell time for all active states. The dwell time is the length of time a phase maintains 
a specific state.  

11. Click Update Phase.  

12. Repeat steps 4-10 for each state that you want to configure.  

13. Click Close to exit the Phase Configuration dialog box.  

14. On the File menu, click Save As. The Save As dialog box opens.  

15. Enter a name and click Save.  

Soft Phase Mode 

In this mode, the Soft Phase Server simulates only the PLI. When you use Soft Phase Mode, the Soft 
Phase Server ignores update requests in the Phase Configuration dialog box; the Soft Phase Server 
does not update the step index in this mode. It is the responsibility of soft phase logic to 
programmatically handle requests and updates to step index register. All phase logic must be 
programmed externally, which includes setting the Complete bit to 1. The soft phase logic should set 
the following tags to 1:  

• _RC (Running Complete)  

• _HC (Holding Complete)  

• _TC (Restarting Complete)  

• _SC (Stopping Complete)  

• _AC (Aborting Complete)  

At the startup, the Soft Phase Server creates these items for each phase. When the Soft Phase Server 
runs phases, it checks these tags if a phase is configured as a soft phase. 
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To configure Soft Phase Mode:  

1. Start the Soft Phase Server.  

2. Select Cold from the Choose Boot Method dialog box.  

3. On the Edit menu, click Phase Configuration. The Phase Configuration dialog box appears.  

4. Select an equipment phase from the drop-down list.  

5. Select the Soft Phase check box, as shown in the following figure.  

 

Phase Configuration Options, Soft Phase Mode 

NOTE: Do not check the Manual Configuration check box. When the check box is cleared, 
the Soft Phase Server ignores requests in the Phase Configuration dialog box and does not 
update the step index. It is the responsibility of soft phase logic to programmatically handle 
requests and updates to step index register.  

6. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state.  

Clear this check box if you want these requests to continue to be processed when the batch is 
put into a Holding state. If this check box is cleared, the batch will not be put into a Held state 
until all EIBs are completed. 

7. Click Update Phase.  

8. Repeat steps 4-6 for each phase that you want to configure.  

9. Click Close to exit the Phase Configuration dialog box.  

10. On the File menu, click Save As. The Save As dialog box opens.  

11. Enter a name and click Save.  

Configuring the Watchdog for the Soft Phase Server 
In order to notify soft phases if the Batch Execution Server suddenly shuts down, there is an item in 
Soft Phase Server called BatchServer_Status. The BatchServer_Status is a global item, and it is not 
associated with any phase. Every soft phase needs to subscribe to this item if it needs to be informed 
whether the Batch Execution server is running.  

Basically, every time the Soft Phase Server gets a watchdog update from the Batch Execution Server, it 
assumes that Batch Execution Server is up and running. The Batch Execution Server sends watchdog 
updates according to the settings in Communications Timeout field under the Server tab in the Batch 
Execution Configuration dialog box. If after some period of time the Soft Phase Server does not 
receive a watchdog update back from the Batch Execution Server, it sets the BatchServer_Status tag to 
1. Thus, the notifying soft phase knows that the Batch Execution Server is not running.  
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To define the time-out setting for the Soft Phase Server:  

1. Open the Batch Execution Soft Phase Server.  

2. Make sure that the Watchdog is enabled.  

If it is enabled, the Enable option is unavailable from the Watchdog menu. If it is not enabled, 
select Enable from the Watchdog menu. 

3. On the Watchdog menu, click BatchServer Status Timeout. The Batch Server Status Timeout 
Setting dialog box appears.  

4. Enter the time-out, in seconds.  

By default the time-out value is set to 60 seconds. You can change this setting to any value 
between 60 seconds and 1,000,000 seconds.  

5. Click OK.  

NOTE: Every time you change the time-out value and click OK, the new value gets stored in 
the Registry.  

6. Save the configuration.  

To disable the Watchdog for the Soft Phase Server:  

1. On the Watchdog menu, click Disable.  

2. Save the configuration.  

Configuring the Soft Phase Server from the Proficy iFIX 
WorkSpace 
In order to configure the Soft Phase Server to communicate directly with Proficy iFIX WorkSpace, you 
first need to register the Soft Phase Server with iFIX data system.  

NOTE: If you are using the OPC Client driver, then you do not need to configure the Soft Phase 
Server from the Proficy iFIX WorkSpace.  

To configure the Soft Phase Server from the Proficy iFIX WorkSpace:  

1. Run DataServerInstaller.exe file that is located in iFIX root directory. For example, this 
directory might be: C:\Program Files\Proficy\Proficy iFIX.  

2. Click Add. The Add Server dialog box appears.  

3. Enter the name that you would like to call the soft phase server. This name is the same name 
as the name that you used in the Configuring the Soft Phase Server with the OPC Power Tool 
in iFIX section.  

4. Select Intellution.SPServer from OPC Server drop-down list box. This list-box includes all of 
the registered OPC servers on your system.  

5. Click OK.  

6. Use iFIX Scheduler to build you soft phases if you are running in Partial Simulation or Soft 
Phase Mode.  

For example, if you want to write running logic for your soft phase, you need to create a new 
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schedule and then add a new event entry. Refer to the Mastering iFIX manual for details on 
how to add events in the Scheduler. 

NOTE: After you finish configuring the Soft Phase Server, the next time you launch iFIX, it 
will also launch the Soft Phase Server. 

Using the iFIX Scheduler to Build Soft Phases 
In the Scheduler's Add Event Entry dialog box you can click the Browse button next to the Data 
Source field to open the iFIX Expression Editor. Through the Expression Editor, you can obtain the 
status tag of the soft phase for which you are writing running logic. You can also manually enter the 
data source in the Trigger group box. For example, if phase name is PHASE11 and Soft Phase Server 
name is OPCSPS, then the expression in the scheduler is: OPCSPS.PHASE11_ST = 50, and the event 
type is OnTrue.  

After you add your events, iFIX creates a new VBA subroutine. In this subroutine you need to 
initialize your tag variables. The VBA code can be accessed by clicking the VB Editor button in the 
Add Event Entry dialog box. The following is a simple sample subroutine:  

Private Sub RunningEvent_OnTrue() 
'Get tag objects for PHASE11 
Set TagPhase11ST = System.FindObject("OPCSPS.PHASE11_ST") 
Set TagPhase11RC = System.FindObject("OPCSPS.PHASE11_RC") 
Set TagPhase11SI = System.FindObject("OPCSPS.PHASE11_SI") 
Set TagPhase11RQ = System.FindObject("OPCSPS.PHASE11_RQ") 
Set TagPhase11P01 = System.FindObject("OPCSPS.PHASE11P01") 
Set TagPhase11P02 = System.FindObject("OPCSPS.PHASE11P02") 
Set TagPhase11P03 = System.FindObject("OPCSPS.PHASE11P03") 
Set TagPhase11R01 = System.FindObject("OPCSPS.PHASE11R01") 
Set TagPhase11R02 = System.FindObject("OPCSPS.PHASE11R02") 
Set TagPhase11R03 = System.FindObject("OPCSPS.PHASE11R03") 
End Sub 

As soon as the phase state changes to running, this subroutine runs and initializes the tag variables.  

You also need to set up another event that will be triggered while the phase is running. Instead 
selecting OnTrue for the Event Type field in the Add Event Entry dialog box, use the WhileTrue event 
type. In addition, you will need to select interval at which this event will trigger. Below is a simple 
VBA sample script for running logic of a soft phase: 

'Declarations 
Public PauseTime, Start 
'Declarations of tag objects for PHASE11 
Public TagPhase11ST As Object 
Public TagPhase11RC As Object 
Public TagPhase11RQ As Object 
Public TagPhase11SI As Object 
Public TagPhase11P01 As Object 
Public TagPhase11P02 As Object 
Public TagPhase11P03 As Object 
Public TagPhase11R01 As Object 
Public TagPhase11R02 As Object 
Public TagPhase11R03 As Object 
  
Private Sub RunningPHASE11_WhileTrue() 
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Select Case TagPhase11SI 
        Case 0 
           TagPhase11RQ = 1000 
           TagPhase11SI = TagPhase11SI + 1 
        Case 1 
                TagPhase11R01 = 34.67 
                TagPhase11R02 = "GE_REPORT" 
                TagPhase11R03 = 23 
                TagPhase11RQ = 2000 
                TagPhase11SI = TagPhase11SI + 1 
        Case 2 
           MsgBox ("Go to step 3") 
           TagPhase11SI = TagPhase11SI + 1 
        Case 3 
           MsgBox ("Index Step is 3") 
           TagPhase11SI = TagPhase11SI + 1 
        Case 4 
           TagPhase11RC = 1 
        Case Else 'Do Nothing 
End Select 
End Sub 

The previous sample uses the step index to make sure that you execute the next step when WhileTrue 
event gets triggered after the configured interval.  

You can develop the logic for other active phase states (HOLDING, STOPPING, and so on) using a 
similar approach. Refer to the Writing Scripts manual for more information on using VBA with iFIX. 

Using the Batch Execution Soft Phase Server 
The following sections describe elements of the Batch Execution Soft Phase Server application: 

• Understanding Restart Control and the Soft Phase Server  

• Updating Unit Tags from the Batch Execution Soft Phase Server  

• Updating a Report Parameters from the Batch Execution Soft Phase Server  

• Troubleshooting the Soft Phase Server  

Understanding Restart Control and the Soft Phase Server 

When you start the Batch Execution Soft Phase Server, a prompts displays asking you to select a 
restart mode. You can start the Batch Execution Soft Phase Server in one of the following modes: 

• Cold Restart  

• Warm Restart  

• Prompt 

These settings control how the Batch Execution Soft Phase Server starts.  
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Cold Restart Mode  

Selecting cold restart is best when you first start the Batch Execution Soft Phase Server or after a 
controlled shutdown and restart of your process.  

Warm Restart Mode  

Selecting warm restart lets you continue from the point where the soft phase left off. Typically, you 
warm restart the Batch Execution Soft Phase Server when a batch is interrupted unexpectedly, for 
example, after a power failure.  

Batch Execution logs the status of each soft phase, every time it changes. Also, it logs step index 
values for each soft phase as they change when phases are in the RUNNING state. When a warm 
restart occurs, Batch Execution restores the stored value of the step index. 

Prompt Mode  

When in prompt mode, the Batch Execution Soft Phase Server prompts you to select a restart mode. 
You can eliminate the startup prompt and automatically start up the Batch Execution Soft Phase Server 
by selecting cold or warm restart mode in the Restart Control tab of the Batch Execution Configuration 
dialog box.  

To start the Soft Phase Server:  

1. Click the Start button and point to Programs, Batch Execution, and then the SPServer icon. 
The Choose Boot Method dialog box opens.  

2. Select Cold.  

NOTE: If you want to return the system to its last known state, select Warm. Only use the 
Warm boot method to recover batches and data after an unexpected loss of the Batch 
Execution Soft Phase Server. 

3. Start the Batch Execution Server.  

Updating Unit Tags from the Batch Execution Soft Phase Server 

By default, unit tags are updated externally, usually by soft phases. You can also manually update unit 
tags from the Batch Execution Soft Phase Server when a batch is running, if you are running in 
Simulation Mode.  

To manually update unit tags:  

1. Open the Batch Execution Soft Phase Server.  

2. On the Edit menu, click Unit Tag Status. The Unit Tag Status dialog box opens.  

3. Select the Manual Update check box, if you want you manually want to update unit tag 
values.  

4. Enter the new value for each unit tag that you want to change.  

5. Click Update values.  

6. Click Close. The settings associated with this dialog box get updated after you close the 
dialog box.  
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Updating a Report Parameters from the Batch Execution Soft Phase Server 

Normally report parameters and request data tags are updated externally, usually by soft phases. You 
can also manually update these tags from the Batch Execution Soft Phase Server when a batch is 
running. If you are running the Soft Phase Server in Partial Simulation Mode, you can use the Phase 
Status dialog box to make these changes. 

In order to make sure that the requests work correctly, you need to properly configure the phases in the 
area model. For example, if you are using requests to download parameters for some phase, you need 
to configure the parameters for that phase in the Batch Execution Equipment Editor when you are 
designing your area model.  

To set report parameters for a phase:  

1. Open the Batch Execution Soft Phase Server.  

2. On the Edit menu, click Phase Status. The Phase Status dialog box opens.  

3. Select a phase from the drop-down list.  

4. Select Report Parameter Tags from the drop-down list.  

5. Enter your changes.  

6. Click the Update Report Data button.  

7. Click Close.  

Troubleshooting the Soft Phase Server 

If the Soft Phase Server is not running and you start a Batch Execution project that has a Soft Phase 
Server configured as one of the data sources, when you click Start from the Batch Execution Server 
Manager, the starting logic will also start the Soft Phase Server. You will see Choose Boot Method 
dialog box for the Soft Phase Server. Do not cancel the Soft Phase Server at the point, because 
selecting Cancel will hang startup of the Batch Execution Server. To avoid problems, first start the Soft 
Phase Server and then the Batch Execution Server.  

NOTE: If you experience an abnormal shutdown with the Soft Phase Server, before you restart it, 
examine the Task Manager for the SPSEventMgr.exe application. If it is running, abort this 
application from Task Manager before restarting Soft Phase Server. 

Modifying the Restarting or Holding Logic for the Soft Phase 
Server 
With the Soft Phase Server, the following registers are exposed in the phase logic: 

• Step Buffer  

• Clear Requests Flag  

You can use these registers to modify the restarting or holding logic. 
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Restarting Logic 

The Step Buffer Register is exposed as an OPC item. This allows you to set the value of step index 
during restarting logic so that you can continue running from any step that you want after warm restart. 
The step buffer item has an extension of _SB. 

Holding Logic 

When enabled, the Clear Requests flag allows the PLI to clear all pending requests when a batch 
moves from the Running to Holding state. When this flag is set, any current request will be aborted 
with an Abort Request. If not enabled, these requests will continue to be processed. You can set this 
item in the phase logic or by using the Phase Configuration dialog box in the Soft Phase Server 
application. For example, when a soft phase is configured for EWI prompts (request 7001), you may 
choose to disable the Clear Requests flag. 

Soft Phase Server Dialog Boxes 
The Soft Phase Server application includes the following dialog boxes (listed in alphabetical order): 

• Batch Server Timeout Setting Dialog Box 

• Phase Configuration Dialog Box 

• Phase Status Dialog Box 

• Save As Dialog Box 

• SoftPhase Server - Choose Boot Method Dialog Box 

• Unit Tag Status Dialog Box 

Batch Server Timeout Setting Dialog Box 

The Batch Server Timeout Setting dialog box displays the following item: 

Batch Server Status Timeout In Seconds 

Enter the time-out, in seconds. By default, the time-out value is set to 60 seconds. You can change this 
setting to any value between 60 seconds and 1,000,000 seconds.  

Phase Configuration Dialog Box 

The Phase Configuration dialog box displays the following items: 

Select Phase 

Select a phase from the drop-down list. 

Select State  

The following table lists the contents of the Select State group:  
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Item Description 

State Select a state from the drop-down list 

Dwell Time 
The dwell time is the length of time a phase maintains a specific 
state. 

Execution Mode  

The following table lists the contents of the Execution Mode group:  

Item Description 

Soft Phase Select this check box if you want to run the Soft Phase Server in 
Soft Phase Mode.   

If you want to run the Soft Phase Server in Partial Simulation 
Mode, you need to select Soft Phase and Manual Configuration. 

Clear Requests 
Leave the Clear Requests check box selected (the default) if you 
want the PLI to clear all pending requests when a batch moves from 
the Running to Holding state.   

Clear this check box if you want these requests to continue to be 
processed when the batch is put into a Holding state.  If this check 
box is cleared, the batch will not be put into a Held state until all 
EIBs are completed. 

NOTE:  If the phase issues a 7001 request to start an electronic 
work instruction clear the Clear Requests check box.  

Manual Configuration 
Select this check box if you want to run the Soft Phase Server in 
Simulation Mode.  If you want to run the Soft Phase Server in 
Partial Simulation Mode, you need to select Manual Configuration 
and Soft Phase.  

Continuous Phase 
Select this check box if the phase is a continuous phase. The 
Continuous check box is unavailable when Soft Phase is selected 
since this setting is irrelevant for soft phases. 

Update Phase 

Click to update the phase. 
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Phase Status Dialog Box 

The Phase Status dialog box displays the following items: 

Select Phase 

Select a phase from the drop-down list. 

Set Complete 

Click to Set Complete. 

Update Report Data 

Click to update report data. 

Start/Stop 

Click to start or stop. 

Hold/Restrt 

Click to hold or restart. 

Abort/Reset 

Click to abort or reset. 

Owner 

Click to make an owner. 

Ask/Clear Request 

Click ask for or clear requests. 

Registers Group 

The Registers Group includes the following:  

• Unit 

• Status 

• Request 

• Step Index 

• Step Buffer 

• Failure 

• Owner 
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• Pause 

• Paused 

• Single Step 

• Restore Req 

• Clear Req 

• Download Req 

• Timer Acc 

Arrays Group 

The Arrays Group displays the following information for the Phase Parameter, Report Parameter, or 
Request Data Tags:  

• Select Tag 

• Parameter 

• Value 

• Type 

Save As Dialog Box 

The Save As dialog box displays the following items: 

Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 

Look In 

Lists the folders and files in the selected location.   

File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you’ve previously opened, click the file name in the drop-down list, if available. 

If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can type *.* to 
see a list of all files. You can also type the full path of a file, for example, C:\Mydocs\Letter.doc. 

If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If you use a 
question mark or asterisk and click Save, the file will not be saved and the dialog box will not close.  

Save as Type 

Specifies the type of file you are saving.  
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SoftPhase Server - Choose Boot Method Dialog Box 

The SoftPhase Server - Choose Boot Method dialog box displays the following items: 

Warm 

Click this button to return the server to its last known state. Only use the warm boot method to recover 
data after an unexpected loss of the server. 

Cold 

Click this button to start the server. This is the preferred method of starting the server. You would also 
select the cold boot option to start after a controlled shutdown and restart of your process. 

Cancel 

Click this button to terminate the start of the Server.  

Unit Tag Status Dialog Box 

The Unit Tag Status dialog box displays the following items: 

Tag List 

The following table lists the contents of the Tag List area:  

Item Description 

Tag Name The name of the individual tag. 

Item 
The item name, if applicable. 

Value 
The value of the specified tag. 

Type 
The data type of the specified tag. 

Class 
The data class of the specified tag. 
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Manual Update 

Select this check box if you want to manually update unit tag values.  

When enabled, the operator can later update values from within this dialog box; writes coming from 
outside the Soft Phase Server are ignored. When disabled, writes from outside the Soft Phase Server 
are allowed. 

Update Values 

Click this button to update the values in this dialog box. 

Configuring Active Journaling 
The sections that follow describe how to set up your Batch Execution software for Active 
Journaling™. Active Journaling is the process of recording Batch event data in a relational database.  

For Active Journaling, the Batch Server and Archiver must reside on the same computer. During the 
execution of a batch, the Batch Execution Server generates events. The Server writes records of these 
events to specialized files for both the Batch Client and the Batch Archiver. 

For the Batch Client, events are written to Event Journal (.EVT) files that display in the Journal View 
screen of the Batch Execution Client application. The Batch Archiver does not use these .evt files. 

For the Batch Archiver, events are written to an events.arc file as SQL insert statements. When the 
events are ready to archive, the Batch Server renames the events.arc file as eventsDDMMYYYY.sql, 
which is also in the format of SQL insert statements. The DDMMYYYY in the file name represents 
the time stamp of the file creation. Events are considered ready to archive if: 

• The events.arc file is more than 10 seconds old. 

• If less than ten .sql files exist, and the events.arc file is larger than 10 KB. 

• If ten or more .sql files exist, and the events.arc file is greater than 100 MB.  

• The Batch Server is shutting down. 

When a .sql file is detected by the Batch Execution Archiver, it is immediately processed and sent to 
the database. The Batch Server will attempt to start the Archiver if it is not running when the .sql 
statement is generated.  

The following figure illustrates the Active Journaling architecture.  
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Active Journaling Architecture 

The Batch Server starts the Archiver automatically when a .sql file is generated. You can use the 
Archiver Manager, however, to start, stop, or pause the Archiver. This is one scenario when you may 
want to use the Archiver Manager.  

Configuring the Batch Execution Archiver  
There are several items you must configure on the computer that is running the Batch Execution 
Archiver. You configure these items, which are described in the following sections, in the Batch 
Execution Configuration dialog box's Archiver and Server tabs. Access this dialog box from the 
Proficy Batch Execution WorkSpace. 

Data Source Name 

This field is on the Archiver tab. Specify the ODBC data source name (DSN) to which the Batch 
Execution Archiver writes the batch data. This must be defined as a System DSN if you configure the 
Archiver to run as a Windows service. The Batch Execution Archiver uses this information to connect 
to a local or remote SQL or Oracle relational database.  

Event Filters 

This field is on the Archiver tab. Specify the types of Event Journal data you want the Archiver to 
write to the relational database. The types of information you can write to a relational database include: 
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• Status information about each batch (for example, the current values of recipe parameters or 
the activity of a recipe step).  

• Recipe header information.  

• Changes in the state of recipe steps, recipe values, ownership of a batch, and the batch mode.  

• Requests for a change of state, information from the operator, and change in mode.  

• Informational messages about phase logic requests and responses, arbitration of resources, a 
change in batch ownership, a change in the batch mode, and the production of a batch.  

Archiver Table Format 

Specify the data model that you want the Batch Execution Archiver to use. You can write data to the 
relational database using: 

3.0 Format – Writes data to the relational database using the table structure from VisualBatch 3.0. 
This version stores data into one table in the relational database. 

Recommended – Recommended option. Writes data to the relational database using the table 
structures for Batch Execution 4.0 and greater. This version stores data into multiple tables 
in the relational database. 

Both – Writes data to the relational database using recommended table structures for Batch 4.0 
and greater, plus VisualBatch 3.0. 

Enable Journaling 

Select this check box to enable the Server to write event data to a file in SQL format for the Batch 
Execution Archiver.  By default, journaling is disabled.   

Discard Event Files After ... Days 

Enter the number of days to wait before discarding Event Journal (*.EVT) files. 

Send Heartbeat Every ... Minutes 

Enter the number of minutes that you want to wait before Proficy Batch Execution generates the 
heartbeat event again. This allows the system to continually generate a heartbeat event from the Batch 
Execution Server. This event can be used by external applications to detect a communication failure 
between the Batch Execution Server and the database. You can enter up to 1,440 minutes (1 day). 
Enter 0 to disable this feature. 

NOTE:  The heartbeat events get stored in the BATCH_SYSTEM_STATUS table.  

Troubleshooting Active Journaling  
During Active Journaling, if a SQL insert fails due to connection issues, the inserts remain in the .sql 
file and get re-processed when the connection is restored. 
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If a failure occurs that is not a connection error, the Batch Archiver creates a dump file, named 
BatchArchiver.dmp. As a record insert fails, a record is added to the dump file, (one at a time). 

For instance, if the table you are trying to insert into had not been created in the database, or a column 
did not exist when the Archiver tried to send the .sql file to the database, you can use the SQL insert 
statements saved in the .dmp file to test your database after you make adjustments.  

IMPORTANT: Use caution if you rename a .dmp file to .sql to automatically archive the file again. 
Do not reprocess a .dmp file on a production system. You can use the .dmp file to troubleshoot on a 
non-production system. 

If a .dmp file grows greater than 100 MB, an additional file is created. The following graphic illustrates 
the files created during the Active Journaling process.  

 

Active Journaling Queue and Cache Files 

The Batch Server starts and stops the Archiver automatically when a .sql file is generated. If the Batch 
Execution Archiver cannot connect to the relational database, when the connection is re-established, 
the Batch Execution Archiver uses this information to resume processing the .SQL file.   

You can use the Batch Archiver Manager, to start, stop, or pause processing by the Archiver. For 
instance, when troubleshooting on a non-production system, you may want to process a file that you 
generated for testing. This is one scenario when you may want to use the Archiver Manager. You can 
also use the Batch Archiver Manager to monitor the communication status between the Batch Server 
and the database. 



System Configuration Manual 

63 

Relational Database Configuration for the Batch Execution 
Archiver  
The Batch Execution Archiver writes batch Event Journal data to a series of tables in a relational 
database. You need to set up a SQL Server or Oracle relational database to store this electronic batch 
data in these table structures. Refer to the Relational Database Configuration section for instructions on 
setting up your relational database for the Archiver.  

NOTE: It is recommended that you do not archive batch data to an Access database. Our testing has 
shown that archiving batch data to an Access database results in severe performance degradation. It is 
recommended that you archive batch data to SQL or Oracle databases.  

Plant Applications Batch Analysis Reports Configuration 
In order to import Batch Execution event data in the Proficy Plant Applications Batch Analysis 
Reports you need to: 

• Upgrade your Batch Execution database tables to support Batch Analysis Reports 

• Configure the Batch Execution applications for use with Batch Analysis 

• Configure the Plant Applications Models (5013 and 118) 

The steps below explain how to perform these steps. Additional configuration steps are required in the 
Batch Analysis Reports module. 

NOTE: The Proficy Plant Applications product (which includes Batch Analysis Reports) supports SQL 
Server databases. Importing Batch Execution data from an Oracle database into a Batch Analysis 
Report is not supported.  

To upgrade the Batch Execution database tables in SQL Server: 

1. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

2. In the tree view, in the Databases folder, double-click the database name to which you want to add the 
batch tables. For example, the database name might be ARCHIVER or BatchExecution.  

3. Select the Tables folder for the database that you plan to upgrade. 

4. On the File menu, click Open and then File. The Open File dialog box appears. 

5. Select the msqlarchiver_BatchAnalysis.sql script and click Open. The Connect to Database 
Engine dialog box appears. 

6. In the Server Name field, make sure that the server you want appears in this field. If it does 
not, select the server from the drop-down list or browse for it. 

7. Click the Options button to view more configurable fields.  

8. In the Connect to Database field, select the database name from the drop-down list or browse for a 
database. The script opens as a new tab in the Microsoft SQL Server Management Studio window. 

9. In the toolbar, click the Execute button. 

10. Repeat steps 5-9 for the Archiver3x_Trigger.sql script. 
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To configure Batch Execution applications: 

1. Open the Proficy Batch Execution WorkSpace, and then open your Batch Execution project. 

2. Open the Configuration folder and double-click the Batch Execution Configuration item. The 
Batch Execution Configuration dialog box appears. 

3. Click the Archiver tab, and do the following: 

a. In the Data Source Name box, enter the data source name for your ODBC connection 
to the Batch Execution database. 

b. In the Event Filters area, ensure that the System option is selected. 

c. In the Archiver Table Format area, do one of the following: 

• If you are using 4.0 archive tables, select the Both option. 

• If you are using 3.0 archive tables or if you aren't archiving, select the 3.0 
option. 

4. Click the Server tab. In the Journaling area:  

• Select the Enable Journaling check box. 

• Optionally, configure the Discard Event Files After and Send Heartbeat fields. 

• Click OK. 

5. Exit the Batch Execution WorkSpace. 

To configure the Plant Application Models: 

Refer to the "Importing S88 Batch Records" topic in the Plant Applications online help for 
instructions. 

Batch Execution Archiver Manager Dialog Box 
The Batch Execution Archiver Manager dialog box displays the following items: 

Archiver Status Group 

The following table lists the contents of the Archiver Status group:  

Item Description 

DSN Displays the Data Source Name (DSN) that the Batch Execution 
Archiver stores the records to. 

Icon 
Shows the status of the DSN connection.  A green, connected icon 
indicates that the Batch Execution Archiver is connected to the data 
source.  A red, disconnected icon indicates that it is not connected.  
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Status Box 

Displays status messages from the Batch Execution Archiver. The most recent message displays at the 
top of the window. 

Dump 

If a failure occurs that is not a connection error, the Batch Archiver creates a dump file, named 
BatchArchiver.dmp. As a record insert fails, a record is added to the dump file, (one at a time). For 
instance, if the table you are trying to insert into had not been created in the database, or a column did 
not exist when the Archiver tried to send the .sql file to the database, you can use the SQL insert 
statements saved in the .dmp file to test your database after you make adjustments.  

Start Archiver 

Click to start the Batch Execution Archiver. 

Stop Archiver 

Click to stop the Batch Execution Archiver. Before stopping, two message boxes appear.  The first one 
confirms if you want to stop the Batch Execution Archiver. The second message asks if you would like 
to continue maintaining electronic batch records for this Batch Execution Archiver. 

Pause 

Click to pause the Batch Execution Archiver. 

Clear 

Click to clear the messages and counters that display in the Batch Execution Archiver Manager. 

Always On Top 

Select this check box if you want the Batch Execution Archiver Manager to display on top of other 
applications, even when you switch between applications.  

How Do I... 
The following sections explain how to work with the Batch Execution Archiver for active journaling: 

• Using the Batch Archiver Manager 

• Setting up the Archiver for Active Journaling 
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Using the Batch Archiver Manager 

To use the Batch Execution Archiver Manager: 

1. Click the Start button, point to Programs, Proficy Batch Execution, and then Archiver 
Manager. The Batch Execution Archiver Manager appears. 

2. Select an option: 

• To start the Batch Execution Archiver, click the Start Archiver button. Use the Stop 
Archiver button to stop the Batch Execution Archiver. 

• To temporarily pause processing, click the Pause button (the Archiver is still 
running, however). Click Resume to resume processing. 

• To clear all messages, click the Clear button. 

3. Click Exit to close the utility. 

Setting up the Archiver for Active Journaling 

To set up the Batch Execution Archiver for Active Journaling: 

1. In the Batch WorkSpace, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Archiver tab. 

3. In the Data Source Name field, enter the Archiver’s data source name (DSN), along with the 
user name and password. 

NOTE: This data source must be defined as a System DSN in the ODBC Data Source 
Administrator program accessed from the Windows Control Panel. 

4. In the Logging Info area, select the Enable Info Logging check box to provide information on 
system events in the BatchArchiver.log file for troubleshooting issues with the Batch 
Execution Archiver. If you want to change the default size of this file, in the Max Log File 
field, enter a maximum size for this file before it is overwritten. 

NOTE: It is not recommended that you enable Info Logging for daily operations in a 
production environment, because of the large number of messages that will be produced by 
the Batch Execution Archiver. 

5. In the Event Filters area, select the filters you want to use from the Event filters group box. 
Selecting a filter adds this information to the relational database. 

6. In the Archiver Table Format area, choose the format that you want the Batch Execution 
Archiver to use when it writes the batch event data to the relational database. 

7. Select the Server tab. 

8. In the Journaling area, select the Enable Journaling check box. 

9. In the Discard Event Files After … Days drop-down list, enter the number of days to wait 
before discarding Event Journal (*.EVT) files. 

10. In the Send Heartbeat Every … Minutes drop-down list, enter the number of minutes that you 
want to wait before Proficy Batch Execution generates the heartbeat event again. You can 
enter up to 1,440 minutes (1 day). Enter 0 to disable this feature. 
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IMPORTANT: The heartbeat event messages are stored to the BATCH_SYSTEM_STATUS 
table in the database. The lower the value you enter in this field, the more values get stored to 
this table. If you enter a low value, you will need to maintain this table to prevent it from 
growing too rapidly. 

11. Click OK to save your changes. 

SCU and Security Configuration 
If you are running Batch Execution with iFIX there are certain setup tasks you need to perform. The 
sections that follow describe these tasks, including: 

• Configuring the iFIX System Configuration Utility (SCU) settings for Batch Execution.  

• Setting up security for Batch Execution using the iFIX Security application.  

Setting up the SCU  
Each Batch Execution node you set up requires iFIX software to complete certain tasks, as the 
following table explains.  

Using iFIX Software  

For this node type... Use iFIX to... 

Development workstations Enable process engineers to create operator displays. 

Batch Execution Clients Enable operators to view operator displays and monitor 
process values residing in the iFIX process database. 

Batch Execution Servers Send alarms to a SCADA Server. 

In addition, any node that requires security needs iFIX software to protect it from unauthorized users. 

You can set up iFIX software by launching the System Configuration Utility (SCU) from the Proficy 
iFIX WorkSpace. This program lets you configure the following iFIX settings: 

• Alarm routing  

• Network connections  

• SCADA and I/O driver settings (for SCADA Servers only)  

• Tasks that automatically start up  

• iFIX security (when your iFIX software is running)  

For more information on using the SCU, refer to the iFIX Setting up the Environment Manual. 
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Setting up Security  
You can secure each Batch Execution and iFIX node against unauthorized use. Security is provided by 
the iFIX Security Configuration program. This program lets you define user accounts for operators. 

Security is provided for specific application functions called application features. For a list of the 
Batch Execution application features you can protect, refer to the Batch Execution Security 
Application Features section. For additional information about iFIX security, refer to the Implementing 
Security Manual. 

Creating Group Accounts 
One powerful feature of the Security Configuration program is the ability to create group accounts. A 
group account lets you specify common application features shared by two or more people. Once 
defined, you can assign a group account to individual user accounts. This assignment provides the 
security privileges defined for the group account to individual operators. 

Example: Sample Group Accounts  

For example, assume you create a group account called Operators. Also assume you assign the 
application feature Client Startup to the group account so operators can start the Batch Execution 
Client application. 

Next, you assign the group account to the user accounts that require the group account's privileges. In 
this case, since all operators need the ability to start the Batch Execution Client application, you assign 
the group to all operator user accounts.  

By extending this example, you can create group accounts for the different groups in your plant, such 
as recipe designers, supervisors, and system administrators, and define the rights that each group 
needs. This approach lets you quickly set up the privileges required. 

To help you set up group accounts, the following subsections list some sample group accounts you 
may want to create. 

Creating a Group Account for Recipe Developers  

To create a group account for recipe developers, assign the following application features: 

• Recipe Editor Startup  

• Save Recipes  

• Remove Recipes  

• Create Recipes  

• Release Recipes to Production  

• Rebuild Recipe Directory  

• Import/Export Recipes  

• Proficy iFIX WorkSpace Startup  

• Save from Proficy iFIX WorkSpace  
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• Create New Project in Proficy iFIX WorkSpace  

• Misc Item Deletion from Proficy iFIX WorkSpace  

Creating a Group Account for Area Model Developers  

To create a group account for area model developers, assign the following application features: 

• Equipment Editor Startup  

• Save Equipment Configuration  

• Create Equipment Configuration  

• Proficy iFIX WorkSpace Startup  

• Save from Proficy iFIX WorkSpace  

• Create New Project in Proficy iFIX WorkSpace  

• Misc Item Deletion from Proficy iFIX WorkSpace  

Creating a Group Account for Operators  

To create a group account for operators, assign the following application features: 

• Client Startup  

• Start Batch  

• Stop Batch  

• Hold/Resume Batch  

• Restart Batch  

• Add Batch  

• Rebind Unit Procedure  

• Remove Batch  

• Go to HMI  

• Clear All Failures  

• Change to Auto/Manual Mode  

• Allow Arbitration  

• Allow Phase Control  

• Acquire Phase for Manual Control  

• Acquire and Release Resources  

• Abort Batch  

Depending on the level of the operator, you may or may not want to assign certain features. For 
example, junior operators may not be allowed to Stop, Hold, Resume, or Restart a batch. 
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Batch Execution Security Application Features  
Batch Execution supports the security application features listed below. For a list of iFIX application 
features, refer to the Implementing Security Manual.  

• Abort Batch  

• Add Batch  

• Acknowledge Prompts  

• Allow Arbitration View  

• Allow Demo Mode  

• Acquire and Release Resources  

• Acquire Phase for Manual Control  

• Allow Help from Client  

• Allow Phase Control  

• Archiver Startup  

• Archiver Startup From Mgr 

• Archiver Shutdown From Mgr 

• Change to Auto/Manual Mode  

• Clear All Failures  

• Client Shutdown  

• Client Startup  

• Configuration  

• Configure the Client  

• Create Equipment Configuration  

• Create New Project in Proficy iFIX WorkSpace  

• Create Recipes  

• Equipment Editor Startup  

• Go to HMI  

• Hold Batch  

• Proficy iFIX WorkSpace Startup  

• Misc Item Deletion from iFIX WorkSpace  

• Rebuild Recipe Directory  

• Recipe Editor Startup  

• Release Recipes to Production  

• Rebind Unit Procedure  

• Remove Batch  

• Remove Recipes  
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• Restart Batch  

• Save Equipment Configuration  

• Save from iFIX WorkSpace  

• Save Recipes  

• Server Shutdown  

• Server Startup  

• Simulator Startup  

• Start Batch  

• Start iWorkInstruction Editor 

• Start SoftPhase Server 

• Stop Batch  

• Stop SoftPhase Server 

Mapping Batch Application Features to iFIX Features 
If you want to secure Batch Execution application features in the iFIX product, you need to know how 
the Batch Execution feature names map to iFIX feature names. For some Batch Execution features, 
security is not available in the iFIX product.  

IMPORTANT: Be aware that iFIX security checking does not occur on commands that you configured 
an electronic signature for (either a Performed By or a Performed By/Verified By signature) in the 
Batch Execution Equipment or Recipe Editors.  For more information, refer to the Understanding iFIX 
Security and Batch Execution Electronic Signatures section. 

The following tables list the features available in the Batch Execution applications, and the associated 
names that appear in the iFIX Security Configuration program (when you add features to users and 
group accounts). 

Batch Recipe Editor 

Batch Feature Name iFIX Feature Name 

Recipe Editor: Convert Project Storage N/A – Security Not Available in iFIX 

Recipe Editor: New Recipe Batch Execution - Create Recipes 

Recipe Editor: Open Recipe N/A – Security Not Available in iFIX 

Recipe Editor: Print Recipe N/A – Security Not Available in iFIX 

Recipe Editor: Rebuild Recipe Directory Batch Execution - Rebuild Recipe Directory 



 

72 

Batch Feature Name iFIX Feature Name 

Recipe Editor: Release To Production Batch Execution - Release Recipes to 
Production 

Recipe Editor: Formulation Status Change Batch Execution - Change Formulation 
Status 

Recipe Editor: Remove Formulation  Batch Execution - Remove Formulation 

Recipe Editor: Save Formulation  Batch Execution - Save Formulation 

Recipe Editor: Remove Recipe Batch Execution - Remove Recipes 

Recipe Editor: Save Recipe Batch Execution - Save Recipes 

Recipe Editor: Save As Recipe Batch Execution - Save Recipes 

Recipe Editor: Startup Batch Execution - Recipe Editor Startup 

Recipe Editor: Upgrade recipe N/A – Security Not Available in iFIX 

Recipe Editor: Verify recipe N/A – Security Not Available in iFIX 

Batch Equipment Editor 

Batch Feature Name iFIX Feature Name 

Equipment Editor: Export N/A – Security Not Available in iFIX 

Equipment Editor: Import N/A – Security Not Available in iFIX 

Equipment Editor: New Batch Execution - Create Equipment 
Configuration 

Equipment Editor: Open 
N/A – Security Not Available in iFIX 

Equipment Editor: Print 
N/A – Security Not Available in iFIX 
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Batch Feature Name iFIX Feature Name 

Equipment Editor: Save Batch Execution - Save Equipment 
Configuration 

Equipment Editor: SaveAs Batch Execution - Save Equipment 
Configuration 

Equipment Editor: Startup Batch Execution - Equipment Editor Startup 

Equipment Editor: Upgrade N/A – Security Not Available in iFIX 

BatchList ActiveX Control 

Batch Feature Name iFIX Feature Name 

BatchList: Abort Batch Batch Execution - Abort Batch 

BatchList: Add Batch Batch Execution - Add Batch 

BatchList: Auto Mode Batch Execution - Change to Auto-Manual 
Mode 

BatchList: Binding Prompts Batch Execution - Change to Auto-Manual 
Mode 

BatchList: Clear All Failures Batch Execution - Clear All Failures 

BatchList: Hold Batch Batch Execution - Hold Batch 

BatchList: Manual Mode Batch Execution - Change to Auto-Manual 
Mode 

BatchList: Operator Prompts 
N/A – Security Not Available in iFIX 

BatchList: Remove Batch Batch Execution - Remove Batch 

BatchList: Restart Batch Batch Execution - Restart Batch 

BatchList: Start Batch Batch Execution - Start Batch 
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Batch Feature Name iFIX Feature Name 

BatchList: Stop Batch Batch Execution - Stop Batch 

BatchManualPhase ActiveX Control 

Batch Feature Name iFIX Feature Name 

BatchManualPhase: Abort Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Acquire Phase Batch Execution - Acquire and Release 
Resources 

BatchManualPhase: Clear All Failures N/A – Security Not Available in iFIX 

BatchManualPhase: Hold Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Operator Prompts Batch Execution - Change to Auto-Manual 
Mode 

BatchManualPhase: Pause Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Release Phase Batch Execution - Acquire and Release 
Resources 

BatchManualPhase: Reset Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Restart Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Resume Phase N/A – Security Not Available in iFIX 

BatchManualPhase: Start Phase Batch Execution - Start Batch 

BatchManualPhase: Step Mode N/A – Security Not Available in iFIX 

BatchManualPhase: Stop Phase N/A – Security Not Available in iFIX 
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BatchSFC ActiveX Control 

Batch Feature Name iFIX Feature Name 

BatchSFC: Abort Step Batch Execution - Abort Batch 

BatchSFC: Auto Mode Batch Execution - Change to Auto-Manual Mode 

BatchSFC: Binding Prompts Batch Execution - Rebind Unit Procedure 

BatchSFC: Change Parameter Batch Execution - Change to Auto-Manual Mode 

BatchSFC: Clear All Failures Batch Execution - Clear All Failures 

BatchSFC: Hold Step Batch Execution - Hold Batch 

BatchSFC: Manual Mode Batch Execution - Change to Auto-Manual Mode 

BatchSFC: Operator Prompts Batch Execution - Change to Auto-Manual Mode 

BatchSFC: Restart Step Batch Execution - Restart Batch 

BatchSFC: Start Step Batch Execution - Start Batch 

BatchSFC: Stop Step Batch Execution - Stop Batch 

Network Configuration 
While it is possible to set up your Batch Execution Servers, Clients, and development workstations all 
on the same computer, separate computers are typically used and recommended for each function. For 
best performance, it highly recommended that you use separate computers for your Batch Execution 
Servers and Batch Execution Clients. Having the Batch Execution Server and the Batch Execution 
Client on the same computer can adversely affect system performance during batch production. 

When multiple computers are used, each computer communicates with each other over a network. The 
sections that follow discuss how to enable network communication for the following Batch Execution nodes: 

• Batch Execution Servers  

• Batch Execution Clients  

• Development workstations  
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IMPORTANT: When the Batch Execution Client and Server reside on the same computer, no special 
setup is required. This configuration is not recommended for production.  

Task Overview  
Complete the following tasks to set up network communications for Batch Execution. 

To set up network communication:  

1. Configure an OPC data server to enable communication between a Batch Execution Server 
and an OPC Server or SCADA Server.  

2. Configure settings on the Batch Execution Server and its Batch Execution Clients so they can 
communicate with each other.  

3. If you want to run the Batch Execution Recipe Editor remotely, configure the 
BatchRecipeEditor.INI on the Batch Execution Server and file sharing on the Batch Execution 
Client so that you can access these files remotely.  

4. Configure development workstations so that they can access the files on your Batch Execution 
Server. 

5. If you plan on using the ActiveX Controls to monitor and control batches, you need to setup 
communications between the ActiveX controls and the Batch Execution Server.  

6. Configure the Soft Phase Server, if required.  

7. If you plan on using an iFIX Terminal Server with Batch Execution, be sure to follow the 
configuration guidelines. Refer to the Using an iFIX Terminal Server section for guidelines. 
The Using Terminal Server guide for iFIX provides instructions on how to configure the iFIX 
Terminal Server and Clients. 

Understanding Batch Execution Network Communication 
There are two types of communication in Batch Execution: 

• Communication between Batch Execution Servers and Batch Execution Clients  

• Communication between Batch Execution Servers and the process hardware  

The following sections describe each type of communication. 

Batch Execution Server and Batch Execution Client Communication 

The Batch Execution Server and the Batch Execution Client communicate over a network using 
DCOM (Distributed Component Object Model). DCOM is a protocol that enables software 
components to communicate directly over a network in a reliable, secure, and efficient manner. 

Batch Execution Server and Process Hardware Communication  

A Batch Execution Server can communicate over a network to your process hardware using OLE for 
Process Control (OPC). You can use OPC when the Batch Execution Server communicates with an 
iFIX process database or OPC-aware process hardware.  
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As the following figure shows, your process hardware and SCADA Server act as servers to the Batch 
Execution Server. As a result, you need to install and configure server software on your process 
hardware to ensure proper communication. Refer to your process hardware manuals for instructions.  

Once you install and configure all the server software on your process hardware, you need to set up the 
Batch Execution Server to run as a client to your process controllers (such as PLCs). To do this, you 
configure an OPC data server. For instructions on configuring this server, refer to the Setting up an 
OPC Data Server section. 

 

Servers and Clients  

Understanding Watchdog Communication 

In addition to configuring OPC data servers, you need to specify the name of a watchdog register in 
your process controller to the Batch Execution Server. The Batch Execution Server reads from and 
writes to this register to ensure that the process controller is available to handle data requests. 

Communicating with an OPC Server  

When communicating with an OPC server, the watchdog register corresponds to a tag that accepts read 
and write requests. If the tag is an iFIX tag, specify the name of an Analog Output block with an 
Analog Input block connected to it, as the following figure shows. 
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Setting up the Watchdog Register 

Notice that both blocks in figure above reference the same I/O Address. This creates a chain in the 
process database that accepts reads and writes from the Batch Execution Server. 

NOTE: An Analog Register block is not used because it does not provide a scan time. 

How the Batch Execution Server Interacts with the Watchdog 

Once you specify the name of the watchdog register, the Batch Execution Server does the following 
when it starts up: 

1. The Batch Execution Server examines the value of the watchdog register.  

2. If the value is 0, the Batch Execution Server assumes the process controller is available and 
sets the register's value to 1.  

3. The Batch Execution Server waits 60 seconds, by default. During this interval, the phase logic 
interface (PLI) in your process hardware must update the watchdog register and reset the 
value to 0.  

4. When the 60 second wait expires, the Batch Execution Server repeats steps 1 and 2 and 
continues in this loop during normal operations.  

NOTE: The Watchdog time out period is configurable in the Batch Execution Configuration dialog 
box from the Server tab. 

Error-Handling  

Associated with the watchdog register are two values you can configure. The first value is the interval 
the Batch Execution Server waits between each read of the watchdog register's value. By default, this 
value is set to 60 seconds; however, you can enter any value between 1000 and 60000 milliseconds. 
Values larger than 120000 are clamped at 120000. 

The other watchdog value you can set is the maximum number of consecutive failures the Batch 
Execution Server allows before assuming the PLC is no longer available. By default, the Batch 
Execution Server accepts up to 10 failure readings of the watchdog register before assuming the PLC is 
not available. You can adjust this value; however, the value you enter must be 2 or greater. 

Example: Error-Handling  

For example, assume that the number of allowable failures is 5. When the Batch Execution Server 
starts, it reads the watchdog register's value. If the value read is 1, the Batch Execution Server assumes 
communications with the PLC are suspect. If the Batch Execution Server reads a 1 from the watchdog 
register on the next four consecutive reads, it assumes communications are bad and that the PLC is no 
longer available.  
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Error Recovery 

Even though the Batch Execution Server may assume communications are bad, it continues reading the 
watchdog register. It does this so that when the PLC resets the register's value, the Batch Execution 
Server can detect it and restore communications. For this reason, it may take up to 60 seconds for the 
Batch Execution Server to reconnect to a device once it is back online. 

DCOM 

DCOM is a protocol that enables software components to communicate directly over a network in a 
reliable, secure, and efficient manner. 

The following topics provide instruction for configuring and troubleshooting DCOM: 

• Troubleshooting Overview 

• Using a Valid User Name and Password 

• Enabling Distributed COM 

• Confirming That Windows Acknowledges Logged In Users as Trusted Users 

• Verifying Security When Using the Same User Name 

• Verifying the Authentication Level 

• Verifying Access and Launch Permissions 

• Understanding the BatchDCOM Utility 

Troubleshooting Overview 

When attempting to resolve local and remote security settings, follow the steps listed below. 

To troubleshoot local and remote security settings:  

1. If the client and server computers are part of a Windows domain, confirm that you logged in 
with valid user names and passwords.  

2. Confirm that you enabled the Distributed Component Object Model (DCOM) protocol on 
both the client and server.  

3. Confirm that Windows acknowledges that the logged in users are trusted users on both the 
client and server.  

4. If you logged in with the same user name on both the client and server, verify the security 
settings again. These security settings include whether you configured a valid user name and 
password and whether the same trust relationships exist on the client and server.  

5. Verify that the client and server use the same DCOM authentication level.  

6. Verify the client and server allow for the same access and launch permissions for the DCOM 
protocol.  

For details on each of these steps, refer to the following sections. 
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Using a Valid User Name and Password 

Your Windows domain controller (if applicable) may have certain restrictions on the password or user 
name. These domain restrictions apply to local user accounts, and user accounts that you want to 
connect to the domain controller.  

For example, there may be a restriction on the length of a password for a user account. In this case, a 
problem could occur if you attempt to login under a local administrator account that does not require a 
password (you entered an empty password when configuring the Windows operating system), but a 
domain security policy requires a password. 

Check that all local users' passwords conform to your domain controller's password restrictions. For 
more information on configuring and viewing password restrictions on your domain controller, refer to 
the online Help for Microsoft Windows. 

Enabling Distributed COM 

Make sure that you enabled the DCOM protocol on both the client and server computers. Without this 
option selected, your computer cannot access COM servers that reside on another computer. 

To enable DCOM on both the client and server: 

1. Log in to Windows as an administrator, if you are not already. 

2. Click the Start button and then point to Run. The Run dialog box appears. 

3. Enter dcomcnfg.exe and click OK. The Component Services Microsoft® Management 
Console (MMC) snap-in appears. 

4. Double-click the Component Services folder. 

5. Double-click the Computers folder within the Component Services folder. 

6. Right-click the My Computer folder, and select Properties from the right-click menu. The My 
Computer Properties dialog box appears. 

7. Select the Default Properties tab. 

8. Select the Enable Distributed COM on this computer check box, if it is not already selected. 

9. Click OK. 

10. Restart your computer. 

Confirming That Windows Acknowledges Logged In Users as Trusted Users 

Confirm that users logged in on both computers are trusted users, by checking the default DCOM 
security settings. 

To check for trusted users on both the client and server: 

1. Log in to Windows as an administrator, if you are not already. 

2. Click the Start button and then point to Run. The Run dialog box appears. 

3. Enter dcomcnfg.exe and click OK. The Component Services Microsoft® Management 
Console (MMC) snap-in appears. 

4. Double-click the Component Services folder. 
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5. Double-click the Computers folder within the Component Services folder. 

6. Right-click the My Computer folder, and select Properties from the right-click menu. The My 
Computer Properties dialog box appears. 

7. Select the COM Security tab. 

8. In the Access Permissions group box, select the Edit Default button. The Access Permission 
dialog box appears. 

9. Confirm that any domain or local users or groups that need access to this computer are listed. 
If they are not, add them. 

10. In the Launch Permissions group box, select the Edit Default button. The Launch Permission 
dialog box appears, if security information is available for you to edit. 

11. Confirm that any domain or local users or groups that need access to this computer are listed. 
If they are not, add them. 

12. Click OK. 

Verifying Security When Using the Same User Name 

If you logged in to both the server and client computers using the same user name, run the following 
steps on both the client and server. 

To verify security: 

1. Make sure that the user name and password are exactly the same on both computers. 

2. Confirm that both user names and passwords conform to any and all password restrictions that 
your domain controller enforces. 

3. Make sure that user is a trusted user, as described in the Confirming That Windows 
Acknowledges Logged In Users as Trusted Users section. 

Verifying the Authentication Level 

Verify that the server and the client use the same DCOM authentication level. If the authentication 
levels are different, a connection problem will occur. 

To verify the DCOM authentication level, use the DCOMCNFG.exe utility. For steps, refer to the 
following sections: 

• Verifying the DCOM Authentication Level on the Server 

• Verifying the DCOM Authentication Level on the Client 

Verifying the DCOM Authentication Level on the Server 

The following steps outline how to check the DCOM authentication levels for servers. 

To check the server authentication level:  

1. Log in to Windows as an administrator, if you are not already.  

2. Click the Start button, and then point to Run. The Run dialog box appears.  
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3. Enter dcomcnfg.exe and click OK. The Component Services Microsoft® Management 
Console (MMC) snap-in appears.  

4. Double-click the Component Services folder.  

5. Double-click the Computers folder within the Component Services folder.  

6. Double-click the My Computer (or computer name) icon.  

7. Double-click the DCOM Config folder to display the list of DCOM applications.  

8. Locate the GE Intelligent Platforms EIB Server from the list of applications.  

9. Right-click the GE Intelligent Platforms EIB Server, and select Properties from the right-click 
menu. The GE Intelligent Platforms EIB Server Properties dialog box appears.  

10. Verify the Authentication Level that appears in the drop-down list.  

IMPORTANT: The server and client authentication level must be the same. 

11. Click OK.  

Verifying the DCOM Authentication Level on the Client 

The following steps outline how to check the DCOM authentication levels for clients. 

To check the client authentication level:  

1. Log in to Windows as an administrator, if you are not already.  

2. Click the Start button, and then point to Run. The Run dialog box appears.  

3. Enter dcomcnfg.exe and click OK. The Component Services Microsoft® Management 
Console (MMC) snap-in appears.  

4. Double-click the Component Services folder.  

5. Double-click the Computers folder within the Component Services folder.  

6. Double-click the My Computer (or computer name) icon.  

7. Double-click the DCOM Config folder to display the list of DCOM applications.  

8. Locate the container application from which you are running the WorkInstruction EWI 
ActiveX control in from the list of applications.  

For example, if this container is the Proficy iFIX WorkSpace, look for an item named the 
Proficy iFIX WorkSpace Application. If you use the Batch Execution WorkSpace as a 
container, select the following item: 

{BFF12D30-357E-11CF-9B51-00608CB19AD6} 

9. Right-click the container application, and select Properties from the right-click menu. The My 
Computer Properties dialog box appears.  

10. Verify the Authentication Level that appears in the drop-down list.   

IMPORTANT: The server and client authentication level must be the same. 

11. Click OK.  
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Verifying Access and Launch Permissions 

Make sure that both the server and client allow for the same DCOM access and launch permissions. 
The following steps outline how to check the access and launch permissions. 

To check the access and launch permissions:  

1. Log in to Windows as an administrator, if you are not already.  

2. Click the Start button, and point to Run. The Run dialog box appears.  

3. Enter dcomcnfg.exe and click OK. The Component Services Microsoft® Management 
Console (MMC) snap-in appears.  

4. Double-click the Component Services folder.  

5. Double-click the Computers folder within the Component Services folder.  

6. Double-click the My Computer (or computer name) icon.  

7. Double-click the DCOM Config folder to display the list of DCOM applications.  

8. Select the application from the list:  

• If you are checking a server computer, select the GE Intelligent Platforms EIB 
Server item.  

• If you are checking a client computer, the container application from which you are 
running the WorkInstruction EWI ActiveX control in from the list of applications. 
For example, if this container is the Proficy iFIX WorkSpace, look for an item 
named the Proficy iFIX WorkSpace Application. If you use the Batch Execution 
WorkSpace as a container, select the {BFF12D30-357E-11CF-9B51-
00608CB19AD6} item.  

9. Right-click the application, and select Properties from the right-click menu. The Properties 
dialog box appears.  

10. Select the Security tab.  

11. In the Launch Permissions group box, make sure that the Customize option is selected.  

12. Click the Edit button in the Launch Permissions group box. The Launch Permission dialog 
box appears.  

13. Confirm that any domain or local users or groups that need access to this computer are listed. 
If they are not, add them.  

14. Click OK. 

15. In the Access Permissions group box, make sure that the Customize option is selected.  

16. Click the Edit button in the Access Permissions group box. The Access Permission dialog box 
appears.  

17. Confirm that any domain or local users or groups that need access to this computer are listed. 
If they are not, add them.  

18. Click OK.  

19. Click Apply to save your changes in the Properties dialog box. 

20. Click OK. 
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Understanding the BatchDCOM Utility 

The BatchDCOM utility provides tools to help you troubleshoot your local and remote security 
settings. Using the BatchDCOM utility, you can display numerous types of data, including system 
information, DCOM information and application specific settings. With this information, for example, 
you can determine if authentication levels are appropriate, or if permissions are set correctly. 

In addition, the BatchDCOM utility provides a way for you to easily export and import your DCOM 
settings. This is particularly important if you are troubleshooting a Batch issue with a GE support 
representative or when you are uninstalling and reinstalling Proficy Batch Execution. If you export 
your settings and there is a problem with the installation, your DCOM settings are not lost; you only 
have to import the settings to restore your specific DCOM configuration.  

Exported settings can only be imported to the same computer; the settings are computer specific. 
Additionally, if you rename your computer, you will not be able to import your DCOM settings. 

Exported settings are output in XML format. 

Using the BatchDCOM Utility 

The BatchDCOM utility is run from the command line. The options described in the following table 
can be used in any order or combination, with the following exceptions: 

• /a, /? and --help override all individual options specified 

• /e and /i take precedence over any other options specified 

• /e, /f and /i are mutually exclusive. 

BatchDCOM Utility Options 

The following table describes the BatchDCOM utility options. 
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Option Description 

/a Displays the following data: 

• System information: 
• Number of processors 
• Processor identifier 
• Processor architecture 
• Computer name 
• User name 

• Status, default and permission settings 
• DCOM status 
• Authentication level 
• Impersonation level 
• Default access permissions 
• Default launch and activation permissions 
• Machine access restrictions 
• Machine launch and activation permissions 

• Application Specific Settings – launch and activation permissions for 
each Batch application 

• Batch Specific Non-DCOM information 
• Batch software version 
• SIMs installed 
• Batch processes running as services 

/b Displays the version of the Batch software installed, a list of SIMs installed, if 
any, and the Batch processes running as services 

/c Displays the name of the computer  

/d Displays the following information: 

• Status, default and permission settings 
• DCOM status 
• Authentication level 
• Impersonation level 
• Default access permissions 
• Default launch and activation permissions 
• Machine access restrictions 
• Machine launch and activation permissions 

• Application Specific Settings – launch and activation permissions for 
each Batch application 
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Option Description 

/e arg Allows you to export your Batch DCOM settings to a specified file. 

arg – specifies a fully qualified file path to export to 

/f arg Saves the options to a dump file. 

arg – specifies a fully qualified file path to save the file to 

NOTE: The dump file cannot be imported. It is for informational purposes 
only. 

/i arg Allows you to import your Batch DCOM settings from a specified file. 

arg – specifies a fully qualified file path to import 

/p Displays the following information: 

• Number of processors 
• Processor identifier 
• Processor architecture 

/s Displays the Batch process running as services 

/u Displays the name of the user 

/? Displays a list of available commands 

--help Displays a list of available commands 

Setting up an OPC Data Server  
Setting up an OPC data server is a straightforward process. 

To set up the OPC data server:  

1. Select a name for the OPC server. The name you specify acts as an identifier for the OPC 
server. For example, you might call the OPC server that communicates to an iFIX SCADA 
server, FIXOPC.  

2. Select the OPC driver you want to associate with the OPC Server name you entered. For 
example, the OPC interface for communicating with an iFIX SCADA server is 
Intellution.OPCEDA.  

3. Assign a tag that corresponds to the watchdog register in the OPC server. For more 
information about how the Batch Execution Server uses the watchdog register, refer to the 
section, Understanding Watchdog Communication.  
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After you set up the OPC server, a Batch Execution Server can communicate with your iFIX process 
database or OPC-aware process hardware. 

Configuring a Remote Server  
Batch Execution Servers communicate with Batch Execution Clients using DCOM.  

To set up network communications between a Batch Execution Client and a remote 
server:  

1. Start the Batch Execution Client application. Select Cancel if you do not connect to the Batch 
Execution Server.  

2. Click the System Configuration and Defaults button on the toolbar to open the System 
Configuration and Defaults screen.  

3. Click the Remote Server Configuration tab. The Remote Server Configuration screen appears.  

4. Click the Remote Server check box to allow the Batch Execution Client to connect to a 
specified remote server.  

5. If you want the Remote Server button to display in the toolbar, select the Enable Remote 
Server in Toolbar check box.  

6. Click Add Server to add a server to the list. The Add a Remote Server dialog box appears.  

NOTE: Make sure that you specify one server as the default server. 

7. In the Server Name field, enter the name of the remote server, or click the Browse (...) button 
to select a server.  

8. In the Alias field, enter an alias for the server name. You must enter an alias with every 
server, even if it is the same name as the server.  

NOTE: The alias cannot exceed 30 characters. It can contain the numbers: 0-9, the letters: 
A-Z and a-z, the underscore character, and a space character. The underscore and space 
characters cannot appear at the beginning of an entry, or alone. Duplicate alias names are 
not allowed in the list. 

9. Click the Default check box if you want this remote server to act as the default server. You 
can only assign one server as the default server.  

10. Click OK to return to the Remote Server Configuration screen.  

11. Click Apply.  

12. Click OK.  

Setting up Development Workstations 
In addition to Batch Execution Servers and Clients, you may also want to set up one or more 
development workstations so that they can access your Batch Execution files from a network. 
Depending on how you installed Batch Execution, your development workstation and your Batch 
Execution Server may be the same computer. However, when they are not, providing network access 
enables process engineers to modify recipes or an area model from their workstation. 
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Running the Batch Execution Recipe Editor Remotely 
If you want to edit recipes from a remote computer, you can easily configure the remote Batch 
Execution Recipe Editor to point to the location where the recipes are stored.  

To run the Batch Execution Recipe Editor on a remote computer:  

1. Open the BatchRecipeEditor.INI file on the remote computer.  

2. Change the Path field in the VBEXEC section to point to the Batch Execution Server 
computer's VBEXEC.INI file. Use UNC pathing to specify the remote computer's name.  

For instance, if the Batch Execution Server computer is named JBANGS, and the operating 
system is Windows Vista, you would enter the following text in the BatchRecipeEditor.INI 
file. 

[VBEXEC] 

Path=\\JBANGS\ProgramData\Proficy\Proficy Batch 
Execution\Configs\VBEXEC.INI 

3. Allow sharing for the ProgramData folder on the Batch Execution Server computer. Refer to 
the Windows Help for instructions on defining shared folders.  

4. Make sure that the Batch Execution Server uses UNC pathing for the project directories. For 
more information on UNC pathing, refer to the Using UNC Paths section.  

Setting up ActiveX Controls to Communicate with the Batch 
Execution Server  
Provided with your Batch Execution software are ActiveX controls that operators can use to monitor 
and control batches in much the same way they can from the Batch Execution Client application. You 
can use these controls in any OLE container, such as the Proficy iFIX WorkSpace, Visual Basic, and 
Internet Explorer. 

The Batch Execution ActiveX controls communicate with a Batch Execution Server through VBIS 
using DCOM.  

To set up ActiveX controls to communicate with the Batch Execution Server:  

1. Open the ActiveX control's property page.  

2. Enter the computer name on which the VBIS Server is running. If VBIS is running on the 
same computer as the control, you can leave this field blank.  

For more information on the ActiveX controls and VBIS, refer to the Custom Applications manual. 

Setting up the Soft Phase Server 
You should always install the Soft Phase Server on the same computer as the Batch Execution Server. 
If the OPC Client driver and the iFIX SCADA server are installed on another computer, the OPC 
Client driver communicates with the Soft Phase Server over the network.  
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If you configure the OPC Client driver to communicate to Soft Phase Server from a remote computer, 
the network communication is handled by DCOM. In this case, you could create soft phases using 
Visual Basic 6.0 and use the iFIX data system to get tag values. You can write soft phase from the 
Proficy iFIX WorkSpace using VBA, as well. Since the Soft Phase Server is an OPC server you can 
also write soft phases in C++ or Java, but you will need to implement the OPC client logic. 

Using an iFIX Terminal Server 
Proficy Batch Execution supports the iFIX Terminal Server functionality. The guidelines for using 
Batch Execution with an iFIX Terminal Server include: 

• Use the Windows 2003 or Windows Server 2008 (Standard or Enterprise Edition) operating 
system on the iFIX Terminal Server computer, as outlined in the iFIX electronic book. 

• Install the Batch Execution Server on a computer that is separate from the iFIX Terminal 
Server computer and Terminal Server Client computers. 

• Install the Batch Execution Client Components on the iFIX Terminal Server computer. Do not 
install or use the Batch Execution Server or EIB Server on the iFIX Terminal Server 
computer.  

• Use only the Batch ActiveX Controls from the iFIX WorkSpace on the iFIX Terminal Server.  

The following figure illustrates the supported configuration: 

 

The Batch Execution ActiveX controls that you can run from the iFIX WorkSpace on the iFIX 
Terminal Server include:  

• BatchList 

• BatchAdd 

• BatchRecipeList 

• BatchOperatorPromptsList 

• BatchBindingPromptsList 

• BatchAlarmList 

• BatchManualPhase 
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• BatchSFC 

• EWIX 

NOTE: The Batch Execution Client Components also install the Batch Execution Client. The Batch 
Execution Client is not supported on the iFIX Terminal Server. To install the EWIX control, install the 
WorkInstruction Components; this component includes the EWIX ActiveX control. The 
WorkInstruction Editor and EIB Server and other WorkInstruction applications are not supported on 
the iFIX Terminal Server.  

Be aware that the following applications are NOT supported on the iFIX Terminal Server computer: 

• Batch Execution Server 

• VBIS Server 

• WorkInstruction Server 

• WorkInstruction Client 

• Proficy Batch Execution Client 

For information on how to configure the iFIX Terminal Server and the Terminal Server Clients, refer 
to the iFIX Using Terminal Server electronic book. 

Relational Database Configuration 
Using Batch Execution, you can: 

• Store recipes in a relational database. The logical data model defines the structures and rules 
for recipe storage in a relational database.  

• Store batch Event Journal data in a relational database. The batch Event Journal logical data 
model defines the structures and rules for storing electronic batch data in a relational database.  

The sections that follow explain the process of setting up your relational database to: 

• Save and store recipes.  

• Store batch Event Journal data from the Archiver.  

These sections also list any prerequisites and any special installation guidelines you need to set up your 
relational database correctly. Once your relational database is set up, use the Batch Execution 
relational database setup scripts provided with Batch Execution to create the necessary tables. For 
information on the table structures, refer to the Custom Applications manual. 

NOTE: The procedures in these sections reflect the English version of the products discussed. 
Depending on the language of the relational database, your screens may differ. 
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Relational Database Software and Batch Execution 
The sections that follow describe how to set up Batch Execution databases using the following 
relational database software:  

• Oracle® 10g  

• Oracle® 11g 

• Microsoft® SQL Server 2005 

• Microsoft® SQL Server 2008 

For general information on installing your relational database, refer to your relational database 
manuals. 

Task Overview  
The process of setting up a relational database for recipe storage is straightforward and summarized in 
the following table.  

Relational Database Setup for Recipe Storage  

To... Refer to... 

Install your relational database server software. • Setting up an Oracle 10g Database to 
Store Recipes and Archiver Data 

• Setting Up an Oracle 11g Database to 
Store Recipes and Archiver Data 

• Setting up a SQL Server 2005 Database 
to Store Recipes and Archiver Data 

• Setting up a SQL Server 2008 Database 
to Store Recipes and Archiver Data 

• Your relational database manuals. 

Run the Batch Execution relational database 
setup scripts for your relational database to 
create the required tables. 

• Running the Database Scripts for 
Oracle 10g 

• Running the Database Scripts for 
Oracle 11g 

• Running the Database Scripts for SQL 
Server 2005 

• Running the Database Scripts for SQL 
Server 2008 

Define the data source for recipe and archiver 
data storage in your project.  

• Defining Data Sources for Recipe and 
Archiver Data 
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Relational Database Setup for Recipe Storage  

To... Refer to... 

Install relational database client software on the 
Batch Execution Server. 

• Client Installation Guidelines 

Configure the ODBC data sources. • Configuring ODBC Data Sources 

Setting up an Oracle 10g Database to Store Recipes and 
Archiver Data 
Only a database administrator should perform these steps. To set up an Oracle database to store Batch 
Execution recipes and batch Event Journal data from the Archiver:  

Task Refer to the sections... 

Create the database with the Oracle Database 
Assistant. 

Creating an Oracle 10g Database 

Create a user account and log into the database. 
Creating a User Account in Oracle 
10g 

Run the Batch Execution relational database setup 
scripts. 

Running the Setup Scripts for Oracle 
10g 

 

IMPORTANT: Batch Execution does not support the Microsoft ODBC for Oracle driver because it 
does not implement all the required features. Oracle users should use the Oracle ODBC driver 
instead. 

For additional instructions on configuring Oracle, refer to the Oracle documentation. 

Creating an Oracle 10g Database 

Use the Oracle Database Configuration Assistant to create an Oracle 10g relational database. 

To create a database in Oracle 10g: 

1. Click the Start button and point to Programs, and then Oracle, Configuration Migration Tools, 
and Database Configuration Assistant. The Database Configuration Assistant appears, 
displaying a Welcome screen. 
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2. Click Next to continue. The Operations screen appears in the Database Configuration 
Assistant. 

3. Select the Create a Database option and click Next. The Database Templates screen appears in 
the Database Configuration Assistant. 

4. Select the General Purpose template option and click Next. The Database Identification screen 
appears in the Database Configuration Assistant. 

5. Enter a database name and click Next. The Management Options screen appears. 

6. Leave the default options and click Next. The Database Credentials screen appears. 

7. Select the Use the same Password for All Accounts option, enter a password and confirm it, 
and then click Next. The Storage Options screen appears. 

8. Leave the defaults and click Next. The Database File Locations screen appears in the 
Database Configuration Assistant. 

9. Leave the defaults and click Next. The Recovery Configuration screen appears in the 
Database Configuration Assistant. 

10. Leave the defaults and click Next. The Database Content screen appears in the Database 
Configuration Assistant. 

11. Leave the defaults and click Next. The Initialization Parameters screen appears in the 
Database Configuration Assistant. 

12. Leave the defaults and click Next. The Database Storage screen appears asking you to review 
your changes. 

13. Leave the defaults and click Next. The Custom Options screen appears in the Database 
Configuration Assistant. 

14. Click Finish. A confirmation screen appears. 

15. Click OK to continue. A dialog box appears displaying the progress of the database creation. 
This process will take some time to complete. A message displays when the database creation 
process completes. 

Creating a User Account in Oracle 10g 

After you create a database for your Batch Execution tables, you can create a user account for the 
database. The user account is required so that an Oracle client (Batch Execution Server) can log into 
and access the relational database server. 

To create a user account: 

1. Open Internet Explorer, and in the Address field, enter the IP address and port to open your 
Batch Execution database.  For example:  

http://5.22.72.1:5501/em 

where 5.22.72.1 is the IP address of your database, and 5501 is the port number. 

2. Enter a User Name and Password for the user account with administrative privileges. After a 
few moments, the main screen appears. 

3. Click the Administration link at the top of the page. 

4. In the Security area, click the Users link. The Users screen appears. 
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5. Click Create. 

6. Enter a Name and Password, and select the Authentication level from the drop-down list, 
which is usually Password. 

7. Click the Roles link.  

8. Click the Modify button. The Modify Roles screen appears. 

9. From the Available Roles list, select DBA and move it into the Selected Roles list. 

10. Click OK. 

11. Click the System Privileges link.   

12. Click Modify and add whatever privileges you want to give to the user. 

13. Click OK. 

14. Click Apply. 

After you add the users, you can later go back and modify the desired roles and privileges. Refer to 
Oracle Help for information on these options, and for detailed steps on how to configure users. 

Verifying the Database Starts 

After you create the database and add a user to your Oracle 10g database, try logging into the database 
from Internet Explorer. If you can successfully log in and view information about your running 
database, the database is running. 

To verify the database is running: 

1. Open Internet Explorer, and in the Address field, enter the IP address and port to open your 
Batch Execution database. For example:  

http://5.22.72.1:5501/em 

where 5.22.72.1 is the IP address of your database, and 5501 is the port number. 

2. Enter a User Name and Password for the user account with administrative privileges for the 
Batch Execution database tables. After a few moments, the main screen appears. 

3. If you successfully login and can view information about your running database, you can 
conclude that the database is running. 

Running the Database Scripts for Oracle 10g 

After you create a database and user account, run the following Batch Execution relational database 
setup scripts: 

orasql7x.sql – creates the tables used by Batch Execution to store recipes. 

oracleArchiver.sql – creates the tables used by the Batch Execution Archiver to store batch Event 
Journal data. 

oracleAuditTable.sql – creates the tables that store audit versioning design-time information 
from the Audit Reporter, Recipe Editor, Equipment Editor, Batch Execution Configuration 
in the WorkSpace, and the WorkInstruction Editor. 
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CampaignOra.sql – (optional) creates the tables that the Campaign Manager uses to store 
campaign information. 

NOTE: The same scripts are used for all Oracle database versions. 

For detailed information on these table structures, refer to the Custom Applications Manual. Once you 
copy the setup scripts to your relational database, you can run them. 

To run the setup scripts:  

1. Copy the script files from the DatabaseFiles folder of your Batch Server to any folder on the 
Oracle server computer, if Batch Execution is not installed on this computer.  

• oracleArchiver.sql  

• orasql7x.sql 

• oracleAuditTable.sql 

• CampaignOra.sql (only if you want to use the Campaign Manager feature) 

NOTE: If you installed to the default location, you can find the script files in the c:\Program 
Files\Proficy\Proficy Batch Execution\DatabaseFiles folder.  

2. Open Internet Explorer, and in the Address field, enter the IP address and port to open your 
Batch Execution database.  For example:  

http://5.22.72.1:5501/em 

3. Enter a User Name and Password for the user account with administrative privileges for the 
Batch Execution database tables. After a few moments, the main screen appears. 

4. At the bottom of the screen, in the Related Topics, click the iSQLPlus link. The iSQLPlus 
Login screen appears. 

5. Leave the Connect as Normal option selected and click Continue. 

6. Enter a user name and password, and then click Login to start iSQLPlus. 

7. Leave the Internet Explorer window open. 

8. Open the oracleArchiver.sql file in a text editor, such as Notepad, and copy the script 
contents. 

9. Go back to the Internet Explorer window, and in the Workspace area, paste the script. Make 
sure that there are no extra paragraph spaces after you paste the text. 

10. Click the Preferences button. 

11. In the Output Page Setup area, select Single Page so that all output displays on a single page, 
and click Apply. 

12. Click the Workspace tab to return to your pasted script. 

13. Click Execute. The results appear in the bottom half of the window, displaying messages that 
let you monitor your progress.  

14. After the script finishes running, click Clear. 

15. Repeat steps 7-14 with the orasql7x.sql, oracleAuditTable.sql and then, optionally, 
CampaignOra.sql scripts.  
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Setting up an Oracle 11g Database to Store Recipes and 
Archiver Data 
Only a database administrator should perform these steps. To set up an Oracle database to store Batch 
Execution recipes and batch Event Journal data from the Archiver:  

Task Refer to the sections... 

Create the database with the Oracle Database 
Assistant. 

Creating an Oracle 11g Database 

Create a user account and log into the database. 
Creating a User Account in Oracle 
11g 

Run the Batch Execution relational database setup 
scripts. 

Running the Setup Scripts for Oracle 
11g 

IMPORTANT: Batch Execution does not support the Microsoft ODBC for Oracle driver because it 
does not implement all the required features. Oracle users should use the Oracle ODBC driver 
instead. 

For additional instructions on configuring Oracle, refer to the Oracle documentation. 

Creating an Oracle 11g Database 

Use the Oracle Database Configuration Assistant to create an Oracle 11g relational database. 

To create a database in Oracle 11g: 

1. Click the Start button and point to Programs, and then Oracle, Configuration Migration Tools, 
and Database Configuration Assistant. The Database Configuration Assistant appears, 
displaying a Welcome screen. 

2. Click Next to continue. The Operations screen appears in the Database Configuration 
Assistant. 

3. Select the Create a Database option and click Next. The Database Templates screen appears in 
the Database Configuration Assistant. 

4. Select the General Purpose template option and click Next. The Database Identification screen 
appears in the Database Configuration Assistant. 

5. Enter a database name and click Next. The Management Options screen appears. 

6. Leave the default options and click Next. The Database Credentials screen appears. 

7. Select the Use the same Password for All Accounts option, enter a password and confirm it, 
and then click Next. The Storage Options screen appears. 

8. Leave the defaults and click Next. The Database File Locations screen appears in the 
Database Configuration Assistant. 
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9. Leave the defaults and click Next. The Recovery Configuration screen appears in the 
Database Configuration Assistant. 

10. Leave the defaults and click Next. The Database Content screen appears in the Database 
Configuration Assistant. 

11. Leave the defaults and click Next. The Initialization Parameters screen appears in the 
Database Configuration Assistant. 

12. Leave the defaults and click Next. The Security Settings screen appears in the Database 
Configuration Assistant. 

13. Leave the defaults and click Next. The Automatic Maintenance Tasks screen appears in the 
Database Configuration Assistant. 

14. Leave the defaults and click Next. The Database Storage screen appears asking you to review 
your changes. 

15. Leave the defaults and click Next. The Creation Options screen appears in the Database 
Configuration Assistant. 

16. Select Create Database and click Finish. A confirmation screen appears. 

17. Click OK to continue. A dialog box appears displaying the progress of the database creation. 
This process will take some time to complete. A message displays when the database creation 
process completes. 

Creating a User Account in Oracle 11g 

After you create a database for your Batch Execution tables, you can create a user account for the 
database. The user account is required so that an Oracle client (Batch Execution Server) can log into 
and access the relational database server. 

To create a user account: 

1. Open Internet Explorer, and in the Address field, enter the IP address and port to open your 
Batch Execution database.  For example:  

http://5.22.72.1:5501/em 

where 5.22.72.1 is the IP address of your database, and 5501 is the port number. 

2. Enter a User Name and Password for the user account with administrative privileges. After a 
few moments, the main screen appears. 

3. Click the Server link at the top of the page. 

4. In the Security area, click the Users link. The Users screen appears. 

5. Click Create. 

6. Enter a Name and Password, and select the Authentication level from the drop-down list, 
which is usually Password. 

7. Click the Roles link.  

8. Click the Edit List. The Modify Roles screen appears. 

9. From the Available Roles list, select DBA and move it into the Selected Roles list. 

10. Click OK. 

11. Click the System Privileges link.   
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12. Click Edit List and add whatever privileges you want to give to the user. 

13. Click OK. 

14. Click Apply. 

After you add the users, you can later go back and modify the desired roles and privileges. Refer to 
Oracle Help for information on these options, and for detailed steps on how to configure users. 

Verifying the Database Starts 

After you create the database and add a user to your Oracle 11g database, try logging into the database 
from Internet Explorer. If you can successfully log in and view information about your running 
database, the database is running. 

To verify the database is running: 

1. Open Internet Explorer, and in the Address field, enter the IP address and port to open your 
Batch Execution database. For example:  

http://5.22.72.1:5501/em 

where 5.22.72.1 is the IP address of your database, and 5501 is the port number. 

2. Enter a User Name and Password for the user account with administrative privileges for the 
Batch Execution database tables. After a few moments, the main screen appears. 

3. If you successfully login and can view information about your running database, you can 
conclude that the database is running. 

Running the Database Scripts for Oracle 11g 

After you create a database and a user account, run the following Batch Execution relational database 
setup scripts: 

orasql7x.sql – creates the tables used by Batch Execution to store recipes. 

oracleArchiver.sql – creates the tables used by the Batch Execution Archiver to store batch Event 
Journal data. 

oracleAuditTable.sql – creates the tables that store audit versioning design-time information 
from the Audit Reporter, Recipe Editor, Equipment Editor, Batch Execution Configuration 
in the WorkSpace, and the WorkInstruction Editor. 

CampaignOra.sql – (optional) creates the tables that the Campaign Manager uses to store 
campaign information. 

NOTE: The same scripts are used for all Oracle database versions. 

For detailed information on these table structures, refer to the Custom Applications Manual. Once you 
copy the setup scripts to your relational database, you can run them. 
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To run the scripts:  

1. Copy the script files from the DatabaseFiles folder of your Batch Server to any folder on the 
Oracle server computer, if Batch Execution is not installed on this computer.  

• oracleArchiver.sql  

• orasql7x.sql 

• oracleAuditTable.sql 

• CampaignOra.sql (only if you want to use the Campaign Manager feature) 

NOTE: If you installed to the default location, you can find the script files in the c:\Program 
Files\Proficy\Proficy Batch Execution\DatabaseFiles folder.  

2. From the Start menu, point to Programs, Oracle, Application Development, and then SQL 
Plus.  

3. Enter the user name and password for the account you want to use to connect to the database. 

4. Run the oracleArchiver.sql script. To do so, enter the following at the command line: 

@"file location of script" 

For example: 

@"c:\Program Files\Proficy\Proficy Batch 
Execution\databasefiles\oracleArchiver.sql" 

5. Repeat step 4 for orasql7x.sql, oracleAuditTable.sql and, optionally, the CampaignOra.sql 
scripts.  

Setting up a SQL Server 2005 Database to Store Recipes and 
Archiver Data 
Only a database administrator should perform these steps. To set up a SQL Server database to store 
Batch Execution recipes: 

Task Refer to the sections... 

Create a database. Creating a Database for SQL Server 2005 

Create a user account to access the new database. Creating a User Account for SQL Server 
2005 

Run the Batch Execution relational database setup 
scripts. 

Running the Setup Scripts for SQL Server 
2005 

For additional instructions on configuring SQL Server, refer to the SQL Server documentation. 

Creating a Database for SQL Server 2005 

The steps that follow describe how to create a database for SQL Server 2005. 
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To create a database:  

1. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

2. From the tree, right-click the Databases folder and select New Database. The New Database 
dialog box appears. 

3. In the Database name field, enter ARCHIVER.  

4. Leave the rest of the defaults and click OK.  

Creating a User Account for SQL Server 2005  

After you create the relational databases, set up a user account to access them. This account is required 
so that Batch Execution can log into your relational database server and access the relational database. 

To create an account that uses SQL Server Authentication, enter the information listed in the following table.  

Creating a User Account  

In the field... Enter... 

Login Name VBADMIN 

Password VBADMIN 

To create a user account:  

1. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

2. From the tree view, open the Security folder.  

3. Right-click the Logins icon and select New Login. The New Login dialog box appears. 

4. In the Login Name field, enter VBADMIN as the user name, or browse for one. 

5. Select Windows Authentication or SQL Server Authentication.  

• If you select Windows Authentication, select a domain and security access level 
(grant or deny).  

• If you select SQL Server Authentication, enter a login name and password. Fox 
example, enter vbadmin as the login name and vbadmin as the password.  

6. Select a default database from the drop-down list.  

7. Click the Server Roles page.  

8. Select all of the check boxes.  

9. Click the User Mapping page.  

10. Select the check box next to the database name (ARCHIVER, for instance), and make sure all 
appropriate check boxes in the Database Role Membership area are selected.  

11. Leave the default settings for the remaining fields. 

12. Click OK.  



System Configuration Manual 

101 

Running the Database Scripts for SQL Server 2005 

After you create a database and grant the permissions required by the Batch Execution relational 
database setup script, you can log into SQL Server with the VBADMIN user account and run the 
following Batch Execution relational database setup scripts: 

MSQL6X.SQL – creates the tables that Batch Execution uses to store recipes. 

MSQL6XArchiver.SQL – creates the tables that the Batch Execution Archiver uses to store 
batch Event Journal data. 

MSQLAuditTable.SQL – creates the tables that store audit versioning design-time information 
from the Audit Reporter, Recipe Editor, Equipment Editor, Batch Execution Configuration 
in the WorkSpace, and the WorkInstruction Editor.  

CampaignMSSQl.sql – (optional) creates the tables that the Campaign Manager uses to store 
campaign information. 

NOTE: If you want to use Batch Analysis Reports with Batch Execution, you need to run the 
msqlarchiver_BatchAnalysis.sql. For instructions, refer to the Batch Analysis Reports Configuration 
section.  

For detailed information on these table structures, refer to the Custom Applications manual. 

To run the scripts:  

1. Copy these script files from the DatabaseFiles folder of your Batch Server to any folder on the 
SQL Server computer: 

• MSQL6X.SQL  

• MSQL6XArchiver.SQL 

• MSQLAuditTable.SQL 

• CampaignMSSQl.sql (only if you want to use the Campaign Manager feature) 

NOTE: If you installed Batch Execution to the default location, you can find the script files in 
the c:\Program Files\Proficy\Proficy Batch Execution\DatabaseFiles folder.  

2. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

3. In the tree view, in the Databases folder, double-click the database name to which you want to 
add the batch tables. For example, the database name might be ARCHIVER or 
BatchExecution.  

4. Select the Tables folder for the database that you plan to upgrade. 

5. On the File menu, click Open and then File. The Open File dialog box appears. 

6. Select the MSQL6X.SQL script and click Open. The Connect to Database Engine dialog box 
appears. 

7. In the Server Name field, make sure that the server you want appears in this field. If it does 
not, select the server from the drop-down list or browse for it. 

8. Click the Options button to view more configurable fields.  
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9. In the Connect to Database field, select the database name from the drop-down list or browse 
for a database. The script opens as a new tab in the Microsoft SQL Server Management 
Studio window. 

10. In the toolbar, click the Execute button. 

11. Repeat steps 5-10 for the MSQL6XArchiver.SQL script, the MSQLAuditTable.SQL script 
and then, optionally the CampaignMSSQl.sql script. 

Setting up a SQL Server 2008 Database to Store Recipes and 
Archiver Data 
Only a database administrator should perform these steps. To set up a SQL Server database to store 
Batch Execution recipes: 

Task Refer to the sections... 

Create a database. Creating a Database for SQL Server 2008 

Create a user account to access the new database. Creating a User Account for SQL Server 
2008 

Run the Batch Execution relational database setup 
scripts. 

Running the Setup Scripts for SQL Server 
2008 

For additional instructions on configuring SQL Server, refer to the SQL Server documentation. 

Creating a Database for SQL Server 2008 

The steps that follow describe how to create a database for SQL Server 2008. 

To create a database:  

1. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

2. From the tree, right-click the Databases folder and select New Database. The New Database 
dialog box appears. 

3. In the Database name field, enter ARCHIVER.  

4. Leave the rest of the defaults and click OK.  

5. Add the BUILTIN\Administrators to the Logins. To do so: 

a. In the left pane, under the Security folder, right-click the Login folder. 

b. Click New Login. The Login – New window appears. 

c. In the Login Name field enter BUILTIN\Administrators. 

d. From the left pane, select Server Roles. 
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e. In the Server Roles area, select sysadmin. 

f. Click OK. 

Creating a User Account for SQL Server 2008 

After you create the relational databases, set up a user account to access them. This account is required 
so that Batch Execution can log into your relational database server and access the relational database. 

To create an account that uses SQL Server Authentication, enter the information listed in the following 
table.  

Creating a User Account  

In the field... Enter... 

Login Name VBADMIN 

Password VBADMIN 

To create a user account:  

1. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

2. From the tree view, open the Security folder.  

3. Right-click the Logins icon and select New Login. The New Login dialog box appears. 

4. In the Login Name field, enter VBADMIN as the user name, or browse for one. 

5. Select Windows Authentication or SQL Server Authentication.  

If you select SQL Server Authentication, enter a login name and password. Fox example, 
enter vbadmin as the login name and vbadmin as the password.  

6. Select a default database from the drop-down list.  

7. Select a default language from the drop-down list. 

8. Click the Server Roles page.  

9. Select all of the check boxes.  

10. Click the User Mapping page.  

11. Select the check box next to the database name (ARCHIVER, for instance), and make sure all 
appropriate check boxes in the Database Role Membership area are selected.  

12. Leave the default settings for the remaining fields. 

13. Click OK.  

Running the Database Scripts for SQL Server 2008 

After you create a database and grant the permissions required by the Batch Execution relational 
database setup script, you can log into SQL Server with the VBADMIN user account and run the 
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following Batch Execution relational database setup scripts: 

MSQL6X.SQL – creates the tables that Batch Execution uses to store recipes. 

MSQL6XArchiver.SQL – creates the tables that the Batch Execution Archiver uses to store 
batch Event Journal data. 

MSQLAuditTable.SQL – creates the tables that store audit versioning design-time information 
from the Audit Reporter, Recipe Editor, Equipment Editor, Batch Execution Configuration 
in the WorkSpace, and the WorkInstruction Editor.  

CampaignMSSQl.sql – (optional) creates the tables that the Campaign Manager uses to store 
campaign information. 

NOTE: If you want to use Batch Analysis Reports with Batch Execution, you need to run 
msqlarchiver_BatchAnalysis.sql. For instructions, refer to the Batch Analysis Reports Configuration 
section.  

For detailed information on these table structures, refer to the Custom Applications manual. 

To run the scripts:  

1. Copy these script files from the DatabaseFiles folder of your Batch Server to any folder on the 
SQL Server computer: 

• MSQL6X.SQL  

• MSQL6XArchiver.SQL 

• MSQLAuditTable.SQL 

• CampaignMSSQl.sql (only if you want to use the Campaign Manager feature) 

NOTE: If you installed Batch Execution to the default location, you can find the script files in 
the c:\Program Files\Proficy\Proficy Batch Execution\DatabaseFiles folder.  

2. Click the Start button and point to Programs, Microsoft SQL Server, and then SQL Server 
Management Studio. The Microsoft SQL Server Management Studio window appears.  

3. In the tree view, in the Databases folder, double-click the database name to which you want to 
add the batch tables. For example, the database name might be ARCHIVER or 
BatchExecution.  

4. Select the Tables folder for the database that you plan to upgrade. 

5. On the File menu, click Open and then File. The Open File dialog box appears. 

6. Select the MSQL6X.SQL script and click Open. The Connect to Database Engine dialog box 
appears. 

7. In the Server Name field, make sure that the server you want appears in this field. If it does 
not, select the server from the drop-down list or browse for it. 

8. Click the Options button to view more configurable fields.  

9. In the Connect to Database field, select the database name from the drop-down list or browse 
for a database. The script opens as a new tab in the Microsoft SQL Server Management 
Studio window. 
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10. In the toolbar, click the Execute button. 

11. Repeat steps 5-10 for the MSQL6XArchiver.SQL script, the MSQLAuditTable.SQL script 
and then, optionally the CampaignMSSQl.sql script. 

Defining Data Sources for Recipe and Archiver Data 
After you have setup your relational database, you need to specify the name of the data sources in the 
project you are working on so that Batch Execution knows where to: 

• Load and store recipes.  

• Store batch Event Journal data from the Archiver.  

To define a data source for recipe storage:  

1. Select Batch Execution Configuration from the Proficy Batch Execution WorkSpace System 
Tree. A tabbed dialog box appears.  

2. Select the Recipe tab.  

3. In the DSN field, enter the ODBC data source name. This data source must be configured as a 
System DSN.  

4. In the Username field, enter the login name you want to use. 

5. In the Password field, enter the password associated with the login name.  

NOTE: The login name and password you enter must be valid for the relational database 
server you are logging into. 

To define a data source for Archiver data storage:  

1. Select Batch Execution Configuration from the Proficy Batch Execution WorkSpace System 
Tree. A tabbed dialog box appears.  

2. Select the Archiver tab.  

3. In the Data Source Name field, enter the ODBC data source name.  

NOTE: This data source must be configured as a System DSN. 

Client Installation Guidelines 
After you set up your relational database server software, you need to install relational database client 
software on the Batch Execution Server, where the Batch Execution Archiver is running, so that the 
Batch Execution Server can communicate with the relational database server. 

Use the instructions in the following sections to install the client software:  

• Installing SQL Server Client Software 

• Installing Oracle Client Software 

If you are using a Microsoft Access database for a test database (non-production database), you can 
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omit the client installation. 

NOTE: GE does not support the use of Microsoft Access for data archiving in a production 
environment. 

Installing SQL Server Client Software 

To install SQL Server client software:  

1. Log in to Windows as an Administrator. 

2. Double-click sqlncli.msi to start the SQL Server install program. The Welcome message box 
appears.  

3. Accept the terms of the license and then click Next. 

4. Enter your name in the Name field and your company in the Company field and click Next. 

5. Select Client Components and click Next. 

6. Click Install. 

7. Click Finish. 

Installing Oracle Client Software 

The steps that follow describe how to install the Oracle 10g client software. 

To install Oracle client software: 

1. Log in to Windows as an Administrator. 

2. Double-click the setup.exe file on the Oracle Client installation CD to start the install. The 
Oracle Universal Installer screen appears. 

2. Follow the instructions on your screen. Select Administrator as your installation type when 
prompted, and click Next to continue.  

3. Wait for the install to complete. This possibly can take up to 10 or more minutes. After the 
install, the Oracle Net Configuration assistant appears. 

4. Click Cancel and finish the installation. 

5. Additional configuration may also be required. For instance, the tnsnames.ora may require 
updating. Refer to your Oracle documentation for more information. 

6. Restart your computer. 

Configuring ODBC Data Sources  
After you define data sources for your recipe and Archiver data in your project and install relational 
database client software, you need to configure the data sources on your ODBC client (Batch 
Execution Server) in Windows. 

IMPORTANT: Batch Execution does not support the Microsoft ODBC for Oracle driver because it 
does not implement all the required features. Oracle users should use the Oracle ODBC driver 
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instead. 

Before you start, you need to know: 

• The type of relational database associated with the data source (required for Oracle or SQL 
Server).  

• The data source names. Make sure these names match the names defined in your Batch 
Execution project.  

• The name of your relational database server.  

To configure an ODBC data source:  

1. Click the Start button and point to Settings, Control Panel, Administrative Tools, and then 
Data Sources (ODBC).  

The ODBC Data Source Administrator dialog box opens. 

2. Select the System DSN tab.  

3. Select the Add button. The Add Data Sources dialog box appears.  

4. Select the type of relational database you want to use and click OK. A dialog box appears.  

5. In the Data Source Name field, enter the data source name. Make sure the data source name 
matches the name defined in your project.  

6. In the Server field, enter the name of your relational database server and click OK.  

Once the data sources are defined, log into your relational database server with the client software you 
installed to ensure the Batch Execution Server can connect to your relational database server. 

Initialization Files 
Proficy Batch Execution uses several initialization files. In most cases, you do not need to edit these 
files manually. The settings in these files are set by each application based on the definitions you enter 
in the user interface. These initialization files include the: 

• VBEXEC.INI 

• VBVIEW32.INI 

• BATCHARCHIVER.INI 

• BATCHEQUIPMENTEDITOR.INI 

• BATCHRECIPEEDITOR.INI 

• FIXWORK.INI 

The following sections describe the purpose, contents, and location of each of these initialization files. 
 Also included are samples of each of these initialization files. 
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VBEXEC.INI 

Purpose 

When you start the Batch Execution Server, Equipment Editor, and Recipe Editor applications, they 
read the VBEXEC.INI file to determine which project is currently active. The VBEXEC.INI file 
contains the information for the last project that was opened in the Proficy Batch Execution 
WorkSpace. 

The information in this file corresponds to the entries in the Batch Execution Configuration dialog box. 
This dialog box is accessed from the Proficy Batch Execution WorkSpace. 

The VBEXEC.INI file contains the following project configuration settings: 

• The area model that the project uses.  

• Hold propagation setting defined for the project.  

• Event Journal file storage locations.  

• Error log information.  

• Watchdog configuration settings.  

• Archiver initialization file name and whether archiving is enabled.  

• Whether equipment capacity checking is enabled.  

• Recipe storage information (whether recipes are stored in SQL format and, if so, the data 
source information).  

• AllowParallelOperations setting. By default, this is set to No to conform with S88.01 
standards. If you want to be able to run operations in parallel, change this entry so that it 
reads: AllowParallelOperations=YES.  

• The default serial number (Buck ID) used when you schedule a batch. 

Location 

On Windows Vista or Windows Server 2008, the VBEXEC.INI file resides in the 
C:\ProgramData\Proficy\Proficy Batch Execution\Configs folder. On Windows XP or Windows Server 
2003, the file is located in the C:\Documents and Settings\All Users\Application Data\Proficy\Proficy 
Batch Execution\Configs folder. When you upgrade, a copy of your previous .INI file is saved as a 
.bak file in the same location. 

Info Logging 

To enable the Batch Execution Server to log errors to the VBEXEC.LOG, change the 
EnableInfoLogging=No statement to EnableInfoLogging=Yes. You can also enable Info Logging in 
the Batch Execution WorkSpace from the Batch Execution Configuration dialog box, under the Server 
tab. 

With Info Logging enabled, you can use the VBEXEC.LOG to track down issues with the Batch 
Execution Server. It is not recommended that you enable Info Logging for daily operations in a 
production environment, because of the large number of informational messages that will be produced 
by the server.  
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Configuring the Batch Serial Number (BUCKID) Location 

The default batch serial number (Buck ID) when you schedule a batch is listed in the CreateID field in 
the [BUCK] section of the VBEXEC.INI file.  

However, if you want to use a default batch serial number defined on a remote computer, you can do 
this by creating the buckid.ini and buckpath.ini files. If a buckpath.ini file exists on the server, the 
CreateID information entered in the [BUCK] section of the VBEXEC.INI file is bypassed.  

NOTE: Starting with Batch 5.5, you must save your buckid.ini and buckpath.ini files to one of 
the following folder locations:  

• Windows Vista or Windows Server 2008: C:\ProgramData\Proficy\Proficy Batch 
Execution\Configs  

• Windows XP or Windows Server 2003: C:\Documents and Settings\All Users\Application 
Data\Proficy\Proficy Batch Execution\Configs  

To specify a default batch serial number on a remote computer: 

1. Shut down the Batch Server. 

2. In Notepad or another text editor, create a file named buckid.ini.  

3. Insert the following information, but replace 1 with the default serial number you want to use: 

[BUCK] 

CreateID=1  

4. Save the file on the remote computer.  

5. On the Batch Server computer, create a file named buckpath.ini and save it in the Config 
folder. The default path for Windows XP or Windows Server 2003 is: C:\Documents and 
Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs. For Windows 
Vista or Windows Server 2008 the default path is: C:\ProgramData\Proficy\Proficy Batch 
Execution\Config. 

6. In the buckpath.ini file, enter the following information, but replace \\myserver\data\ with the 
path to the buckid.ini file created in step 2: 

[BUCK] 

Path=\\myserver\data\buckid.ini 

7. Save the file on the Batch Server computer.  

Example of VBEXEC.INI 

Below is an example of a VBEXEC.INI file 

[RECIPE] 
HoldPropagate=BATCH 
RecipeDirectoryPath=C:\Program Files\Proficy\PROFICY BATCH 
EXECUTION\PROJECTS\DEMO\RECIPES\ 
RecpParmDecimals=4 
[AREA] 
AreaModelFilename=C:\Program Files\Proficy\PROFICY BATCH 
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EXECUTION\PROJECTS\DEMO\RECIPES\DEMO.CFG 
AreaModelFileDateTime=15:05:26 Monday, April 20, 2009 
[EVENT MANAGER] 
MinAvailDiskSpace=10000000 
RestartDirectoryPath=C:\Program Files\Proficy\PROFICY BATCH 
EXECUTION\PROJECTS\DEMO\RESTART1\ 
RestartDirectoryPath2=C:\Program Files\Proficy\PROFICY BATCH 
EXECUTION\PROJECTS\DEMO\RESTART2\ 
RestartType=QUERY 
EventDirectoryPath=C:\Program Files\Proficy\PROFICY BATCH 
EXECUTION\PROJECTS\DEMO\JOURNALS\ 
EventDirectoryPathSecondary=C:\Program Files\Proficy\PROFICY BATCH 
EXECUTION\PROJECTS\DEMO\JOURNALS\ 
SoftPhaseConfigPath= 
SimConfigPath= 
EWIStorePath=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\EWI\ 
CheckAll=NO 
[ERROR] 
ErrorLogOffset=790 
ErrorLogMaxFileSize=1000000 
EnableInfoLogging=NO 
ErrorLogDirectory=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\LOGS\ 
AllowBatchOnUnVerifiedRecipes=YES 
AllowBatchOnAreaModelModified=YES 
RecipeVerificationRequired=YES 
[CLIENT MGR DDE] 
ClientMgrDdeServerName= 
ClientMgrDdeServerTopic= 
[SECURITY] 
Password= 
[XMAN] 
WatchdogPeriod=60000 
WatchdogCycles=10 
[ARCHIVER] 
ArchiverIniFileName=D:\Documents and Settings\All Users\Application Data\Proficy\Proficy 
Batch Execution\CONFIGS\ARCHIVERENABLED=NO 
ArchiverEnabled=Yes 
[CAPACITY] 
CapacityEnabled=YES 
[RMF] 
DSN=vbadmin 
ODBCUsername=vbadmin 
ODBCPassword=0x6b 0xd4 0x3b 0x8d 0x65 0x62 0x38 0x9f 0x44 0x98 0xb6 0x75 0xff 0x34 0x58 
0x18 
StorageType=FILE 
AllowParallelOperations=NO 
EWISSIniPath= 
EWIUsername= 
EWIPassword= 
EWISQLDataStoreDSN= 
EWISQLUsername= 
EWISQLPassword= 
EWIRestartType=QUERY 
[PUBLISHER] 
PublisherIniFileName=D:\Documents and Settings\All Users\Application Data\Proficy\Proficy 
Batch Execution\CONFIGS\[EWI] 
EWIIniFileName=D:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch 
Execution\CONFIGS\[AUDITCFG] 
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AuditCfgIniFileName=D:\Documents and Settings\All Users\Application Data\Proficy\Proficy 
Batch Execution\CONFIGS\[BUCK] 
CreateID=1 
[ACTIVEBINDING] 
UseUnitPriority=NO 
[HEARTBEAT] 
ServerHeartbeatEnabled=No 
ServerHeartbeatFrequency=0 
[ENCRYPTION] 
Flag=Yes 
[SPS] 
SPSRestartType=QUERY 
[BUCK] 
CreateID=3 
[CampaignManager] 
DSN=vbadmin 
Username=vbadmin 
Password=0xc7 0x6a 0xaa 0xb3 0x06 0xc8 0xd3 0x94 0xd0 0x33 0x88 0x54 0x7a 0x50 0x6f 0xef 

VBVIEW32.INI 

Purpose 

When the Batch Execution Client starts, it reads the VBVIEW32.INI file to obtain configuration 
information for the Batch Execution Client screens and dialog boxes. These settings in this file 
correspond with the System Configuration and Defaults dialog box in the Batch Execution Client. 

Location 

On Windows Vista or Windows Server 2008, the vbview32.ini file is located in the 
C:\ProgramData\Proficy\Proficy Batch Execution\Configs folder, by default. On Windows XP or 
Windows Server 2003, the file is located in the C:\Documents and Settings\All Users\Application 
Data\Proficy\Proficy Batch Execution\Configs folder. When you upgrade, a copy of your previous .INI 
file is saved as a .bak file in the same location. 

Example 

[Localization] 
LanguageDLL=OBVWENG.DLL 
[General Information] 
ViewFont=Arial,10,700,0 
SplitterX=6 
SplitterY=6 
XExtentPct=100 
YExtentPct=100 
Server=Server 
Topic=NotUsed 
HMIPath= 
HMITitle= 
HMIBitmap= 
ConfirmCommands=1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1 
EnableCommands=1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1 
RemoteMachineName= 
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ServerLocation=Local 
PathPCellBitmaps=C:\Program Files\Proficy\Proficy Batch Execution\BMP\PROCCELL\  
PathUnitBitmaps=C:\Program Files\Proficy\Proficy Batch Execution\BMP\UNIT\  
PathManiBitmaps=C:\Program Files\Proficy\Proficy Batch Execution\BMP\MANIFOLD\  
ShowLoginDialog=No 
Decimal Places=1 
Batch Version=55 
[SECURITY] 
CompanyName=Intellution 
SiteName=Build 002 Inty Build 
[Batch List View] 
BatchID=Batch ID,%,20.,0,2,1 
Recipe=Recipe,%,15.,0,1,1 
Descript=Description,%,21.,0,8,1 
STime=Start Time,%,20.,0,9,1 
ETime=Elapsed Time,%,14.,0,10,1 
State=State,%,13.,0,3,1 
Mode=Mode,%,9.,0,4,1 
ProcCell=Process Cells,%,9.,0,5,1 
Unit=Unit,%,6.,0,6,1 
Phase=Phase,%,14.,0,7,1 
ViewFont=Arial,12,700,0 
RowHeight=20 
SortOrder=1 
Fail=Failure,%,37.,0,11,1 
UniqueID=UniqueID,%,50.,0,0,0 
AuditVer=Audit Version,%,16.,0,0,1 
[Event Log View] 
Area=Area,%,50.,0,9,0 
BatchID=BatchID,%,50.,0,3,0 
Descript=Description,%,47.,0,5,1 
EU=EU,%,50.,0,8,0 
Event=Event Type,%,19.,0,6,1 
ProcCell=ProcCell,%,50.,0,10,0 
Recipe=Recipe,%,50.,0,4,0 
LclTime=Time,%,50.,0,11,0 
Unit=Unit,%,6.,0,1,1 
Phase=Phase,%,9.,0,2,1 
PValue=Value,%,9.,0,7,1 
PhaseDesc=Phase Description,%,14.,0,0,1 
User=User,%,80,0,0,1 
ViewFont=Arial,12,700,0 
RowHeight=16 
SortOrder=0 
UserID=User,%,5.,0,0,1 
UniqueID=UniqueID,%,50.,0,0,0 
RecpType=Recipe Type,%,50.,0,0,0 
Sequence=Sequence,%,50.,0,0,0 
Key Process Report=Key Process Report,%,50.,0,0,0 
[Prompts View] 
LclTime=Time,%,50.,0,1,0 
BatchID=Batch ID,%,14.,0,4,1 
Recipe=Recipe,%,47.,0,5,1 
Descript=Equipment Description,%,61.,0,7,1 
Event=Event Type,%,50.,0,8,0 
PValue=Value,%,8.,0,0,1 
EU=EU,%,11.,0,9,1 
Area=Area,%,10.,0,2,1 
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ProcCell=ProcCell,%,50.,0,3,0 
Unit=Unit,%,9.,0,6,1 
Phase=Phase,%,9.,0,0,1 
ViewFont=Arial,12,700,0 
RowHeight=25 
SortOrder=0 
Uptnotice=1 
Upromptedit=3 
UniqueID=,%,50.,0,0,0 
[Alarm Summary View] 
Phase=Phase,%,22.,0,7,1 
State=State,%,17.,0,0,1 
Unit=Unit,%,15.,0,3,1 
Fail=Failure,%,104.,0,5,1 
BatchID=Batch ID,%,15.,0,0,1 
ViewFont=Arial,12,700,0 
RowHeight=25 
SortOrder=1 
[Phase Summary View] 
Phase=Phase,%,20.,0,0,1 
State=State,%,13.,0,0,1 
Mode=Mode,%,10.,0,0,1 
Unit=Unit,%,19.,0,0,1 
Owner=Owner,%,19.,0,0,1 
StepIndex=Step Index,%,102,0,0,1 
Message=Message,%,148,0,0,1 
BatchID=Batch ID,%,15.,0,0,1 
Failure=Failure,%,215,0,0,1 
ViewFont=Arial,12,700,0 
RowHeight=25 
SortOrder=0 
Idx=Step Index,%,12.,0,0,1 
Mesg=Message,%,18.,0,0,1 
Fail=Failure,%,46.,0,0,1 
[Recipe List Dialog] 
ViewFont=Arial,10,400,0 
RowHeight=16 
SortOrder=0 
FIELD_1=Product Version,%,10.,0,0,0 
FIELD_2=File Name,%,10.,0,0,0 
FIELD_3=Identifier,%,20.,0,0,1 
FIELD_4=Procedure Description,%,25.,0,0,1 
FIELD_5=Product Name,%,50.,0,0,0 
FIELD_6=Product Code,%,20.,0,0,1 
FIELD_7=Version Num,%,20.,0,0,1 
FIELD_8=Version Date,%,25.,0,0,1 
FIELD_9=Author,%,50.,0,0,0 
FIELD_10=Approved By,%,50.,0,0,0 
FIELD_11=Recipe Type,%,25.,0,0,1 
FIELD_12=Equipment,%,50.,0,0,0 
FIELD_13=Procedure Abstract,%,25.,0,0,1 
FIELD_14=Batch Size Min,%,50.,0,0,0 
FIELD_15=Batch Size Dflt,%,50.,0,0,0 
FIELD_16=Batch Size Max,%,50.,0,0,0 
FIELD_17=Batch Size EU,%,50.,0,0,0 
FIELD_18=Batch Run Length,%,50.,0,0,0 
FIELD_19=Released To Batch,TRUE,10.,0,0,0 
FIELD_20=Area Model File Name,%,50.,0,0,0 
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FIELD_21=Area Model Validated Against,%,50.,0,0,0 
FIELD_22=Class Instance,%,50.,0,0,0 
FIELD_23=Validation Time,%,50.,0,0,0 
FIELD_24=Storage Type,%,20.,0,0,1 
FIELD_31=Audit Version,%,25.,0,0,1 
[SFC View] 
Expressions=1 
LineWidth=10 
TextBox=1 
StateColors=16711935,65535,16711680,65280,32768,32896,8421504,8388608,8388736,16777215,65
280,255 
FillStyles=-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1 
[Phase Control] 
ViewFont=Arial,10,400,0 
PhaseStateFont=Arial,10,400,0 
PhaseMsgFont=Arial,10,400,0 
PhaseListFont=Arial,10,400,0 
[Table View - Procedures] 
Name=Name,80.,0,1,1 
State=State,80.,0,1,1 
Mode=Mode,80.,0,1,1 
Failure=Failure,80.,0,1,1 
Owner=Owner,80.,0,1,1 
ParamList=Binding Unit,80.,0,1,1 
ViewFont=Arial,10,700,0 
RowHeight=20 
Used Unit=Used Unit,84.,0,1,1 
Binding Unit=Parameter,80.,0,1,1 
[Table View - Unit Procedures] 
Name=Name,90.,0,1,1 
State=State,80.,0,1,1 
Mode=Mode,80.,0,1,1 
Failure=Failure,80.,0,1,1 
Owner=Owner,80.,0,1,1 
ParamList=Parameters,80.,0,1,1 
ViewFont=Arial,10,700,0 
RowHeight=20 
Used Unit=Used Unit,50.,0,1,1 
[Table View - Operations] 
Name=Name,80.,0,1,1 
State=State,80.,0,1,0 
Mode=Mode,80.,0,1,0 
StepIdx=Step Index,80.,0,1,0 
Unit=Unit,80.,0,1,0 
Owner=Owner,80.,0,1,0 
Control=Control,80.,0,1,1 
Message=Message,80.,0,1,1 
Request=Request,80.,0,1,1 
Failure=Failure,98.,0,1,1 
ParamList=Parameters,80.,0,1,0 
ReportList=Reports,80.,0,1,0 
ViewFont=Arial,10,700,0 
RowHeight=20 
Used Unit=Unit,50.,0,1,1 
[Hierarchical Step List] 
State=State,100.,0,1,1 
Mode=Mode,80.,0,1,1 
Unit=Unit,80.,0,1,1 
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Index=Index,80.,0,1,1 
KeyParam=Key Parameters,250.,0,1,1 
RowHeight=20 
ViewFont=Arial,10,700,0 
Used Unit=Unit,50.,0,1,0 
Binding Unit=,50.,0,1,0 
[Procedure Prompts View] 
LclTime=Time,,50.,0,0,0 
BatchID=Batch ID,BATCH_ID,12.,0,0,1 
Recipe=Recipe,412:%,40.,0,0,1 
Descript=Description,,40.,0,0,1 
Event=Event Type,,50.,0,0,0 
PValue=Value,,10.,0,0,1 
EU=Eng. Units,,10.,0,0,1 
Area=Area,,50.,0,0,0 
ProcCell=Process Cell,,15.,0,7,1 
Unit=Unit,%,50.,0,0,0 
Phase=Phase,,25.,0,0,1 
ViewFont=Arial,10,700,0 
RowHeight=25 
SortOrder=0 
[Procedure Parameters View] 
Name=Name,,15.,0,1,1 
Low=Low,,20.,0,0,1 
PValue=Value,,20.,0,0,1 
High=High,,20.,0,0,1 
EU=Eng. Units,,20.,0,0,1 
ViewFont=Arial,10,700,0 
RowHeight=20 
SortOrder=0 
[Procedure Reports View] 
Name=Name,,35.,0,0,1 
PValue=Value,,35.,0,0,1 
EU=EU,,20.,0,0,1 
ViewFont=Arial,12,700,0 
RowHeight=20 
SortOrder=0 
Key Process Report=Key Process Report,%,50.,0,0,0 
[Event File List Dialog] 
FIELD_1=Batch ID,%,5.,0,0,1 
FIELD_2=,,10.,0,0,0 
FIELD_3=Description,%,23.25,0,0,1 
FIELD_4=,,10.,0,0,0 
FIELD_5=Start Time,%,11.125,0,0,1 
FIELD_6=Recipe,%,20.,0,0,1 
ViewFont=Arial,10,400,0 
RowHeight=16 
SortOrder=0 
[Binding Prompts View] 
LclTime=Time,%,18.,0,1,1 
BatchID=Batch ID,%,16.,0,2,1 
Recipe=Recipe,%,19.,0,3,1 
Descript=Binding Description,%,71.,0,4,1 
Area=Area,%,50.,0,0,0 
ProcCell=ProcCell,%,50.,0,0,0 
StepName=Step Name,%,21.,0,5,1 
Unit=Default Unit,%,50.,0,7,0 
UnitClass=Unit Class,%,25.,0,6,1 
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ViewFont=Arial,12,700,0 
RowHeight=25 
SortOrder=1 
BindingNotice=0 
BindingPrompt=2 
UniqueID=,%,50.,0,0,0 
BatchSN=Batch SN,%,50.,0,0,0 
[Remote Server Information] 
ViewFont=Arial,10,400,0 
Remote Server Enabled=No 
Remote Server Enabled in Toolbar=No 
The Server List= 
[Transition Breakpoint Prompts View] 
Batch ID=Batch ID,%,36.5,0,2,1 
Recipe=Recipe,%,43.125,0,2,1 
Transition Expression=Transition Expression,%,64.,0,2,1 
Event ID=Event ID,%,50.,0,2,0 
ViewFont=Arial,12,700,0 
RowHeight=25 
SortOrder=1 
Recipe=Recipe,%,50.,0,0,0 

BATCHARCHIVER.INI 

Purpose 

When you start the Batch Execution Archiver, it reads the BATCHARCHIVER.INI file. This file 
contains Archiver run-time settings, such as the name of the ODBC data source to which the Batch 
Execution Archiver writes data. The settings in this file correspond to the Archiver tab in the Batch 
Execution Configuration dialog box. You can access the Batch Execution Configuration dialog box 
from the Proficy Batch Execution WorkSpace. 

To configure the Batch Execution Archiver to log errors to the BATCHARCHIVER.LOG file, change 
the EnableInfoLogging=No statement to EnableInfoLogging=Yes. With this enabled, you can also 
view errors in the Batch Execution Server Manager. 

Location 

On Windows Vista or Windows Server 2008, this file resides in the C:\ProgramData\Proficy\Proficy 
Batch Execution\Configs folder. On Windows XP or Windows Server 2003, the file is located in the 
C:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs 
folder. When you upgrade, a copy of your previous .INI file is saved as a .bak file in the same location. 

Example 

Listed below is an example of a BATCHARCHIVER.INI file. 

[ARCHIVER] 
ArchiverDSN=ONLINEJ 
ArchiverConnectionString=ODBC; 
ArchiverErrorLogFile= 
ArchiverReconnectionInterval=0 
ArchiverBacklogAge=0 
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ArchiverIniFileName=BatchArchiver.ini 
ArchiverVersionEnable=1 
ArchiverDSNUsername= 
ArchiverDSNPassword= 
ArchiverEnabled=Yes 
ArchiverEnableInfoLogging=No 
ArchiverFlushThreshold=50 
UpdateArchiverMgrRate=2 
[EVENT FILTERS] 
ArchiverFilterActiveBinding=Yes 
ArchiverFilterBatchDescription=Yes 
ArchiverFilterComment=Yes 
ArchiverFilterEventFileName=Yes 
ArchiverFilterMessage=Yes 
ArchiverFilterModeChange=Yes 
ArchiverFilterModeCommand=Yes 
ArchiverFilterOwner=Yes 
ArchiverFilterParamDownloadVerified=Yes 
ArchiverFilterParamDownloadVerifyFail=Yes 
ArchiverFilterPermissiveMsgCanc=No 
ArchiverFilterPermissiveMsgRcvd=No 
ArchiverFilterPermissiveMsgSent=No 
ArchiverFilterPhaseLogicArb=No 
ArchiverFilterPrompt=Yes 
ArchiverFilterPromptResponse=Yes 
ArchiverFilterRecipeDescription=Yes 
ArchiverFilterRecipeHeader=Yes 
ArchiverFilterRecipeValue=Yes 
ArchiverFilterRecipeValueChange=Yes 
ArchiverFilterRecipeVersion=Yes 
ArchiverFilterReport=Yes 
ArchiverFilterScaleFactor=Yes 
ArchiverFilterStateChange=Yes 
ArchiverFilterStateCommand=Yes 
ArchiverFilterStepActivity=Yes 
ArchiverFilterSystemMessage=Yes 
ArchiverFilterActiveStepChangeCommencing=Yes 
[FIELDS] 
;<FieldName>=<Yes | No> [,<C | D | N  >] 
[PUBLISHERS] 
PublisherList= 
[ENCRYPTION] 
Flag=Yes 
[ERROR] 
ArchiverErrorLogMaxFileSize=100000 
ErrorLogOffset=82 

BATCHEQUIPMENTEDITOR.INI 

Purpose 

When you start the Equipment Editor, from either the Proficy Batch Execution WorkSpace or by 
double-clicking its icon in the Batch Execution program group, it reads the 
BATCHEQUIPMENTEDITOR.INI file. This file contains the bitmap locations for the equipment 
bitmaps used in the Equipment Editor. The information in this file corresponds to entries in the Select 
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Directories dialog in the Equipment Editor. 

Location 

On Windows Vista or Windows Server 2008, this file resides in the C:\ProgramData\Proficy\Proficy 
Batch Execution\Configs folder. On Windows XP or Windows Server 2003, the file is located in the 
C:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs 
folder. When you upgrade, a copy of your previous .INI file is saved as a .bak file in the same location. 

Example 

Listed below is an example of a BATCHEQUIPMENTEDITOR.INI file. 

[DIRS] 
PCBDIR=C:\Program Files\Proficy\Proficy Batch Execution\BMP\PROCCELL 
PHBDIR=C:\Program Files\Proficy\Proficy Batch Execution\BMP\PHASE 
UNBDIR=C:\Program Files\Proficy\Proficy Batch Execution\BMP\UNIT 
MANBDIR=C:\Program Files\Proficy\Proficy Batch Execution\BMP\MANIFOLD 
[SECURITY] 
CompanyName=Intellution 
SiteName=Build 002 Inty Build 
[Recent File List] 
File1=C:\Program Files\Proficy\Proficy Batch Execution\Projects\DEMO\RECIPES\DEMO.CFG 
[RECIPE] 
EnablePhaseDescriptions=NO 
PhaseDescStateChange=NO 

BATCHRECIPEEDITOR.INI 

Purpose 

When you start the Recipe Editor, from either the Proficy Batch Execution WorkSpace or by double-
clicking its icon in the Batch Execution program group, it reads the BATCHRECIPEEDITOR.INI file. 
This file contains the environment settings, such as font sizes and the display of toolbars, that 
correspond the selections on the View menu in the Recipe Editor. 

Location 

On Windows Vista or Windows Server 2008, this file resides in the C:\ProgramData\Proficy\Proficy 
Batch Execution\Configs folder. On Windows XP or Windows Server 2003, the file is located in the 
C:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs 
folder. When you upgrade, a copy of your previous .INI file is saved as a .bak file in the same location.  

Example 

Listed below is an example of a BATCHRECIPEEDITOR.INI file. 

[VBEXEC] 
Path=D:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch 
Execution\Configs\vbexec.ini  
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[VIEW] 
ShowToolbar=YES 
ShowStatusbar=YES 
ShowSFCToolbar=YES 
ShowRecipeList=YES 
ShowEquipmentLinks=YES 
[Misc] 
DockedDialogState=7936 
DialogOriginX=0 
DialogOriginY=68 
FloatingDialogCXSize=138 
FloatingDialogCYSize=474 
DockedDialogCXSize=138 
DockedDialogCYSize=474 
[PAGESETUP] 
LeftMargin=250 
RightMargin=250 
BottomMargin=250 
TopMargin=180 
[EDIT_FORMULATION] 
SplitterPosition=150 
[TABULAR_RECIPE] 
ShowRevisionLogPrompt=NO 
IndexWidth=10 
UnitWidth=14 
UnitStartWidth=0 
AWidth=2 
BWidth=2 
CWidth=2 
DWidth=2 
EWidth=2 
SplitWidth=2 
JoinWidth=2 
DescriptionWidth=60 
CommentWidth=0 
[Recent File List] 
File1=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\RECIPES\MAKE_BAS.UOP 
File2=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\RECIPES\BASE.UPC 
File3=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\RECIPES\MAKE_ADD.UOP 
File4=C:\Program Files\Proficy\PROFICY BATCH EXECUTION\PROJECTS\DEMO\RECIPES\ADDITIVE.UPC 

FIXWORK.INI 

Purpose 

When you start the Proficy iFIX WorkSpace, it reads the FIXWORK.INI file. This file contains the 
settings for the Proficy iFIX WorkSpace, such as the last project that was opened.  

Location 

On Windows Vista or Windows Server 2008, this file resides in the C:\ProgramData\Proficy\Proficy 
Batch Execution\Configs folder. On Windows XP or Windows Server 2003, the file is located in the 
C:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch Execution\Configs 
folder. When you upgrade, a copy of your previous .INI file is saved as a .bak file in the same location.  
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Example 

Listed below is an example of a FIXWORK.INI file. 

[Start Up] 
ShowDialog=TRUE 
LastProjectName=DEMO 
LastProjectPath=C:\Program Files\Proficy\Proficy Batch Execution\Projects\DEMO.WKB 
[Misc] 
DockedDialogState=7936  
DialogOriginX=-2  
FloatingDialogCXSize=233  
DialogOriginY=69  
FloatingDialogCYSize=387  
DockedDialogCXSize=233  
DockedDialogCYSize=387  
[Recent File List] 
File1=C:\Program Files\Proficy\Proficy Batch Execution\Projects\DEMO.WKB 
File2=C:\Program Files\Proficy\Proficy Batch Execution\Projects\EWIDemo.wkb 

WorkSpace Dialog Boxes 
The WorkSpace application includes the following dialog boxes (listed in alphabetical order): 

• Batch Execution Configuration Dialog Box 

• Datasources Dialog Box 

• Enter New Project Name Dialog Box 

• Insert Object Dialog Box 

• Open Dialog Box 

• Project Configuration Dialog Box 

Batch Execution Configuration Dialog Box 
The Batch Execution Configuration dialog box displays the following tabs: 

• Project Tab 

• Server Tab 

• Recipe Tab 

• Archiver Tab 

• Electronic Work Instruction(EWI) Tab 

• Electronic Signature Tab 

• Restart Control Tab 

• Campaign Manager Tab 
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Project Tab 

The Project tab in the Batch Execution Configuration dialog box displays the following items: 

Name 

Specifies the path and file name of the VBEXEC.INI file, which contains the information for the last 
project opened, including the area model.      

Valid Entries:  Display only. 

Example:  D:\Documents and Settings\All Users\Application Data\Proficy\Proficy Batch 
Execution\Configs\vbexec.ini 

Project Directories  

The following table lists the Project Directories contents:  

Item Description 

Recipe Enter the path location where recipes are stored.    

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\RECIPES 

Primary Journal 
Enter the primary path for the Batch Execution Server to store the batch 
journal.  This journal contains all the events that have occurred during 
production.     

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\Journals 

Secondary Journal 
Enter a backup path for the Batch Execution Server to store the batch 
journal.  The Batch Execution Server uses this path when the primary 
journal path becomes unavailable.  Typically, this is a network path.     

Example:  Z:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\Journals 

Error Logging 
Enter the path location of the error log file, VBEXEC.LOG.    

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\Logs 
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Item Description 

Equipment 
Database 

Enter the path location of the active area model.   

NOTE: This field is only available at the time of initial configuration. 

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\Recipes\DEMO.CFG 

Primary Restart 
Path 

Enter the primary path in which the Batch Execution Server stores its 
work files during normal operations.  The Batch Execution Server uses 
these files on a warm restart.   

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\LOGS 

Secondary Restart 
Path 

Enter a backup path in which the Batch Execution Server stores its work 
files during normal operations.  The Batch Execution Server reads the 
files in this path on warm restart, if the primary path is unavailable. 
 Typically, this is a network path. 

Example:  Z:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\LOGS 

EWI Directory 
Store 

Enter the local path where you want to store the files that the system pulls 
from SourceSafe when using the EWI functionality.  

Server Tab 

The Server tab in the Batch Execution Configuration dialog box displays the following items: 

Logging  

The following table lists Logging contents:  

Item Description 

Maximum File Size 
Enter the maximum size, in bytes, for the error log file, 
VBEXEC.LOG. By default, the maximum file size is set to 
1000000.   

Valid Entries:  1 to 999,999,999 

NOTE: If you enter a value lower than 10240, at run time the value 
is set to 10240. 
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Item Description 

Minimum Disk Space 
Enter the minimum amount of disk space in KB required for the 
error log file, VBEXEC.LOG. By default, the minimum file size is 
set to 1000000 KB.    

Valid Entries:  1 to 999,999,999 

Enable Info Logging 
Select this option to provide information on system events in the 
Vbexec.log file for troubleshooting issues with the Batch Execution 
Server.   

It is not recommended that you enable Info Logging for daily 
operations in a production environment, because of the large number 
of messages that will be produced by the server. 

Hold Propagation  

The following table lists the Hold Propagation contents:  

Item Description 

None 
Setting hold propagation to None causes the Batch Execution Server 
to ignore a hold command issued by the phase logic when a phase 
fails. 

Phase 
Select Phase to set hold propagation at the phase level.  Setting hold 
propagation at the phase level causes the Batch Execution Server to 
hold the execution of a phase when that phase fails. 

Operation 
Select Operation to set hold propagation at the operation level. 
 Setting hold propagation at the operation level causes the Batch 
Execution Server to execute a hold command when a phase fails. 
 The Batch Execution Server holds the operation that contains the 
phase that failed. 

Unit 
Select Unit to set hold propagation at the unit level.  Setting hold 
propagation at the unit level causes the Batch Execution Server to 
execute a hold command when a phase fails.  The Batch Execution 
Server holds the unit procedure that contains the phase that failed. 

Batch 
Select Batch to set hold propagation at the batch level.  Setting hold 
propagation at the batch level causes the Batch Execution Server to 
hold execution of the entire batch when a phase fails. 
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Command Acknowledgement 

The following table lists the Command Acknowledgement contents:  

Item Description 

Hold After Minutes Enter the number of minutes to wait for a command 
acknowledgement from the PLC before the batch is put in a holding 
state. 

Parameter Verify 

The following table lists the Parameter Verify contents:  

Item Description 

Hold After Minutes Enter the number of minutes to wait for parameter verification from 
the PLC before the batch is put in a holding state. 

Communications Timeout  

The following table lists the Communications Timeout contents:  

Item Description 

Period (msec) 
Enter the length of time, in milliseconds, between watchdog checks 
to ensure communications are established between the Batch 
Execution Server and the process hardware (OPC server). 

Valid Entries:  1000 to 120000 milliseconds.  The default is 60000. 

Allowable Failures 
The maximum number of communication failures allowed before 
Proficy Batch Execution determines that your process hardware is 
unavailable and breaks the connection. 

Valid Entries:  2 or greater.  The default is 10. 

Active Binding  

The following table lists the Active Binding contents:  
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Item Description 

By Unit Availability 
(default) 

Select this option if you want to allocate the units based on 
availability.  This is the default setting for Active Binding.  

By Unit Priority 
Select this option if you want to allocate the units based on the unit 
priority tags. 

Equipment Capacity  

The following table lists the Equipment Capacity contents:  

Item Description 

Enable Equipment 
Capacity 

Select this check box to enable equipment capacity for the 
project.  If enabled, during Active Binding, Proficy Batch 
Execution ensures that the unit capacity defined in the area 
model meets the minimum capacity requirement defined in the 
recipe's unit procedure. 

Recipe Scheduling  

The following table lists the Recipe Scheduling contents:  

Item Description 

Recipe Verification 
Required 

Select this option to confirm that a recipe is verified prior to 
scheduling and that the area model has not change since the recipe 
was last modified. 

Journaling  

The following table lists the Journaling contents:  

Item Description 

Enable Journaling Select this check box to enable the Server to write event data to a 
file in SQL format for the Batch Execution Archiver.  By default, 
journaling is disabled. 
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Item Description 

Discard Event Files 
After 

Enter the number of days after which to discard Event Journal 
(*.EVT) files. 

Send Heartbeat Every 
Enter the number of minutes that you want to wait before Proficy 
Batch Execution generates the heartbeat event again.  You can enter 
up to 1,440 minutes (1 day). 

IMPORTANT:  The heartbeat event messages get stored to the 
BATCH_SYSTEM_STATUS table in the database.  The lower the 
value that you enter in this field, the more values get stored to this 
table.  If you enter a low value, you will need to maintain this table to 
prevent it from growing too rapidly. 

   

Recipe Tab 

The Recipe tab in the Batch Execution Configuration dialog box displays the following items: 

Recipe Storage Type  

The following table lists Recipe Storage Type contents:  

Item Description 

File 
Select File to store all the recipes in the project to a file by default.  

SQL 
Select SQL to store all the recipes in the project to a relational 
database by default. 

ODBC Configuration  

The following table lists the ODBC Configuration contents:  
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Item Description 

DSN 
When storing recipes in SQL format, enter the ODBC data source 
name (DSN) to which the Batch Execution Server writes recipe data. 
 This data source name is defined in the ODBC Data Source 
Administrator program accessed from the Windows Control Panel.  

NOTE: This data source must be defined as a System DSN. 

User Name 
When storing recipes in SQL format, enter the login name needed to 
access the ODBC data source entered in the DSN field. 

Password 
When storing recipes in SQL format, enter the password needed to 
access the ODBC data source in the DSN field. 

Test Data Source 
Click to test the data source. 

Other Options  

The following table lists the Other Options contents:  

Item Description 

Parameter Precision Enter the number of decimal points to display for the low, high, 
and value numbers in the parameters spreadsheet of the Batch 
Execution Recipe Editor and the Tabular Recipe Editor. 

Allow Parallel 
Operation 

Select this option to allow operations within a unit procedure to run 
in parallel.   By default, this field is set to No to conform with 
S88.01 standards.   

Tabular Recipe Editor Group 

The following table lists the Tabular Recipe Editor Group contents:  
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Item Description 

Enable Phase 
Description 

Select this check box to allow the Phase Description tab to 
appear in the Edit Equipment Phase Class dialog box of the 
Batch Execution Equipment Editor. This check box is only 
applicable to users who create recipes in the Tabular Recipe 
Editor and want to be able to edit the descriptions of phase 
parameters.  

Archiver Tab 

The Archiver Tab in the Batch Execution Configuration dialog box displays the following items: 

Database Information Group 

The following table lists Database Information Group contents:  

Item Description 

Data Source Name Enter the name of the ODBC data source (DSN) to which the Batch 
Execution Archiver writes event journal data.  This data source 
name is defined in the ODBC Data Source Administrator program 
accessed from the Windows Control Panel.  

NOTE:  This data source must be defined as a System DSN. 

Database Connect String Displays the database connection string that Batch Execution 
Archiver uses to connect to the data source. 

Test Connection Click to test the connection. 

User Name Enter the user name to login to the data source. 

Password Enter the password to login to the data source. 

Logging Info Group 

The following table lists the Logging Info Group contents:  
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Item Description 

Enable Info Logging 
Select this option to provide information on system events in the 
BatchArchiver.log file for troubleshooting issues with the Batch 
Execution Archiver.   

It is not recommended that you enable Info Logging for daily 
operations in a production environment, because of the large 
number of messages that will be produced by the Batch Execution 
Archiver. 

Max. Log File Size Enter a maximum size, in bytes, for this file before it is overwritten. 
By default, the maximum file size is set to 1000000.   

Valid Entries:  1 to 999,999,999 

NOTE: If you enter a value lower than 10000, at run time the value is 
set to 10000. 

Event Filters Group 

The following table lists the Event Filters Group contents:  

Item Description 

Active Binding 
Select this check box to archive Active Binding information to the 
relational database. 

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Active Step Change Select this check box to archive the time when a recipe became 
active or inactive to the relational database. 

Batch Desc Select this check box to archive the operator description of the batch 
to the relational database. 

Comment Select this check box to archive operator comments to the relational 
database. 

File Name Select this check box to archive the Event (EVT) file name to the 
relational database. 
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Item Description 

Message Select this check box to archive operator messages to the relational 
database. 

Mode Change Select this check box to archive batch mode changes to the relational 
database. 

Mode Command Select this check box to archive requests to change the batch mode to 
the relational database. 

Owner Change Select this check box to archive messages that the ownership of the 
batch changed. 

Param Download Verify Select this check box to archive the names of phase parameters that 
successfully downloaded to the process hardware to the relational 
database. 

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Parm Dwnld Verify Fail Select this check box to archive the names of phase parameters that 
failed to download to the process hardware to the relational database.  

Permissive Msg Cancel Select this check box to archive phase logic requests to cancel a 
phase message to the relational database. 

Permissive Msg Received Select this check box to archive phase logic requests to receive a 
phase message to the relational database. 

Permissive Msg Sent Select this check box to archive phase logic requests to send a phase 
message to the relational database. 

Phase Logic Arbitration Select this check box to archive phase logic requests to acquire and 
release equipment to the relational database. 

Prompt Select this check box to archive operator prompts to the relational 
database.  

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Recipe Desc Select this check box to archive the description of the recipe as 
defined in the recipe header to the relational database. 
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Item Description 

Recipe Header Select this check box to archive the recipe name, version number, 
description, and author as defined in the recipe header to the 
relational database. 

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Recipe Value Select this check box to archive the current values of recipe 
parameters to the relational database. 

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Recipe Value Change Select this check box to archive the names of recipe parameters that 
changed to the relational database. If you plan to use the Plant 
Applications Batch Analysis product with Batch Execution, select 
this check box.   

Report Select this check box to archive report parameter values to the 
relational database.  

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Response Select this check box to archive operator responses to prompts to the 
relational database. 

Scale Factor Select this check box to archive the batch scale factor entered by the 
operator to the relational database. 

State Change Select this check box to archive the recipe steps that changed state to 
the relational database.  

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

State Command Select this check box to archive requests to change the state of the 
batch to the relational database. 

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

System Select this check box to archive informational messages generated 
by the batch during production to the relational database. 



 

132 

Item Description 

Step Activity Select this option if you want to track the status of a step.  

IMPORTANT: If you plan to use the Plant Applications Batch 
Analysis product with Batch Execution, select this check box. 

Initialization File 

Displays the name of the Batch Execution Archiver’s initialization file.  The default is: 
BATCHARCHIVER.INI. 

Archiver Table Format  

The following table lists the Archiver Table Format contents:  

Item Description 

3.0 Format 
Select this option to write data to the relational database using 
the VisualBatch version 3.0 data model.  This data model uses 
one table to store all batch event journal data.  It is 
recommended that you use the 4.0 table format. 

Recommended Select this option to write data to the relational database using the 
Batch Execution 4.0 and greater data model.  This data model uses 
several tables to store batch event journal data.  This is the 
recommended table format. 

Both Select this option to write data to the relational database using both 
version 3.0 and the recommended 4.0 and greater data models.   

   

Electronic Work Instruction (EWI) Tab 

The Electronic Work Instruction tab in the Batch Execution Configuration dialog box displays the 
following items: 

Electronic Work Instruction Configuration  

The following table lists Electronic Work Instruction Configuration contents:  
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Item Description 

Source Safe INI Path Enter the path where the SourceSafe configuration file is located. 
The EIB and Recipe Editors point to this path for SourceSafe project 
configuration. 

NOTE: If you are using a remote computer with a SourceSafe client 
installed, use UNC pathing. 

User Name Enter the user name to login to SourceSafe, so that the user can 
access EWI production files. 

Password Enter the password to login to SourceSafe, so that the user can 
access EWI production files. 

Database Information  

The following table lists the Database Information contents:  

Item Description 

Data Source Name Optionally, enter the name of the ODBC data source DSN for 
dynamic SQL IDOs. 

User Name Enter the user name to login to an ODBC data source DSN for 
dynamic SQL IDOs. 

Password Enter the password needed to access the ODBC data source listed in 
the Data Source Name field. 

Test Connection Click to test the communication to the database. 

Electronic Signature Tab 

The Electronic Signature Tab in the Batch Execution Configuration dialog box displays the following 
items: 

Enable Batch Execution Auditing 

Select this check box to enable auditing in the Proficy Batch Execution Configuration dialog box, the 
Recipe Editor, and the Equipment Editor. When you enable this option, Proficy Batch Execution 
records all user actions from the lists below in the audit log in the database, regardless of the signature 
requirements. Clear this check box to disable auditing. 
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ODBC Configuration Group 

The following table lists ODBC Configuration Group contents:  

Item Description 

DSN Enter the name of the DSN, or click the Browse (...) button next to 
this field to browse for a DSN. 

User Name Enter the user name for the DSN. 

Password Enter the password for the DSN. 

Test Connection Click to test the DSN communication. 

Batch Execution Configuration Group 

The following table lists the Batch Execution Configuration Group contents:  

Item Description 

Use Default Signature 
Requirements 

Select this check box to use the Default signature requirements in 
the Proficy Batch Execution Configuration. The electronic 
signature type that you select in the Default drop-down field gets 
applied when opening or saving changes from the Batch Execution 
Configuration dialog box.  The default types are:  None, Performed 
By, or Performed By/Verified By. 

Command The available command. 

Signature Requirements The signature requirements for the specified command: None, 
Performed By, or Performed By/Verified By. 

Performed By The Windows user group who can perform the action. 

Verified By The Windows user group who can verify the action. 

Recipe Editor Group 

The following table lists the Recipe Editor Group contents:  
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Item Description 

Use Default Signature 
Requirements 

Select this check box to use the Default signature requirements 
Proficy Batch Execution Recipe Editor. The electronic signature 
type that you select in the Default drop-down field gets applied to 
all user actions performed in the Proficy Batch Execution Recipe 
Editor.  The default types are:  None, Performed By, or Performed 
By/Verified By. 

Command The available command. 

Signature Requirements The signature requirements for the specified command: None, 
Performed By, or Performed By/Verified By. 

Performed By The Windows user group who can perform the action. 

Verified By The Windows user group who can verify the action. 

Equipment Editor Group 

The following table lists the Equipment Editor Group contents:  

Item Description 

Use Default Signature 
Requirements 

Select this check box to use the Default signature requirements in 
the Proficy Batch Execution Equipment Editor. The electronic 
signature type that you select in the Default drop-down field gets 
applied to all user actions performed in the Equipment Editor.  The 
default types are:  None, Performed By, or Performed By/Verified 
By. 

Command The available command. 

Signature Requirements The signature requirements for the specified command: None, 
Performed By, or Performed By/Verified By. 

Performed By The Windows user group who can perform the action. 

Verified By The Windows user group who can verify the action. 
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Restart Control Tab 

The Restart Control Tab in the Batch Execution Configuration dialog box displays the following items: 

Use the same restart option for all servers 

Select this check box so that the Batch Server, EIB Server, and Soft Phase Server all use the settings 
configured in the Batch Server Restart Control area. 

Batch Server Restart Control  

The following table lists Batch Server Restart Control contents:  

Item Description 

Cold Restart Select Cold to always restart the server in cold restart mode. 
 Selecting cold restart is best when you first start the server or after a 
controlled shutdown and restart of your process. For example, in the 
cold restart mode, the Batch Execution Server provides an empty 
batch list to the operators, forcing them to select the batches they 
want to schedule and run.  

Warm Restart Select Warm to always restart the server in warm restart mode. 
Selecting warm restart lets operators continue from the point where 
the batch left off. For example, typically, you warm restart the Batch 
Execution Server when a batch is interrupted unexpectedly, for 
example, after a power failure. In warm restart mode, the Batch 
Execution Server restores the batch list and the state of the server to 
its last known state. 

Prompt Select Prompt (the default setting) to prompt users to select the restart 
mode:  warm or cold. 

EWI Server Restart Control  

The following table lists EWI Server Restart Control contents:  

Item Description 

Cold Restart Select Cold to always restart the server in cold restart mode. 
 Selecting cold restart is best when you first start the server or after a 
controlled shutdown and restart of your process. For example, in the 
cold restart mode, the Batch Execution Server provides an empty 
batch list to the operators, forcing them to select the batches they 
want to schedule and run.  



System Configuration Manual 

137 

Item Description 

Warm Restart Select Warm to always restart the server in warm restart mode. 
Selecting warm restart lets operators continue from the point where 
the batch left off. For example, typically, you warm restart the Batch 
Execution Server when a batch is interrupted unexpectedly, for 
example, after a power failure. In warm restart mode, the Batch 
Execution Server restores the batch list and the state of the server to 
its last known state. 

Prompt Select Prompt (the default setting) to prompt users to select the restart 
mode:  warm or cold. 

SP Server Restart Control  

The following table lists SP Server Restart Control contents:  

Item Description 

Cold Restart Select Cold to always restart the server in cold restart mode. 
 Selecting cold restart is best when you first start the server or after a 
controlled shutdown and restart of your process. For example, in the 
cold restart mode, the Batch Execution Server provides an empty 
batch list to the operators, forcing them to select the batches they 
want to schedule and run.  

Warm Restart Select Warm to always restart the server in warm restart mode. 
Selecting warm restart lets operators continue from the point where 
the batch left off. For example, typically, you warm restart the Batch 
Execution Server when a batch is interrupted unexpectedly, for 
example, after a power failure. In warm restart mode, the Batch 
Execution Server restores the batch list and the state of the server to 
its last known state. 

Prompt Select Prompt (the default setting) to prompt users to select the restart 
mode:  warm or cold. 

Default Configurations  

The following table lists Default Configurations Control contents:  

Item Description 

Soft Phase Server Enter the fully qualified path of the configuration file that you want to 
load when starting up the Soft Phase Server. 
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Item Description 

Browse (...) button Click to browse for a configuration file that you want to load when 
starting up the Soft Phase Server. 

   

Campaign Manager Tab 

Database Information  

The following table lists the Database Information contents:  

Item Description 

Data Source Name Enter the data source name or click Browse to search for the data 
source name. 

User Name Enter the user name to login to the database you selected. 

Password Enter the password needed to access the database listed in the Data 
Source Name field. 

Test Connection Click to test the communication to the database. 

Datasources Dialog Box 
The Datasources dialog box displays the following items for each datasource in the list: 

Name 

The name of the data source. 

Driver 

The driver version associated wit the data source. 
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Enter New Project Name Dialog Box 
The Enter New Project Name dialog box displays the following item: 

Project Name 

Enter the name of the project you want to create. 

Insert Object Dialog Box 
The Insert Object dialog box displays the following items: 

Create New 

Select this option to insert a new OLE object, and then select the new object from the Object Type list. 

Create From File 

Select this option to insert an OLE object from a file. Enter the file name in the Fie field.  

Create Control 

Select this option to insert a new OLE object by browsing for an ActiveX control not displayed in the 
Object Type list. Click the Add Control button to browse for the new control.  

Object Type or File 

Select the type of object you want to add from the Object Type list box, or enter the file name into the 
edit box. 

Open Dialog Box 
The Open dialog box displays the following items: 

Look in 

Specifies the location where you want to locate a file or folder. Click the arrow to select another 
location, or click    on the toolbar to move up levels.  

The box below lists the items in the selected location. To open a file, in the Open dialog box, double-
click the name of the file you want to open. To save a file using an existing file name, in the Save 
dialog box, double-click the name of the file you want to save. 
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Shortcuts 

Provides shortcuts to places on your computer or the network from which you can open a file, such as 
the History folder, the desktop, or My Network Places. When you click a location, it will appear in 
Look in, and the files and folders in the selected location will be listed at the right. 

Location Area 

Lists the folders and files in the selected location.  

File Name 

Provides a space for you to type the name of the file you want to open or save. To quickly find a file 
you’ve previously opened, click the file name in the drop-down list, if available. 

If you are searching for a file, you can use asterisks (*) as wildcards. For example, you can type *.* to 
see a list of all files. You can also type the full path of a file, for example, C:\Mydocs\Letter.doc. 

If you are saving a file, you cannot use a question mark (?) or an asterisk in the file name. If you use a 
question mark or asterisk and click Save, the file will not be saved and the dialog box will not close.  

Files of type 

Lists the types of files to display. 

Project Configuration Dialog Box 
The Project Configuration dialog box displays the following items: 

Name 

Displays the path and file name of the project being created.    

Valid Entries:  Display only. 

Example:  C:\Program Files\Proficy\Proficy Batch Execution\Projects\DEMO.WKB 

Project Directories Group 

The following table lists the Project Directories Group contents:  

Item Description 

Recipe Displays the path that will be assigned to the recipes in this project.    

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\Demo\Recipes 
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Item Description 

Primary Journal Displays the primary path that the Batch Execution Server will use to 
store the batch journal when this project runs.     

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\Demo\Journals 

Secondary Journal Displays the backup path that the Batch Execution Server will use to store 
the batch journal when this project runs.  Typically, this is a network 
path.    

Example:  Z:\Program Files\Proficy\Proficy Batch 
Execution\Projects\Demo\Journals 

Error Logging Displays the path that will be assigned to all error logs associated with 
this project.    

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\LOGS 

Equipment Database Displays the path and file name of the area model associated with this 
project.    

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\Recipes\DEMO.CFG 

Primary Restart Path Displays the primary path in which the Batch Execution Server stores its 
work files during normal operations.  The Batch Execution Server uses 
these files on a warm restart.   

Example:  C:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\LOGS 

Secondary Restart 
Path 

Displays a backup path in which the Batch Execution Server stores its 
work files during normal operations.  The Batch Execution Server reads 
the files in this path on warm restart, if the primary path is unavailable. 
 Typically, this is a network path. 

Example:  Z:\Program Files\Proficy\Proficy Batch 
Execution\Projects\DEMO\LOGS 

EWI Local Directory Displays the local path to store the files that the system pulls from 
SourceSafe when using the EWI functionality.  
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How Do I... 
The following sections explain how to work with the Batch Execution WorkSpace: 

• Using the Batch Services Configuration Utility 

• Using the BatchDCOM Utility 

• Using the Batch Server Manager 

• Using the Soft Phase Server 

• Configuring a Project 

• Performing Basic Operations 

• Working with the Area Model 

• Working with Pictures 

• Working with Recipes 

• Working with Miscellaneous Documents 

• Managing a Project 

Using the Batch Services Configuration Utility 
The following sections explain how to configure your Batch system: 

• Using the Proficy Batch Execution Services Configuration utility 

• Adding a User to the DCOM Permissions list 

• Adding Batch applications to the Windows Firewall Exception list 

Using the Proficy Batch Execution Services Configuration Utility 

To use the Batch Execution Services Configuration utility: 

1. In Windows, log in as an Administrator. 

2. Make sure that the Batch Server and EIB Server are not running. 

3. Click the Start button, point to Programs, Proficy Batch Execution, and then Services 
Configuration. The Batch Execution Services Configuration Utility dialog box appears. 

4. If you do not want to run the Batch Execution Server and EIB Server as Windows services, 
select the Run as Regular Server button, and then skip to the last step. 

5. If you do want to run these applications as Windows services, select the Run as a Windows 
Service button. 

6. Optionally, if you want to start the Batch Server and EIB Server when Windows starts, select 
the Automatically Start Applications at System Boot check box. 
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7. Select one of the following options for the type of Windows account to use when starting 
these applications as Windows services: 

• Run under local system account – Select this option to run the Server and EIB 
Server as services under the local system account. This limits access to system 
resources. You cannot archive to a remote database or use UNC paths with this 
option enabled.  

• Run under this account– Select this option to configure the Batch Server and EIB 
Server to run as services under a specified user account. This allows access to 
network resources. Enter a specified Windows user name and password in the 
following fields. This user must already be configured as a Windows user account 
before you can add it here; you cannot create a new user by entering it here. If the 
user is on a domain, then you need to specify the domain and the user name. If you 
leave the default user settings during install, the account name that displays in this 
field is BatchExecutive and the password is batchrules.  

8. If you are using iFIX as your SCADA/HMI system and you are running the Batch Execution 
Server as a service, configure iFIX to run as a service using the Local Startup Definition 
dialog box in the System Configuration Utility. Refer to the "Running iFIX as a Service" 
section in the Getting Started with iFIX guide for steps. 

9. If your product key does not include WorkInstruction, you should manually disable the EIB 
Server from running as a service. To do this: 

a. On the Start menu, point to Programs, Administrative Tools, and then Services. The 
Services window appears. 

b. Double-click the GE Intelligent Platforms EIB Server to open the Properties dialog 
box. 

c. In the Startup Type drop-down list, select Manual and click OK. 

NOTE: If you do not configure the Manual option, you may encounter an error message 
when you automatically start your applications as services at system boot, or in the error log 
when starting as a local or specified user. 

10. Click OK. 

Adding a User to the DCOM Permissions List 

To add a user to the DCOM Permissions List: 

1. In Windows, log in as an Administrator. 

2. On the Start menu, point to Programs, Batch Execution, and then Services Configuration. 

- Or - 

In the Proficy Batch Execution\BIN folder, double-click the servicecfg.exe file. If you 
installed to the default locations, this file is located in the C:\Program Files\Proficy\Proficy 
Batch Execution\BIN folder. 

The Services Configuration utility appears. 

3. Click the DCOM tab. 
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4. In the Domain field, enter the domain for the user account you want to add, if this user 
belongs to a domain; otherwise, leave this field empty. 

5. In the User Name field, enter the Windows user name to be added to the DCOM permission 
list.  

6. Click OK. 

Adding Batch Applications to the Windows Firewall Exception List 

To add batch applications to the Windows Firewall Exception list: 

IMPORTANT: The Windows Firewall must be enabled to make these edits.  

1. In Windows, log in as an Administrator. 

2. On the Start menu, point to Programs, Batch Execution, and then Services Configuration. 

- Or - 

In the Proficy Batch Execution\BIN folder, double-click the servicecfg.exe file. If you 
installed to the default locations, this file is located in the C:\Program Files\Proficy\Proficy 
Batch Execution\BIN folder. 

The Services Configuration utility appears. 

3. Click the DCOM tab. 

4. In the Windows Firewall area, select the check boxes for the files  (BatchClient.exe, 
BatchServer.exe, or VBIS.exe) that you want to add to the Windows Firewall Exception list.  

NOTES:  

• If the Windows Firewall is disabled, the Windows Firewall area of this dialog box is 
unavailable. Enable the Windows Firewall to continue.  

• The BatchClient.exe is the only file that appears with a check box in Windows Vista.  

• After the file is added to the Firewall Exception list, you cannot remove it by clearing 
the check box. When you select a check box, you can re-add the item to the Exception 
List. 

5. Click OK. 

Using the BatchDCOM Utility 
The following sections explain how to use the BatchDCOM utility: 

• Importing DCOM Settings 

• Exporting DCOM Settings 

• Viewing DCOM Settings 
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Importing DCOM Settings 

To import your DCOM settings: 

1. At the command line, navigate to the \BIN folder. 

NOTE: If you installed to the default location this path is: C:\Program Files\Proficy\Proficy 
Batch Execution\BIN. 

2. Type the following command: 

batchdcom /i arg 

where arg represents the fully qualified file path that you want to import. For example: 

batchdcom /e c:\dcom\settings\dcomsettings.txt 

3. Press Enter. 

Exporting DCOM Settings 

To export your DCOM settings: 

1. At the command line, navigate to the \BIN folder. 

NOTE: If you installed to the default location this path is: C:\Program Files\Proficy\Proficy 
Batch Execution\BIN. 

2. Type the following command: 

batchdcom /e arg 

where arg represents the fully qualified file path that you want to export to. For example: 

batchdcom /e c:\dcom\settings\dcomsettings.txt 

3. Press Enter. 

Viewing DCOM Settings 

To view your DCOM settings: 

1. At the command line, navigate to the \BIN folder. 

NOTE: If you installed to the default location this path is: C:\Program Files\Proficy\Proficy 
Batch Execution\BIN. 

2. Type the following command: 

batchdcom /d | more 

NOTE: The "| more" is optional. This allows you to view only a screen full of information at 
any one time, if the text exceeds the length of the screen. 

3. Press Enter. 

If more than a screen full of information displays, press the Space bar to page down through 
the entries one screen at a time, or use the Enter key to scroll through one line at a time. 
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Using the Batch Server Manager 
The following sections explain how to work with the Batch Server Manager: 

• Using the Batch Server 

• Setting Up Batch Server Communications 

Using the Batch Server 

Using the Batch Server 

For information on completing basic tasks in the Batch Server Manager, refer to the following 
sections: 

• Starting the Batch Execution Server 

• Selecting a Method for Starting the Server Manager 

• Starting the Batch Execution Server from the iFIX Task List 

Starting the Batch Execution Server 

To start the Batch Execution Server: 

1. Click the Start button, point to Programs, Proficy Batch Execution, and then Server Manager. 
The Batch Server Manager dialog box appears. 

2. On the Server tab, click the Start Server button.  

If the Prompt option is selected from the Server tab in the Batch Execution Configuration 
dialog box, the Choose Boot Method dialog box appears. If either Cold Restart or Warm 
Restart is selected from the Server tab in the Batch Execution Configuration dialog box, the 
Server starts. 

3. If prompted, select a boot method:  

• Warm – to return the Batch Server to its last known state. Control recipes, manually 
controlled phases, and arbitration functions are returned to the state that existed prior 
to the termination of the server. Only use the warm boot method to recover batches 
and data after an unexpected loss of the Batch Execution Server. 

• Cold – to start the Batch Execution Server with an empty batch list and with no 
resources allocated to the operator. This is the preferred method of starting the Batch 
Execution Server. 

• Cancel – to terminate the start of the Server.  
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Selecting the Method of Booting the Server 

To boot the Batch Execution Server: 

Click one of the following buttons: 

• Warm – to return the Batch Server to its last known state. Control recipes, manually 
controlled phases, and arbitration functions are returned to the state that existed prior 
to the termination of the server. Only use the warm boot method to recover batches 
and data after an unexpected loss of the Batch Execution Server. 

• Cold – to start the Batch Execution Server with an empty batch list and with no 
resources allocated to the operator. This is the preferred method of starting the Batch 
Execution Server. 

• Cancel – to terminate the start of the Server.  

Starting the Batch Execution Server from the iFIX Task List 

To start the Batch Execution Server from the iFIX task list: 

1. In the Proficy Batch Execution WorkSpace, open a project. 

2. From the Proficy Batch Execution WorkSpace browser, double-click the Batch Execution 
Configuration icon. The Batch Execution Configuration dialog box appears. 

3. Click the Server tab. 

4. Select Cold or Warm Restart. 

5. Click OK. 

NOTE: You cannot use Prompt Restart if you want to start the Batch Execution Server from 
the iFIX task list. 

6. Launch the iFIX SCU. 

7. In the SCU, on the Configure menu, click Tasks. The Task Configuration dialog box appears. 

NOTE: Refer to the iFIX Electronic books for more information on the Task Configuration 
dialog box. 

8. In the Filename field, enter the path of BatchServerManager.exe. For example: K:\Program 
Files\Proficy\Proficy C:\Program Files\Proficy\Proficy Batch 
Execution\BIN\BatchServerManager.exe. 

9. In the Command Line field, enter /start. 

10. Click Add. 

11. Save and close the SCU. 

12. Start iFIX. 
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Setting Up Batch Server Communications 

For more information on server communications in the Batch Server Manager, refer to the following 
sections: 

• Setting up Network Communications Between the Proficy Batch Execution Client and Server 

• Setting up ActiveX Controls to Communicate with the Batch Execution Server 

• Setting up the Batch Execution Server to Run as a Service 

Setting up Network Communications Between the Proficy Batch Execution Client and 
Server 

To set up network communications between the Proficy Batch Execution Client and 
Server: 

1. Click the Start button, point to Programs, Proficy Batch Execution, and then Client. The 
Batch Client application appears. 

2. In the Batch Client on the toolbar, click the System Configuration and Defaults button. 

3. Select the General tab. 

4. In the Communications area, select the Remote Server check box and enter the computer 
name of the Batch Execution Server. 

Setting up ActiveX Controls to Communicate with the Batch Execution Server 

To set up ActiveX controls to communicate with the Batch Execution Server: 

1. Right-click the ActiveX control and select Properties to view the ActiveX control's properties. 

2. Click the VBIS Server tab. 

3. On the Server tab, if the VBIS Server is remote, enter the computer name on which the VBIS 
Server is running in the Remote Machine Name field. If the VBIS Server is running on the 
same machine as the ActiveX control, leave the field blank. 

Setting up the Batch Execution Server to Run as a Service 

To set up the Batch Execution Server to run as a service: 

1. Click the Start button, point to Programs, Proficy Batch Execution, and then Services 
Configuration Utility. The Services Configuration Utility appears. 

2. Select one of the three configuration options: Regular Server, Local System Account, or 
BatchExecutive Account. 

3. Click OK.  

4. Acknowledge the prompt. 
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Using the Soft Phase Server 
The following sections explain how to work with the Soft Phase Server: 

• Starting the Soft Phase Server 

• Configuring Run Modes 

• Setting up the Watchdog 

• Working with the Soft Phase Server 

• Configuring Requests for a Phase 

Starting the Soft Phase Server 

For information on starting the Soft Phase Server, refer to the following sections: 

• Starting the Soft Phase Server 

• Selecting a method for starting the Soft Phase Server 

• Starting the Proficy Soft Phase Server from the iFIX Task List 

Starting the Soft Phase Server 

To start the Soft Phase Server: 

1. Click the Start button, and point to Programs, Proficy Batch Execution, and then click Server 
Manager. The Batch Server Manager application appears, which allows you to start the Soft 
Phase Server along with the Batch Server. 

2. Click Start Server. This action initiates the Batch Server and the Soft Phase Server. 

The Choose Boot Method dialog box appears, if you configured the Prompt for the Restart 
Control. 

3. For each Choose Boot Method dialog that appears, click a button to select a boot method:  

• Warm – to return the server to its last known state. Only use the warm boot method 
to recover data after an unexpected loss of the server. 

• Cold – to start the server. This is the preferred method of starting the server. You 
would also select the cold boot option to start after a controlled shutdown and restart 
of your process. 

• Cancel – to terminate the start of the Server.  

Selecting a Method for Starting the Soft Phase Server 

To boot the Proficy Soft Phase Server: 

Click one of the following buttons from the Choose Boot Method dialog box: 

Warm – to return the Soft Phase Server to its last known state. Only use the warm boot method to 
recover data after an unexpected loss of the Soft Phase Server. 
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Cold – to start the Soft Phase Server. This is the preferred method of starting the Soft Phase 
Server. You would also select the cold boot option to start after a controlled shutdown and 
restart of your process. 

Cancel – to terminate the start of the Server.  

Starting the Batch Execution Server from the iFIX Task List 

To start the Batch Execution Server from the iFIX task list: 

1. In the Proficy Batch Execution WorkSpace, open a project. 

2. From the Proficy Batch Execution WorkSpace browser, double-click the Batch Execution 
Configuration icon. The Batch Execution Configuration dialog box appears. 

3. Click the Server tab. 

4. Select Cold or Warm Restart. 

5. Click OK. 

NOTE: You cannot use Prompt Restart if you want to start the Batch Execution Server from 
the iFIX task list. 

6. Launch the iFIX SCU. 

7. In the SCU, on the Configure menu, click Tasks. The Task Configuration dialog box appears. 

NOTE: Refer to the iFIX Electronic books for more information on the Task Configuration 
dialog box. 

8. In the Filename field, enter the path of BatchServerManager.exe. For example: K:\Program 
Files\Proficy\Proficy C:\Program Files\Proficy\Proficy Batch 
Execution\BIN\BatchServerManager.exe. 

9. In the Command Line field, enter /start. 

10. Click Add. 

11. Save and close the SCU. 

12. Start iFIX. 

Configuring Run Modes 

For information on configuring run modes in the Soft Phase Server, refer to the following sections: 

• Understanding the Soft Phase Server Modes 

• Running in Simulation Mode 

• Running in Partial Simulation Mode 

• Running in Soft Phase Mode 
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Understanding Soft Phase Server Modes 

To use the Soft Phase Server Modes: 

1. Start the Soft Phase Server. 

2. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

3. Select an option: 

• OPC Simulator Mode – simulation of both the PLI and phase logic. 

• Partial Simulation Mode – simulation of the PLI and most of the phase logic 
(handling requests and updating the step index register).  

• Soft Phase Mode – simulation of only the PLI. 

Clearing the Request Register when a batch is in a Held State 

To run in Simulation Mode: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select the Manual Configuration check box. 

3. Select the Continuous Phase check box, if applicable. 

4. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state.  

Clear this check box if you want these prompts to continue to be processed when the batch is 
put into a Holding state.  

5. Click Update Phase. 

6. Click Close to exit the Phase Configuration dialog box. 

7. On the File menu, click Save As. The Save As dialog box appears. 

8. Enter a name and click Save. 

Running in Partial Simulation Mode 

To run in Partial Simulation Mode: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select an equipment phase from the drop-down list. 

3. Select the Soft Phase check box.  

4. Select the Manual Configuration check box.  

The Continuous check box is unavailable since this setting is irrelevant for soft phases. 
Requests and step index register updates are performed automatically.  

5. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state. 
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Clear this check box if you want these prompts to continue to be processed when the batch is 
put into a Holding state. 

6. Click Update Phase. 

7. Click Close to exit the Phase Configuration dialog box. 

8. On the File menu, click Save As. The Save As dialog box appears. 

9. Enter a name and click Save. 

Running in Soft Phase Mode 

To run in Soft Phase Mode: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select an equipment phase from the drop-down list. 

3. Select the Soft Phase check box. 

Do not check the Manual Configuration check box. When the check box is cleared, the Soft 
Phase Server ignores requests in the Phase Configuration dialog box and does not update the 
step index.  

NOTE: It is the responsibility of soft phase logic to programmatically handle requests and 
updates to step index register.  

4. Leave the Clear Requests check box selected (the default) if you want the PLI to clear all 
pending requests when a batch moves from the Running to Holding state. 

Clear this check box if you want these prompts to continue to be processed when the batch is 
put into a Holding state. 

5. Click Update Phase. 

6. Click Close to exit the Phase Configuration dialog box. 

7. On the File menu, click Save As. The Save As dialog box appears. 

8. Enter a name and click Save. 

Setting up the Watchdog 

Setting up the Watchdog 

For information on setting up the watchdog in the Soft Phase Server, refer to the following sections: 

• Defining the time-out setting 

• Disabling the Watchdog 

• Enabling the Watchdog 
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Defining the Time-out Setting 

To define the time-out setting for the Soft Phase Server: 

1. Make sure that the Watch Dog is enabled. 

If it is enabled, the Enable option is unavailable from the Watchdog menu in the Soft Phase 
Server. If it is not enabled, select Enable from the Watchdog menu. 

2. On the Watchdog menu, click BatchServer Status Timeout. The Batch Server Status Timeout 
Setting dialog box appears. 

3. Enter the time-out, in seconds. 

By default the time-out value is set to 60 seconds. You can change this setting to any value 
between 60 seconds and 1,000,000 seconds.  

4. Click OK. 

Every time you change the time-out value and click OK, the new value gets stored in the 
Registry.  

5. On the File menu, click Save As. The Save As dialog box appears. 

6. Enter a name and click Save. 

Enabling the Watchdog 

To enable the Watchdog for the Soft Phase Server: 

1. In the Soft Phase Server, on the Watchdog menu, click Enable. 

2. On the File menu, click Save As. The Save As dialog box appears. 

3. Enter a name and click Save. 

Disabling the Watchdog 

To disable the Watchdog for the Soft Phase Server: 

1. In the Soft Phase Server, on the Watchdog menu, click Disable. 

2. On the File menu, click Save As. 

3. Enter a name and click Save. 

Working with the Soft Phase Server 

For information on working with the Soft Phase Server, refer to the following sections: 

• Manually configuring phases 

• Updating Report Parameter Tags for a Phase 

• Updating unit tags 
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Manually Configuring a Phase 

To manually configure a phase when in simulated mode: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select an equipment phase from the drop-down list. 

3. Select the Manual Configuration check box. 

4. Select a state from the drop-down list in the Select State group box. 

5. Configure the requests for the phase. 

6. Enter a dwell time for all active states. The dwell time is the length of time a phase maintains 
a specific state. 

7. Click Update Phase. 

8. Repeat steps 2-7 for each state that you want to configure. 

9. Click Close to exit the Phase Configuration dialog box. 

10. On the File menu, click Save As. The Save As dialog box appears. 

11. Enter a name and click Save. 

Updating Reporting Parameter Tags for a Phase 

To update the report parameter tags for a phase: 

1. In the Soft Phase Server, on the Edit menu, click Phase Status. The Phase Status dialog box 
opens. 

2. Select a phase from the drop-down list. 

3. Select Report Parameter Tags from the drop-down list. 

4. Enter your changes. 

5. Click the Update Report Data button. 

Updating Unit Tags 

To update unit tags: 

1. In the Soft Phase Server, on the Edit menu, click Unit Tag Status. The Unit Tag Status dialog 
box opens. 

2. If you want you manually want to update unit tag values, select the Manual Update check 
box. 

3. Enter the new value for each unit tag that you want to change. 

4. Click Update values. 

5. Click Close. The settings associated with this dialog box get updated after you close the 
dialog box. 
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Configuring Requests for a Phase 

For information on configuring requests for a phase in the Soft Phase Server, refer to the following 
sections: 

• Clearing Requests when a Batch Moves from a Running to a Holding State 

• Continuing to Process Requests when a Batch Moves from a Running to a Holding State 

Clearing the Request Register when a batch is in a Held State 

To clear all requests for a phase when a batch moves from a Running to a Holding State: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select an equipment phase from the drop-down list. 

3. Select the Clear Requests check box. When this flag is set, the PLI clears all pending requests 
when a batch moves from the Running to Holding state. 

4. Click Update Phase. 

5. Click Close to exit the Phase Configuration dialog box. 

6. On the File menu, click Save. 

Making Prompts Available when a Batch is in a Held State 

To continue to process requests from a phase when a batch moves from a Running to a 
Holding State: 

1. In the Soft Phase Server, on the Edit menu, click Phase Configuration. The Phase 
Configuration dialog box appears. 

2. Select an equipment phase from the drop-down list. 

3. Clear the Clear Requests check box. 

4. Click Update Phase. 

5. Click Close to exit the Phase Configuration dialog box. 

6. On the File menu, click Save. 

Configuring a Project 
For information on configuring a project in the WorkSpace, refer to the following sections: 

• Overview: Creating a Project 

• Configuring the Project's Server Settings 

• Setting up the Archiver for Active Journaling 

• Starting and Configuring the iFIX SCU 

• Starting the iFIX Security Configuration Program 
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• Defining a Data Source to Store Recipes 

• Configuring iFIX as your HMI 

• Configuring Source Safe and DSN information for EWIs 

• Defining Electronic Signature Requirements 

Overview: Creating a Project 

To create a batch project in the Batch WorkSpace: 

1. Start your iFIX software and the Proficy Batch Execution WorkSpace. Be sure to enter any 
required electronic signatures. 

2. In the Batch WorkSpace, on the File menu, click New Project or select the New Project 
button from the Proficy Batch Execution WorkSpace dialog box. The Proficy Batch 
Execution WorkSpace prompts you for a project name. 

3. Enter the name you want and click OK. The Project Configuration dialog box appears with 
the default paths and area model name supplied for the new project. 

4. To accept the paths and the area model name as shown, click the Finish button and proceed to 
step 7. 

5. To change the defaults, click the Advanced button. The Batch Execution Configuration dialog 
box appears. 

6. Edit the paths and equipment database name in the Project tab. Make sure that the .cfg file 
name and path that you enter in the Equipment Database field is correct, because this is the 
only time you can edit this field; you will not be able to modify this field later. When you 
finish, click OK to return to the Project Configuration dialog box. 

NOTE: If the paths you specify do not exist, the Proficy Batch Execution WorkSpace prompts 
you to create them. Click Yes to create the paths. 

7. If any electronic signatures are required, enter them. 

The Proficy Batch Execution WorkSpace creates an empty hierarchy of folders and then adds 
an empty area model, default configuration files, and any pictures residing in your Pictures 
directory to the project. 

8. In the Batch WorkSpace, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

9. Enter the required information on each of the tabs. For more information, refer to the 
Overview: Completing the Server Tab section. 

10. Configure the area model.  

11. Create the project’s recipes.  

12. Create the project’s pictures.  
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To create a batch project in the iFIX WorkSpace: 

1. Start your iFIX software and open the Proficy iFIX WorkSpace. Be sure to enter any required 
electronic signatures. 

2. In the iFIX WorkSpace tree, double-click the Batch Execution Configuration item. The Batch 
Execution Configuration dialog box appears. 

3. In the Project tab, click the Create Project button to create a new project. The Project Name 
dialog box appears. 

4. Enter the project name you want and click OK. The default paths and area model name are 
supplied for the new project in the Project tab. 

5. If necessary, change the project directory paths. 

6. Enter any required electronic signatures. The Proficy iFIX WorkSpace creates an empty 
hierarchy of folders and then adds an empty area model, default configuration files, and any 
iFIX pictures residing in your Pictures directory to the project. 

7. In the iFIX WorkSpace tree, double-click the Batch Execution Configuration item to display 
the Batch Execution Configuration dialog box again. 

8. Enter the required information on each of the tabs. For more information, refer to the 
Overview: Completing the Server Tab section. 

9. Configure the area model.  

10. Create the project’s recipes.  

11. Create the project’s pictures.  

Configuring the Project's Server Settings 

Configuring the Project's Server Settings 

For information on configuring the project's server settings in the WorkSpace, refer to the following 
sections: 

• Overview: Completing the Server Tab 

• Defining Project Paths 

• Defining UNC Project Paths 

• Modifying Project Paths 

• Selecting a Restart Mode 

• Defining the Warm Restart Paths 

• Selecting the Hold Propagation 

• Defining the File and Disk Settings 

• Defining a Batch Execution Server's Network Settings 

• Enabling or Disabling Equipment Capacity 

• Configuring the Restart Control Options 
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Overview: Completing the Server Tab 

To complete the Server tab: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Click the Server tab. 

3. In the Logging area, define the file and disk settings of the Batch Execution Server.  

4. Optionally, if you want to provide information on system events in the Vbexec.log file for 
troubleshooting issues with the Batch Execution Server, select the Enable Info Logging check 
box. 

IMPORTANT: It is not recommended that you enable Info Logging for daily operations in a 
production environment, because of the large number of messages that will be produced by 
the server.  

5. In the Hold Propagation area, select the hold propagation for the Batch Execution Server.  

6. In the Communications Timeout area, set up the Batch Execution Server’s communication 
timeout settings.  

7. In the Active Binding area, select the active binding options.  

8. In the Equipment Capacity area, enable or disable equipment capacity.  

9. Optionally, in the Recipe Scheduling area, select the verification options required before 
scheduling a recipe. 

If the Recipe Verification Required option is selected, a recipe must is verified before it 
scheduled.  

If the Area Model Verification Required option is selected, the area model is checked for 
changes before a recipe is scheduled. 

10. Optionally, in the Journaling area, select the Enable Journaling check box to enable this 
option. 

11. In the Discard Event Files After … Days drop-down list, enter the number of days to wait 
before discarding Event Journal (*.EVT) files. 

12. In the Send Heartbeat Every … Minutes drop-down list, enter the number of minutes that you 
want to wait before Proficy Batch Execution generates the heartbeat event again. You can 
enter up to 1,440 minutes (1 day). Enter 0 to disable this feature. 

IMPORTANT: The heartbeat event messages are stored to the BATCH_SYSTEM_STATUS 
table in the database. The lower the value you enter in this field, the more values get stored to 
this table. If you enter a low value, you will need to maintain this table to prevent it from 
growing too rapidly. 

10. Click OK to save your changes. 
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Defining Project Paths 

To define the project paths in the Batch WorkSpace: 

1. In the Batch WorkSpace, on the File menu, click New Project. The Enter New Project dialog 
box appears. 

2. Enter the project name you want and click OK. The Project Configuration dialog box appears 
with the default paths and area model name supplied for the new project. 

3. To accept the default paths and the area model name, click the Finish button.  

To change the defaults, click the Advanced button and enter the paths and area model name 
you want when the Batch Execution Configuration dialog box appears. 

4. If the paths you specify do not exist, the Proficy Batch Execution WorkSpace prompts you to 
create them. Click the Yes button to create the paths and the new project. 

NOTE: You can use UNC paths or you can specify a network drive in any of the project 
paths. For more information, refer to the Defining UNC Project Paths section. 

5. Enter any electronic signatures that Proficy Batch Execution requests. 

To define the project paths in the iFIX WorkSpace: 

1. In the iFIX WorkSpace system tree, double-click the Batch Execution Configuration item. 
The Batch Execution Configuration dialog box appears. 

2. Select the Project tab. 

3. Click the Create New Project button. You may be prompted to save all changes to the current 
project. 

4. Enter the project name you want and click OK. The default directories are setup in the Project 
Directories area. 

5. Click OK. 

6. Enter any electronic signatures that Proficy Batch Execution requests. 

You will be prompted to exit and restart the WorkSpace in order for the new settings to take 
effect.  

Defining UNC Project Paths 

To define UNC project paths: 

1. On the machine that contains the project files (the Batch Execution Server), share the project 
directory. 

For example, to share the DEMO project, you would share the DEMO directory in 
C:\Program Files\Proficy\Proficy Batch Execution\Projects\DEMO. If you want to share all 
projects in the project directory, you would share the PROJECTS directory in C:\Program 
Files\Proficy\Proficy Batch Execution\Projects. 

2. When defining the Share, assign Full Control permissions to the shared directory. To prevent 
unauthorized access to the shared directory, add specific users or a group of users to the 
permissions list. 
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3. On the machine that needs to access the project files remotely, enter the UNC paths for the 
project directories.  

The UNC syntax for project directories is: 

\\machinename\sharename\path\filename 

For example: 

\\SERVERNAME\c$\Program Files\Proficy\Proficy Batch 
Execution\Projects\PROJECTNAME\Recipes 

\\SERVERNAME\c$\Program Files\Proficy\Proficy Batch 
Execution\Projects\PROJECTNAME\Journals 

\\SERVERNAME\c$\Program Files\Proficy\Proficy Batch 
Execution\Projects\PROJECTNAME\Logs  

Modifying Project Paths 

To modify the project paths: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Project tab. 

3. Edit the project paths as needed and click OK. 

If the paths you specify do not exist, the Proficy Batch Execution WorkSpace prompts you to 
create them. Click Yes to create the paths and the new project. The new project paths take 
effect after you close and re-open the project. 

The Proficy iFIX WorkSpace creates the paths automatically. 

NOTES:  

• You can use UNC paths or you can specify a network drive in any of the project paths. 
For more information, refer to the Defining Project Paths section. 

• You cannot modify the Equipment Database project path after initial installation. If 
you need to modify the Equipment Database project path, refer to Modifying 
Equipment Database Project Paths. 

Modifying Equipment Database Project Paths 

To modify the equipment database project path: 

CAUTION: The following procedure must be performed when the Batch Server is shutdown. In 
addition, all running batches must run to completion.  

1. Save a copy of your Projects folder, including the *.WKB and *.WK^ files, to a new location.  

2. Under the project folder, delete the *.WKB and *.WK^ files. 

3. In the Batch WorkSpace, on the File menu, click New Project or select the New Project 
button from the Proficy Batch Execution WorkSpace dialog box. The Proficy Batch 
Execution WorkSpace prompts you for a project name. 

4. Specify the name of your existing project as the new project name and click OK. The Project 
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Configuration dialog box appears with the default paths and area model name supplied for the 
project. 

5. Click Advance. The Batch Execution Configuration dialog box appears. 

6. Enter the desired Equipment Database path and click OK. 

7. Verify that all of the values on each of the tabs on the Batch Execution Configuration dialog 
box are correct. 

8. On the File menu, click Save Project to save your changes. 

Selecting a Restart Mode 

To select the restart modes: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Restart Control tab. 

3. Select the restart options that you want to use and click OK. 

NOTE: If you want to use the same restart options for all servers (Batch Execution Server, 
Soft Phase Server, and EIB (EWI) Server), select the Use the same restart option for all the 
servers check box. 

Defining the Warm Restart Paths 

To define warm restart paths: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Project tab. 

3. In the Primary Path field, enter the primary path to use when the Batch Execution Server 
performs a warm restart. 

4. In the Secondary field, enter the secondary path to use when the Batch Execution Server 
performs a warm restart. Typically, this is a network path. 

Selecting the Hold Propagation 

To select the hold propagation for a Batch Execution Server: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Server tab. 

3. In the Hold Propagation group box, select the type of hold propagation you want. 
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Defining the File and Disk Settings 

To define the file and disk settings of the Batch Execution Server: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Server tab. 

3. In the Max. Log File Size field, enter the maximum size of the error log file. 

4. In the Minimum Disk Space field, enter the minimum allowed free disk space. 

Defining a Batch Execution Server's Network Settings 

To set up a Batch Execution Server’s network settings: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Click the Server tab. 

3. In the Communications Timeout area, in the Period field, specify the wait time for the 
watchdog register. 

4. In the Allowable Failures field, enter the maximum number of failures that can occur before 
the Batch Execution Server assumes communications are bad. 

Enabling or Disabling Equipment Capacity 

To enable or disable equipment capacity: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Server tab. 

3. Select the Enable Equipment Capacity check box to enable equipment capacity for this 
project.  

When this is enabled, Proficy Batch Execution checks the unit capacity as part of its unit 
selection criteria during Active Binding. When this is disabled, Proficy Batch Execution does 
not check the unit capacity during Active Binding. 

NOTE: Equipment capacity is disabled by default for new projects and projects that were 
upgraded from VisualBatch v3.0. 

Configuring the Restart Control Options 

To complete the Restart Control tab: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Click the Restart Control tab. 

3. If all the restart control options are the same for all servers (Batch Execution Server, Soft 



System Configuration Manual 

163 

Phase Server, and EIB Server), select the Use the same restart option for all the servers check 
box. Otherwise, select the restart options that you want to use. 

4. In the Soft Phase Server field, enter the fully qualified path of the configuration file that you 
want to load when starting up the Soft Phase Server, if you are using that server. 

5. Click OK. 

Setting up the Archiver for Active Journaling 

To set up the Batch Execution Archiver for Active Journaling: 

1. In the Batch WorkSpace, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Archiver tab. 

3. In the Data Source Name field, enter the Archiver’s data source name (DSN), along with the 
user name and password. 

NOTE: This data source must be defined as a System DSN in the ODBC Data Source 
Administrator program accessed from the Windows Control Panel. 

4. In the Logging Info area, select the Enable Info Logging check box to provide information on 
system events in the BatchArchiver.log file for troubleshooting issues with the Batch 
Execution Archiver. If you want to change the default size of this file, in the Max Log File 
field, enter a maximum size for this file before it is overwritten. 

NOTE: It is not recommended that you enable Info Logging for daily operations in a 
production environment, because of the large number of messages that will be produced by 
the Batch Execution Archiver. 

5. In the Event Filters area, select the filters you want to use from the Event filters group box. 
Selecting a filter adds this information to the relational database. 

6. In the Archiver Table Format area, choose the format that you want the Batch Execution 
Archiver to use when it writes the batch event data to the relational database. 

7. Select the Server tab. 

8. In the Journaling area, select the Enable Journaling check box. 

9. In the Discard Event Files After … Days drop-down list, enter the number of days to wait 
before discarding Event Journal (*.EVT) files. 

10. In the Send Heartbeat Every … Minutes drop-down list, enter the number of minutes that you 
want to wait before Proficy Batch Execution generates the heartbeat event again. You can 
enter up to 1,440 minutes (1 day). Enter 0 to disable this feature. 

IMPORTANT: The heartbeat event messages are stored to the BATCH_SYSTEM_STATUS 
table in the database. The lower the value you enter in this field, the more values get stored to 
this table. If you enter a low value, you will need to maintain this table to prevent it from 
growing too rapidly. 

11. Click OK to save your changes. 
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Starting and Configuring the iFIX SCU 

To start and configure the iFIX SCU from a Proficy Batch Execution node: 

1. If you are using the Proficy Batch Execution WorkSpace, double-click the Configuration 
folder in the browser to open it. If you are using the Proficy iFIX WorkSpace, skip to step 2. 

2. Double-click the System Configuration project item to start the iFIX SCU. 

3. On the Configure menu, click Local Startup. The Local Startup dialog box appears. 

4. Enter the complete path to your .SCU file in the Configuration File field. 

5. On the Configure menu, click Tasks. The Task Configuration dialog box appears. 

6. Add the Batch Execution Server application and iFIX to the list of applications your iFIX 
software automatically starts. 

7. Save the current SCU settings. 

Starting the Security Configuration Program 

To start the iFIX Security Configuration program from a Proficy Batch Execution node: 

1. Make sure your iFIX software is running. 

2. If you are using the Proficy Batch Execution WorkSpace, double-click the Configuration 
folder in the browser to open it. If you are using the Proficy iFIX WorkSpace, skip to step 3. 

3. Double-click the Security Configuration project item to start the Security Configuration program. 

Defining a Data Source to Store Recipes 

To define a data source to store recipes: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Recipe tab. 

3. Select the SQL option to save recipes to a relational database by default. If you want to save 
recipes to a local file by default, select the File option instead. 

If you have selected SQL-type storage, you must complete the following ODBC information. 

4. In the DSN field, enter the data source name. 

NOTE: This data source must be defined as a System DSN in the ODBC Data Source 
Administrator program accessed from the Windows Control Panel. 

5. In the Username field, enter the login name you want to use. 

6. In the Password field, enter the password associated with the login name. 

NOTE: If you did not define a password in MS Access, Proficy Batch Execution still requires 
that you enter a password in the Password field. In this case, you can enter any password 
here (for example, PASSWORD). Otherwise, storing and retrieving recipes in an Access 
database will fail. 
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Configuring iFIX as your HMI 

To configure iFIX as your HMI: 

1. On the Batch Client computer, start the Proficy Batch Execution Client application. 

2. Click the Configuration and Default button. A tabbed dialog box appears. 

3. Select the General tab. 

4. In the .EXE Path field, enter the full path name of your HMI executable. For example: 

path\workspace.exe 

5. Enter the following text in the Window Title field: 

WorkSpace 

6. In the Toolbar Bitmap field, enter the name and full path of a bitmap for the HMI button on 
the toolbar. 

7. Click OK. 

Configuring Source Safe and DSN information for EWIs 

To configure the SourceSafe and DSN database information for EWIs: 

1. In the Batch WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Electronic Work Instruction (EWI) tab. 

3. Enter the path where the SourceSafe configuration file is located and the name of the 
SourceSafe .INI file. The Proficy Batch Execution Recipe Editor points to this path for 
SourceSafe project configuration. 

4. Enter the user name and password to login to SourceSafe, so that the user can access EWI 
production files. 

5. Optionally, in the DSN field, enter the name of the ODBC data source DSN for dynamic SQL 
IDOs. 

6. In the DSN User Name field, enter the login name you want to use. 

7. In the Password field, enter the password associated with the DSN login name. 

Defining Electronic Signature Requirements 

To define electronic signature requirements: 

IMPORTANT: You must add a user to the iESigAdministrators in Windows and create the 
DSN for the audit log database before Proficy Batch Execution allows you to save any of the 
settings that you define from this dialog box. 

1. In the Batch WorkSpace tree, in Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

2. Select the Electronic Signature tab. 
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3. Select the Enable Auditing check box. 

4. Enter a DSN, user name, and password. 

5. Select the required signature requirements for the Batch Execution Configuration dialog box. 

6. Select the required signature requirements for the Recipe Editor. 

7. Select the required signature requirements for the Equipment Editor. 

NOTE: If you want to assign the same requirements to each action, use the Default drop-
down field for the specified editor. Otherwise, select a signature type from the drop-down list 
for each command. Right-click the Performed By or Verified By field to browse the Windows 
Security Groups. 

8. Click OK. If you configured a signature requirement for the Save command in the Batch 
Execution Configuration, the Performed By dialog box appears. 

9. Enter the required electronic signatures. 

Performing Basic Operations 
For information on basic operations in the WorkSpace, refer to the following sections: 

• Opening and Closing a Folder 

• Opening a Project 

• Closing a Project 

• Saving a Project 

Opening and Closing a Folder 

To open a folder in the Batch WorkSpace tree: 

Double-click a closed folder or click the plus (+) button next to the folder to open it. 

To close a folder in the Batch WorkSpace tree: 

Double-click an open folder or click the minus (-) button next to the folder to close it. 

Opening a Project 

To open a project in the Batch WorkSpace: 

1. In the Batch WorkSpace, on the File menu, click Open Project, or select the Open Project 
button from the toolbar. The Open dialog box appears. 

2. Select the project you want to open, and click Open. 

3. Enter any electronic signatures, if required: 

• If a Performed By electronic signature is required for the open command, a dialog 
appears requesting the appropriate signature.  
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• If a Verified By electronic signature is required, a second dialog appears requesting 
the appropriate signature. 

To open a project in the iFIX WorkSpace: 

1. Start your iFIX software and open the Proficy iFIX WorkSpace. 

2. In the iFIX WorkSpace, double-click the Proficy Batch Execution Configuration icon in the 
WorkSpace system tree. The Proficy Batch Execution Configuration dialog box appears. 

3. In the Project tab, select the project you want to open from the Active Project list box. 

4. Click OK. You will be prompted to exit and restart the WorkSpace for the changes to take 
effect. 

IMPORTANT: In both the Proficy Batch Execution WorkSpace and Proficy iFIX WorkSpace, 
Proficy Batch  Execution always uses the last project that you opened as the current project. 
This means that if you edit five projects, Proficy Batch Execution assumes that the last one is 
the project you want to use at runtime. 

Closing a Project 

To close a project: 

1. In the Batch WorkSpace, on the File menu, click Close Project. If you have made changes to 
the project that have not been saved, the Proficy Batch Execution WorkSpace prompts you to 
save your changes. 

2. Click the Yes button to save your changes and close the project. Click the No button to close 
the project without saving your changes. 

3. Enter any required electronic signatures. 

NOTE: This procedure does not apply to the Proficy iFIX WorkSpace. 

Saving a Project 

To save a project: 

5. In the Batch WorkSpace, on the File menu, click Save Project. The Batch WorkSpace saves 
your project with a file extension of .wkb.  

NOTE: This procedure does not apply to the Proficy iFIX WorkSpace. 

Working with the Area Model 
For information on working with the area model in the WorkSpace, refer to the following sections: 

• Defining a Project's Area Model 

• Viewing Audit Versioning Information 

• Exporting the Area Model to File 
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Defining a Project's Area Model 

To define a project's area model: 

1. In the Batch WorkSpace, on the File menu, click Open Project or select the Open Project 
button from the toolbar. The Open dialog box appears. 

2. Select the project you want to open and click Open. 

3. Enter any electronic signatures, if required: 

• If a Performed By electronic signature is required for the open command, a dialog 
appears requesting the appropriate signature. 

• If a Verified By electronic signature is required, a second dialog appears requesting 
the appropriate signature. 

4. In the WorkSpace tree, in the Configuration folder, double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

5. On the Project tab, enter the path and file name for the area model in the Equipment Database 
field. 

6. Click OK. 

Viewing Audit Versioning Information 

To view the audit versioning information for the current file: 

1. In the Batch WorkSpace, on the Area menu, click Audit Information. The Audit Information 
dialog box appears. 

2. Examine each of the fields. 

The fields displayed in the Audit Information dialog box include the audit version number and 
electronic signature information for the user(s) who authorized the Proficy Batch Execution 
WorkSpace to save the current version of the area model. 

NOTE: Information only appears in the electronic signature fields if you enabled auditing 
and configured signature requirements in the Batch Execution Configuration dialog box, and 
then saved the area model with the required electronic signatures. The GUID and audit 
version number will always appear regardless of the audit configuration state. 

Exporting the Area Model to File 

To export the current area model: 

1. In the Batch WorkSpace, on the Area menu, point to Export, and then click either Text or 
XML as the export format. The File Export As dialog box appears unless Proficy Batch 
Execution requires that you enter electronic signatures first. 

2. Enter any required electronic signatures: 

• If a Performed By electronic signature is required for the export command, a dialog 
appears requesting the appropriate signature. 
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• If a Verified By electronic signature appears, a second dialog appears requesting the 
appropriate signature.. 

3. From the File Export As dialog box, enter a name for the file in the File name field. 

4. Select a location to save the file. 

5. Click Save. 

Working with Pictures 
For information on working with pictures in the WorkSpace, refer to the following sections: 

• Adding a New Picture to a Project 

• Deleting a Picture from a Project 

Adding a New Picture to a Project 

To add a new iFIX picture to a project: 

1. Make sure your iFIX software is running. 

2. Shut down the Batch WorkSpace. 

3. In Windows Explorer, copy the iFIX picture to your Batch Picture path.  

4. Restart the Batch WorkSpace.  

NOTE: The picture does not appear in the Batch WorkSpace browser when you open the 
associated project.  

Deleting a Picture from a Project 

To a delete an iFIX picture from a project: 

IMPORTANT: Make sure you have a backup of the picture before you delete it. 

1. Shut down the Batch WorkSpace. 

2. In Windows Explorer, delete the iFIX picture from your Batch Picture path.  

3. Restart the Batch WorkSpace.  

NOTE: The picture does not appear in the Batch WorkSpace browser when you open the 
associated project.  

Working with the Enumerations 
For information on working with enumerations in the WorkSpace, refer to the following sections: 

• Overview: Defining Enumerations 

• Defining Enumeration Sets 
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• Modifying Enumeration Set Names 

• Deleting Enumeration Sets 

• Defining Enumerations 

• Configuring the UNIT_OF_MEASURE Enumeration Set 

• Configuring Unit Capacity 

Overview: Defining Enumerations 

To define enumerations: 

1. Define enumeration sets: 

a. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create 
Enumeration Sets and Enumerations dialog box appears. 

b. In the Sets area, click the New button. The Create Enumeration Set dialog appears. 

c. Enter a unique name for the enumeration set in the Enumeration Set field. 

d. Click OK. 

2. Define enumeration strings and their corresponding ordinal values: 

a. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create 
Enumeration Sets and Enumerations dialog box appears. 

b. Click the appropriate enumeration set.  

c. In the Enumerations area, click the New button. The Create Enumeration dialog box 
appears. 

d. In the Enumeration field, enter a unique, meaningful name.  

e. In the Ordinal field, enter the corresponding numeric value. This value must match 
the value defined in phase logic. 

f. Click OK.  

NOTE: Proficy Batch Execution supplies two predefined enumeration sets: 
PHASE_FAILURES and UNIT_OF_MEASURE. These sets are required by Proficy Batch 
Execution and cannot be deleted. 

Defining Enumeration Sets  

To define enumeration sets: 

1. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create Enumeration Sets 
and Enumerations dialog box appears. 

2. In the Sets area, click the New button. The Create Enumeration Set dialog appears. 

3. Enter a unique name for the enumeration set in the Enumeration Set field. 

4. Click OK. 
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Modifying Enumeration Set Names 

To modify an enumeration set name: 

1. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create Enumeration Sets 
and Enumerations dialog box appears. 

2. Click the appropriate enumeration set. 

3. Enter the new name for the enumeration set. 

4. Click OK. 

NOTE: You cannot modify the names of the UNIT_OF_MEASURE or PHASE_FAILURES 
enumeration sets. 

Deleting Enumeration Sets 

To delete an enumeration set: 

1. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create Enumeration Sets 
and Enumerations dialog box appears. 

2. Click the appropriate enumeration set. 

3. In the Sets area, click the Delete button. 

NOTE: You must delete all enumerations within an enumeration set before you can delete the 
enumeration set. 

4. Click Yes when prompted for confirmation. 

5. Click OK. 

NOTE: You cannot delete the UNIT_OF_MEASURE or PHASE_FAILURES enumeration 
sets. 

Defining Enumerations 

To define enumerations: 

1. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create Enumeration Sets 
and Enumerations dialog box appears. 

2. Click the appropriate enumeration set.  

3. In the Enumerations area, click the New button. The Create Enumeration dialog box appears. 

4. In the Enumeration field, enter a unique, meaningful name.  

5. In the Ordinal field, enter the corresponding numeric value. This value must match the value 
defined in phase logic. 

6. Click OK.  
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Configuring the UNIT_OF_MEASURE Enumeration Set 

To configure the UNIT_OF_MEASURE enumeration set: 

1. In the Batch WorkSpace, on the Edit menu, click Enumerations. The Create Enumeration Sets 
and Enumerations dialog box appears. 

2. In the Enumeration Sets list box, select the UNIT_OF_MEASURE enumeration set. A list of 
the existing units of measure appear in the Enumerations list box. 

3. To add a new unit of measure, in the Enumerations area, click the Add button. 

4. To edit an existing unit of measure, in the Enumerations area, in the Enumerations list box, 
select the unit of measure and click Edit. 

5. To delete a unit of measure, in the Enumerations area, in the Enumerations list box, select the 
unit of measure click Delete. 

NOTE: You cannot delete a unit of measure that is currently assigned to a unit. First, assign 
a different unit of measure to the unit and then you can delete the unused unit of measure. 

Configuring Unit Capacity 

To configure an unit's equipment capacity: 

1. In the Batch WorkSpace, select the unit that you want to modify. Otherwise, for a new unit: 

a. In the Batch WorkSpace, in the Unit Classes area, select a unit class.  

b. Move the cursor into the work area. The cursor changes to a right angle when you 
move it into the work area. 

c. Click anywhere inside the work area. An instance of the unit appears. 

2. Right-click the unit and select the Unit Properties. The Unit Properties dialog box appears. 

3. Select the Equipment Capacity tab. 

4. In the Amount field, enter the maximum amount the unit can contain, transfer, or process. 

5. In the UOM field, enter the unit's unit of measure. Choose from a list of predefined UOMs or 
enter a new unit of measure and add it to the UNIT_OF_MEASURE enumeration set.  

NOTE: If you want Proficy Batch Execution to consider a unit’s capacity as part of its unit 
selection criteria, assign the same UOM to (1) all units within the same unit class, and (2) the 
unit procedure’s capacity requirement. If a unit has a different UOM than the UOM specified 
in the unit procedure’s capacity requirement, Proficy Batch Execution ignores the unit’s 
capacity amount as part of the selection criteria. 

Working with Recipes 
For information on working with recipes in the WorkSpace, refer to the following sections: 

• Adding a Recipe to a Project 

• Adding Existing Recipes to a Project 

• Deleting a Recipe from a Project 
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Adding a Recipe to a Project  

To add a recipe to a project: 

1. In the Batch WorkSpace, double-click the Recipes folder to open it. 

2. Double-click the icon of the recipe type (procedure, unit procedure, or operation) you want to 
create. The Proficy Batch Execution WorkSpace launches the Recipe Editor. 

3. Enter any electronic signatures that Proficy Batch Execution requests. 

4. Build the recipe.  

5. When you complete the recipe, save it. 

6. Enter any electronic signatures that Proficy Batch Execution requests. 

The Proficy Batch Execution WorkSpace adds the recipe to the project. 

NOTE: You can also add an existing recipe to the project by adding it to the recipe path. The 
recipe appears in the browser when you open the associated project.  

Adding Existing Recipes to a Project 

To add existing recipes to a project: 

1. In Windows Explorer, copy the batch procedure files (.BPC), unit procedure files (*.UPC), 
and unit operation (*.UOP) files to the destination project's recipe path. 

IMPORTANT: If you copy a batch procedure recipe (*.BPC) file, make sure you copy all of 
its underlying unit procedure (.UPC) and unit operation (.UOP) files. Similarly, if you copy a 
unit procedure recipe (*.UPC) file, make sure you copy all of its underlying unit operation 
(.UOP) files. Additionally, the destination project's area model (.CFG) file must contain the 
equipment referenced by the copied recipes. 

2. After you have copied the files, rebuild the recipe directory.  

Deleting a Recipe from a Project 

To a delete a recipe from a project: 

1. In the Batch WorkSpace, on the Start menu, point to Programs, Proficy Batch Execution, and 
then Recipe Editor.  

2. Enter any required electronic signatures to open the Recipe Editor. 

3. In the Recipe Editor, on the File menu, click Remove Recipe. The Remove Recipe dialog box 
appears. 

4. Double-click the name of the recipe you want to delete from the Remove Recipe dialog box. 

5. Click the Yes button to delete the selected item or click the No button to return to the Remove 
Recipe dialog box. 

6. Enter any required electronic signatures to remove the recipe. 

NOTE: You cannot delete an open recipe. 
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Working with Miscellaneous Documents 
For information on working with miscellaneous documents in the WorkSpace, refer to the following 
sections: 

• Adding a New OLE Object to a Project 

• Adding an Existing OLE Object to a Project 

• Deleting an OLE Object from a Project 

Adding a New OLE Object to a Project 

To add a new OLE object to a project in the Batch WorkSpace: 

1. In the Batch WorkSpace, on the File menu, click Insert New Object. The Insert Object dialog 
box appears. 

2. Select the Create New option and select the type of object you want to add from the Object 
Type list box. 

3. Click OK. The Proficy Batch Execution WorkSpace launches the appropriate application and 
displays a blank work area for you to create a new OLE object. 

4. When you finish creating the object, save the project. This adds the new document to the 
project in the Misc folder. 

NOTE: Refer to your application manual for instructions on creating the object. 

To add a new OLE object to a project in the iFIX WorkSpace: 

1. From the iFIX WorkSpace: 

In Ribbon view, from the Insert tab in Objects/Links group, click Objects/Links, and then 
click OLE Object.  

-Or- 

In Classic view, on the Insert menu, click OLE Object.  

The Insert Object dialog box appears. 

2. Select the Create New option and select the type of object you want to add from the Object 
Type list box. 

3. Click OK. The Proficy iFIX WorkSpace launches the appropriate application and displays a 
blank work area for you to create a new OLE object in the current picture. 

4. When you finish creating the object, save the picture. This adds the new object to the picture 
in the browser tree. 

Adding an Existing OLE Object to a Project 

To add an existing OLE object to a project in the Batch WorkSpace: 

1. In the Batch WorkSpace, on the File menu, click Insert New Object. The Insert Object dialog 
box appears. 
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2. Select the Create from File button and specify the path and file name of the object you want to 
add. 

3. Click OK. The specified object is added to your project. 

4. When you finish adding the object, save the project. 

NOTE: Refer to your application manual for instructions on creating the object. 

To add an existing OLE object to a project in the iFIX WorkSpace: 

1. From the iFIX WorkSpace: 

In Ribbon view, from the Insert tab in Objects/Links group, click Objects/Links, and then 
click OLE Object.  

-Or- 

In Classic view, on the Insert menu, click OLE Object.  

2. Select the Create from File button and specify the path and the file name of the object you 
want to add. 

3. Click OK. The specified object is added to your open document. 

4. When you finish adding the object, save the document. 

Deleting an OLE Object from a Project 

To delete an OLE object from a project from the Batch WorkSpace: 

1. In the Batch WorkSpace, select the OLE object you want to delete from the Misc folder. 

2. On the File menu, click Delete Object. The Proficy Batch Execution WorkSpace updates the 
browser and removes the selected item. 

3. On the File menu, click Save Project to save your changes. 

To delete an OLE object from a project from the iFIX WorkSpace: 

1. In the iFIX WorkSpace, select the OLE object you want to delete from either the picture or 
the browser. 

2. In Ribbon view, from the Home tab in Editing group, click Delete. 

-Or- 

In Classic view, on the Edit menu, click Delete.  

3. Save your changes. 
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Managing a Project 
For information on managing a project in the WorkSpace, refer to the following sections: 

• Moving a Project from a Development Workstation to a Batch Execution Server Node 

• Setting up Network Access for Development Workstations 

• Defining the Frequency of Binding Prompts Notification 

Moving a Project from a Development Workstation to a Batch Execution 
Server Node 

To move a project from a development workstation to a Batch Execution Server node: 

1. In the Batch WorkSpace, create a new project.  

2. Exit the WorkSpace. 

3. Using Windows Explorer, copy the files from the source computer’s 
PROJECT/project_name/RECIPES directory to the destination computer. For example, to 
copy the DEMO project files, copy the files in the following path: C:\Program 
Files\Proficy\Proficy Batch Execution\Projects\DEMO\RECIPES. 

IMPORTANT: Do not copy the project's .WKB file. 

4. Copy all the files from the source computer’s iFIX Pictures path to the destination computer’s 
picture path. 

5. Copy the source computer’s SCU file to the destination computer. 

6. Start the Batch WorkSpace again, and open the new project. 

TIP: If the new project was the last project you opened on the destination computer, use the 
Open Last command to open the project. 

Setting up Network Access for Development Workstations 

To set up mapped network drives: 

1. Using the Windows Explorer, share the drive of the Batch Execution Server containing your 
project files. Make sure the share name of the drive matches the network computer name of 
the Batch Execution Server. 

2. On the Batch Server computer, on the Start menu, point to Programs, Proficy Batch 
Execution, and then WorkSpace. 

3. In the WorkSpace tree, open the Configuration folder, and double-click the Batch Execution 
Configuration item. The Batch Execution Configuration dialog box appears. 

4. On the Project tab, modify the edit boxes for the project paths so that they point to the shared 
drive. 

5. In Windows Explorer, map a drive on your development workstation to the shared drive on 
the Batch Execution Server. 

6. On the Batch development workstations, open the Batch WorkSpace, and in the Batch 
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Execution Configuration dialog box, modify the project paths so that they point to the shared 
drive. 

NOTE: It is recommended that you use UNC paths instead of mapping network drives. For 
more information, refer to the Defining UNC Project Paths section. 

Defining the Frequency of Binding Prompts Notification 

To define how frequently operators are notified of binding prompts: 

1. In the Batch Client, click the Configuration and Defaults button on the toolbar. 

2. Select the Operator Binding Prompts tab. 

3. In the Operator Notification section, select the Every Acknowledged or Outstanding Number 
button. 

4. If you select the Outstanding Number button, enter an integer in the Over field. 

5. Click OK. 
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